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1.0 INTRODUCTION

This unit introduces you to information technology and its use in business. It first explains the fundamentals
of computers including its characteristics and its basic anatomy. Information technology (IT) is closely
related with computers, because IT is the study, design, development and implementation of computer-
based information systems.

This unit will also explain the concept of business information. You will learn that business information can
include sales reports, stock statements and financial analysis reports. You will also learn how information
technology is applied in business. Business organizations can also use flexible systems to increase the
efficiency in operating the business. In this unit, you will learn about the different flexible systems used in
business organizations..  Business organizations can also use information systems to collect,  process,        store and
distribute information for effective decision-making in an orga-         nization. You will learn about the
different types of information systems        in an organization. Finally,you will analyse the importance of
information         technology in modern organizations.
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1.1 UNIT OBJECTIVES

After going through this unit, you will be able to:.  Describe the fundamentals of computers. Explain the relationship between information technology and computers. Explain the concept of information technology in business. Interpret the role of information technology in business. Explain the different flexible systems in business organizations. Explain the different information systems used in organizations.  Describe the use of information technology in modem business organizations

1.2  FUNDAMENTALS OF COMPUTERS

A computer can be defined as an electronic device that takes some input data from the user, processes it and
provides some pre-defined output. A computer literally means something that computes or calculates. The
dictionary definition of a computer is as follows: ‘An automatic electronic apparatus for making calculations
or controlling operations that are expressible in numerical or logical terms.’

Thus, the computer is an electronic device that processes raw data by performing  mathematical calculations
and operations on it. The processed data, which is produced by the computer, is called information. The raw
data can be figures and texts that are fed as input to the computer by the end-user.

The computer contains hardware and software that enable the processing of raw data. Hardware is constituted
by the physical components of the computer and software is the set of instructions and programs that are
necessary for the functioning of a computer. Programs instruct the computer to perform various operations.
These operations are:. Accepting data. Processing data. Generating output data. Storing data

Computers are used to perform these operations because of their high reliability, speed and ability to store
data.

1.2.1 Characteristics of Computers
Computer is an electronic device, which is used to process various processes related to different fields such
as science, accounts, entertainment, business and  studies. Various features of computers have contributed
to increase its popularity. These features are as follows:

. Speed

    . Accuracy. Diligence. Versatility. Intelligence. Storage

1.2.1.1 Speed

Internal processes of computers operate at the speed of light, limited only by the programs that control these
processes, and the quantum of data under process. The speed with which computers perform is way beyond
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human capabilities. To express it differently, a computer does a specific task in one minute that you could
take a lifetime to do.

While referring to the speed of computers, it is not measured in terms of seconds or even milliseconds (10-

3 ). The units of speed are in microseconds (10-6), nanoseconds (10-9), and even picoseconds (10-12 ). A
powerful computer is capable of processing about 3-4 million simple instructions per second.

1.2.1.2 Accuracy
The accuracy of a computer is consistently high. Errors can occur, but these are almost always due to
human error rather than technological weaknesses. Imprecise thinking by the programmer, inaccurate data,
or poorly-designed systems can be the origins of error. Computer errors arising due to incorrect data input or
unreliable programs are often referred to as Garbage-In-Garbage-Out (GIGO).

1.2.1.3 Diligence
Unlike human beings, a computer does not suffer from limitations associated with human beings such as
tiredness and lack of concentration, and hence can work for hours at a stretch without errors arising from
the above non-existent faults. As a result, computers score over human beings in performing routine tasks,
which require a high degree of accuracy. If a million calculations need to be performed, a computer will
perform the millionth calculation with exactly the same accuracy and speed as the first one.

1.2.1.4 Versatility
Computers are capable of performing almost any task, provided the task can be reduced to a series of
logical steps. For example, a task such as preparing a payroll can be broken down into a logical sequence of
operations and is therefore ideal for computerized processing.

The computer by itself has only limited ability and actually performs only four basic operations, which are as
follows:. Exchange of information with the outside world via Input/Output (I/O) devices. Transfer of data internally within the Central Processing Unit (CPU). Performance of basic arithmetic operations. Performance of operations of comparison

In one sense, the computer is not versatile because it is limited to the above mentioned basic functions. Yet,
since so many everyday activities can be reduced to interplay between these functions, it means that computers
are effective, highly ingenious and versatile devices.

1.2.1.5 Intelligence
A computer does not possess any intelligence of its own. It can perform only hose tasks that can be broken
down into a series of logical steps. Therefore, it needs to be told what it has to do and in what sequence.

1.2.1.6 Storage
The speed with which computers can process large amounts of information has led to the large-scale
information generation, resulting in the information explosion. Storage of information in a human brain and a
computer happens differently. Using its intelligence, the human brain subconsciously sifts through new
knowledge and selects what it feels is important and retains it in the memory, and the unimportant information
is relegated to the back of the mind or just forgotten. Computers, on the other hand, can store and recall any
amount of information by using. The secondary storage capability. Information can, therefore, be retained as
long as desired and recalled as and when required.
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1.2.2 Basic Anatomy of the Computer
The size, shape, cost, and performance of computers have changed over the years, Jut the basic logical
structure has not changed. Any computer system essentially ;consists of four important parts, namely input
device, Central Processing Unit (CPU), output device and main memory. The CPU itself consists of arithmetic
logic unit and control unit.

In addition to the five basic parts mentioned above, computers also use secondary storage devices, which
are also referred as auxiliary storage or backing storage devices. These secondary storage devices are used
to store data and instructions on a long-term basis. Figure 1.1 shows the basic anatomy of a computer
system.

All computer systems perform five basic operations for converting raw data into relevant information.
These operations are as follows:
   1. Inputting: The process of entering data and instructions into the computer system is called inputting
   2. Storing: It is the process of saving data and instructions so that they are  available for use as and
when required.

   3. Processing: It is the process of performing arithmetic or logical operations on data to convert them
into useful information. Arithmetic operations include operations such as add, subtract, multiply and divide.
Logical        operations are operations of comparison such as equal to, less than and greater than.

   4. Outputting: This is the process of providing the results to the user. The result could be in the form of
visual display and/or printed reports.

   5.  Controlling: It refers to directing the sequence and manner in which all the above operations are
performed.

1.2.2.1 Input unit

Both program and data need to be in the computer system before any kind of operation can be performed.
Program refers to the set of instructions, which the computer needs to carry out and data is the information
on which these instructions are to operate. For example, if the task is to rearrange a list of telephone
subscribers in the alphabetical order, the sequence of instructions that guides the computer through this
operation is the program, whilst the list of names to be sorted is the data.

The input unit performs the process of transferring data and instructions from the external environment into
the computer system. Regardless of the form in which the input unit receives data, it converts these instructions
and data into a form which is acceptable by the computer, which is the binary code. It then supplies the
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converted data and instructions to the computer system for further processing.

1.2.2.2 Main memory (Primary Storage)

Data and instructions should be in the main memory of the computer system before the arithmetic logic unit
(ALU) can process them. Once the processing is complete, the final results are again stored in the primary
storage till they are released to an output device. Also, any intermediate results generated by the ALU are
temporarily transferred back to the primary storage until needed at a later time. Thus, data and instructions
may move many times back and forth between the primary storage and the ALU before the processing is
completed.

1.2.2.3 Arithmetic Logic Unit (ALU)

The ALU is used to perform arithmetic as well as logical operations in the computer system. The four basic
arithmetic operations performed by the ALU are addition, subtraction, multiplication and division. The logical/
comparison operations performed by the ALU can be equal to, less than and greater than.

1.2.2.4 Output unit

Computers can only work with the binary data and the results produced by the computer system are also in
the binary form. The basic function of the output unit, therefore, is to convert these results into a form which
can be deciphered by human beings, before providing the output through various output devices such as
terminals and printers.

1.2.2.5 Control unit

It is the function of the control unit to ensure that, the right operation is done on the right data at the right
time, according to the stored instructions. It is the control unit that obtains instructions from the program
stored in the main memory, interprets them, and ensures that the other units of the system execute them in
the desired order. In effect, the control unit is comparable to the central nervous system of the human body.

1.2.2.6 Central Processing Unit (CPU)

The control unit, arithmetic logic unit along with the main memory are together known as the central processing
unit (CPU). It is the brain of any computer system.

1.2.2.7 Secondary storage

The storage capacity of the primary memory of a computer system is limited. Often, it is necessary to store
large amounts of data in the computer system. Therefore, additional memory called secondary storage or
auxiliary memory is used in most computer systems. Secondary storage is storage other than the primary
storage. These are peripheral devices connected to and controlled by the computer to enable permanent
storage of user data and programs. Typically, hardware devices such as magnetic tapes and magnetic disks
fall under this category .

1.3 INFORMATION TECHNOLOGY AND

           COMPUTERS

Computers can be used with information systems to store and process business data. The collected and
processed business data can then be used by management of business organizations to take business decisions.
You need to have the knowledge of application programming for using computers in business organization.
Application programming is an art of making a computer work according to the user requirements to get the
desired result. It consists of a sequence of commands, which are given to the computer to achieve an
objective. An application program is a set of instructions given to a computer in the binary language to
perform a particular task. The binary language is very difficult for the human beings to comprehend. Therefore,
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an intermediate language is used to translate the human data into its binary form. There are various
intermediate languages such as C, C++, Java , FORTRAN and COBOL

All programs can be structured in the following four ways:. Sequence: A program should maintain a strict step-by-step sequence. Violation         of this
sequence causes error in the program. Figure 1.2 shows the sequence        of instructions.

. Branches: It means a program has to follow decision instructions given by        a programmer.
Example: If condition one is true, then follow path 1 and if        condition two is true, then follow path
2. Figure 1.3 shows the branches.
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. Loops: This means that the steps in the program are repeated continuously        until some test
condition is reached. Figure 1;4 shows the loop structure.

. Modules: The program performs an identical sequence of actions, several         times. For
convenience, these common actions are placed in a module,         which is a kind of mini program that
can be executed from within the main          program. Examples of such modules are subroutine,
procedure or function.         Figure 1.5 shows the structure of modules.

An application program is run through an executable file which is stored in the computer and can be run
repeatedly to perform a specific task. In addition, an application program is written by a programmer using
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a specific programming language. As a result, an application program can only be modified by a programmer.
Generally, the programmer writes a program in high-level language, which is converted into the byte code by
an interpreter. The computer can understand only the byte code. The code written by programmer is called
source code and the code, which is generated by the interpreter, is called object code.

An application program must have the following elements for its execution:. Loader: The function of a loader is to load the program into the memory

         of the computer system.. Data definitions: A user needs to define exactly what type of data will be used for the source code
so that it becomes easier to understand the code.. Statements: These are the basics of a program. The main function of statements  is to manipulate the
data.

1.4  INTRODUCTION TO BUSINESS

            INFORMATION

Business information is the information related to the business conducted by an organization. The business
information can include sales reports, stock statements and financial analysis report. There can be many
types of business information, which need to be provided for better planning and achieving organizational
objectives. The various types of business information are described as follows:. Action versus no-action information: The information which induces action is called action
information. The information, which communicates only the  Status of a situation, is no-action information..Recurring versus non-recurring information: The information generated at regular intervals is a
recurring information. Information such as the monthly        sales reports, the stock statements and the
trial balance, are recurring  infor-        mation. The information, which is generated at irregular
intervals, is a non-       recurring information. For example, the financial analysis or the report in
     the market research study is a non-recurring information.. Internal versus external information: The information generated through the internal sources of
the organization is termed as internal  information;while  the information generated through goverment
reports and industry surveys is termed as external information.. Planning information: Certain standards, norms and specifications are used in the planning of an
activity. Hence, such information is called the planning information. The time standards, the operational
standards and the design standards are examples of the planning infom1ation.. Control information: Reporting the status of an activity through a feedback mechanism is called
the control information. When such an information shows a deviation from the goal or the objective, it will
         induce a decision or an action leading to control.. Knowledge information: A collection of information through library reports and research studies
to build up a knowledge base as a  information source for decision-making is known as knowledge
information.

1.4.1 Value and Cost of Information

Value of infomlation is determined on the basis of the benefits that are derived from the infomlation.
Consider an example where two products A and B are developed. The benefits derived from product A
evaluates to 20 and the benefits derived from product B evaluates to 30. The difference between the
benefits of the two products is 10 units.

If you add some infomlation, the benefits derived from product A increases by 20 points, i.e., from 20 to
40. The actual value of infomlation needs to be calculated by simple mathematics. The cost of infomlation
increases by 20 units. You need to subtract the cost involved in obtaining the infomlation to determine the
actual value of the infomlation.
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Cost of infomlation determines the cost involved in obtaining the infomlation, which includes the following:..Cost of acquiring the data. Cost of maintaining the data. Cost of generating the infomlation. Cost of communicating the infomlation

The cost is estimated from the point the infomlation is generated to the point the infomlation is retrieved
by an infolmation system. The cost of obtaining accurate and complete infomlation is more as compared
to the cost generally retrieved from the system.

1.5 INFORMATION TECHNOLOGY  IN BUSINESS

IT and computers are very much related to each other. It depends on the hardware and software capacity
of the computer to store infomlation. The hardware and the software can be changed or managed as per the
requirement of the organization. For example, some organizations may need a small database, while others
may. need a large database. Organizations having many branches may need to store infomlation in one
computer with which all the other computers are connected.

The ability of the computer hardware to store large volumes of data, access data when required, sort and
manage data and finally the ability to compute large volumes of data helps in the proper management of data
and information. There is no need of maintaining large number of files and working on them manually.
Personnel from any department can access the required information as and when needed. Also, computers
provide security facilities such as protecting the information stored or denying access to unknown users.
The information of any organization is very important and it is very necessary to protect it from others. The
important files and folders in the computer can be given passwords so that it is not accessible to everyone or
they can be made READ ONLY so that no one can update the information. The user can only view the
information with the READ ONLY facility.

Software is an integral part of a computer, which makes all the hardware parts to function. It helps in the
processing of procedural and non-procedural data. For example, if you need to do additions, then you need
to install the software that is able to calculate. Today, there is software available for every kind of job. You
can have software  as per  requirement of the organization. For example. if you need software for the
accounting department that can help in bookkeeping which includes maintaining the profit and loss account,
balance sheets and trial balance, you can install the software named tally.

Computers are used for performing many tasks such as storing business data and manipulating the stored
business data. Computers can store large amount of data in its main memory and secondary memory.
Computers also help in organizing the business data in a specific manner such as in the ascending or the
descending order. Business organizations can use Relational Database Management System software such
as MS Access, Oracle and SQL Server for storing large amount of data. These RDBMS software allows
business organizations to organize business data, so that it can be easily retrieved and manipulated. Organizing
business data through RDBMS software helps in efficient and easy searching of information related to
business conducted by an organization. Searching of relevant information helps in proper planning and
management of business activities. Searching of business information is also important because it helps the
management of an organization in taking appropriate business related decisions. The tasks of storing, organizing
and searching business data are necessary for the effective functioning of a business organization and the
achievement of business goals.

Business organizations can also use computers to perform word processing tasks such as formatting data
and entering data in a document. Computers are employed in business for the purpose of online meetings,
which are held through Internet. Various groups participate in these online meetings for discussion on specific
business issues. Other uses of computers in business include e-commerce, e-business and e-banking.
Computers can be used for multimedia related tasks, which include photo editing, sound editing and making
movies. Another application of computers in business is office automation in which computers and various
communication technologies are used to manage information. Office automation basically helps automate
different activities such as generating reports, storing business data, processing data, accounting and managing
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inventory. People who are involved in office automation include managers, supervisors, analysts and executives.
In office automation, e-mails related to business are sent to other business associates, customers and suppliers.
Office automation systems comprise many different subsystems, which are text management systems,
business analysis systems, document management systems and network and communications systems. A
text management system is a computer system, which is used to work on text document. This type of
subsystem helps perform tasks such as editing and formatting text. A text management system includes
various typewriters, word processing computer systems and desktop publishing computer systems. These
types of systems are used for writing memos, notes, letters and short documents. A business analysis system
is a computer system that provides appropriate data with the help of appropriate software for understanding
the business processes conducted by an organization. Document management systems are computer systems,
which help manage different types of documents, which can be paper-based. computer-based or electronic
documents. Communication management systems are systems, which help in the effective communication
of business information. The communication systems include telephone and fax machines.

1.6  FLEXIBLE SYSTEMS IN BUSINESS ORGANIZATIONS

Business organizations can use flexible systems to increase efficiency in conducting the business. Flexible
systems are those systems that are used by the organizations according to their requirements. For example,
an organization can use the Internet according to its requirement to collaborate with business associates,
customers and suppliers. The various flexible systems that can be used in a business organization are:. Client -server computing system

   . Collaborating computing system. Collaboration through Internet

1.6.1 Client-Server Computing System

In client-server computing system, there are a number of clients and a server, which processes the request
of the clients. The clients and the server are connected to each other through Local Area Network (LAN)
or Wide Area Network (WAN). The client sends request to the server for processing specific data. The
server, on the other hand, receives the request of the clients and processes the data. After processing the
data, the server sends the result to the client.

In a client- server computing system, a client computer may also perform data  processing. The server in
this case stores the data related to the business conducted by an organization. To store and organize data,
relational database management system software such as SQL Server and Oracle are installed on the
server. Thus, the server works as a back-end in this type of client-server computing system, where the client
may also have certain processing power. The client, on the other hand, performs processing tasks such as
validation of data and manipulation of data. The client, thus, works as a front end. Figure 1.6 shows a simple
client-server computing system in which multiple clients are connected to the server.

The above figure shows that the clients and the server can be connected to each other through either LAN
or WAN network.

In a client-server computing system, processing of data is performed in a centralized manner. This is because
the server has all the data required for processing and the client requests the server for data. The client-
server computing system works in a distributed environment, because the server provides data to all clients.
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1.6.2 Collaborating Computing System

In collaborating computing systems, employees of a business organization share business data with each
other through a network, which is a group of computers connected to each other through network cables.
The computers used by employees are connected to each other in a LAN, WAN or Metropolitan Area
Network (MAN). In the collaborating computing system, the files containing the business data are shared
among the employees of the organization. Different employees perform different computing tasks on the
shared data. The result of computing the data is also shared among the employees through the network.

Business organizations can also use software such as Content Management System (CMS) and Share Point
Portal Server that allow sharing of files. Organizations can have their own e-mail systems and instant
messaging software to allow employees to send e-mail messages and instant messages to each other for
sharing business information.

1.6.3 Collaboration through Internet

Business organizations collaborate with their business associates, customers and suppliers through the Internet.
Internet is the internetworking, which is a collection of computers all over the world connected to each
other. It is used by all small and large business organizations. The Internet allows business organizations to
send e-mails to their business associates, customers and suppliers for providing business-related information.
Business organizations can develop digital firms on the internet for interacting with the customers and
suppliers. Digital firms also help identify opportunities for new products and services. In addition, the digital
firms help customize existing products of an organization.

Internet also allows business organizations to collaborate with customers through online chatting, which can
be either voice chatting or text chatting, for identifying their needs. Instant messaging through Internet
allows business organizations to share business information with their customers and business associates by
sending and receiving instant messages.

Internet also allows business organizations to perform e-commerce for marketing and selling their products.
E-commerce is a business transaction through which organizations sell and purchase products and raw
materials. Organizations perform e-commerce for the following purposes:. Provide information about the products manufactured by them. Identify the needs of customers. Buy products from suppliers. Deliver electronically the products ordered by customers. Supply services to customers electronically

On the basis of the nature of the participants in the e-commerce transactions, e- commerce applications are
divided into three major categories, which are as follows:

.Business-to-Consumer (B2C)e-commerce: In this type of e-commerce, consumers deal directly
with an organization, and thus, there are no interme- diaries, for example, Amazon.com.. Business-to-Business (B2B) e-commerce: In B2B e-commerce, the  participants are various
organizations, for example, Neoforma.com.. Consumer-to-Consumer (C2C) e-commerce: This category of e-commerce involves consumers
selling goods and services directly to other consumers through the websites. For example, eBay.com, which
is a large Web auction site, allows people to sell their goods to other consumers by auctioning off the
merchandise to the highest bidder.

Besides these three main categories of e-commerce, Business-to-Government (B2G) and e-Government
applications also apply the concept of e-commerce. With the advancements in communication technology,
websites can be accessed through cell phones and other wireless handheld digital appliances. The use of
handheld wireless devices for purchasing goods and services is known as mobile commerce or m-commerce.
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1.7  INFORMATION SYSTEMS IN ORGANIZATION
An information system can be defined technically as a set of interrelated components that collect, process,
store and distribute information to support decision-making and control in an organization. In addition to this,
information systems may also help managers and workers to analyse problems, visualize complex subjects
and create new products. Information systems contain information about significant people, places and
things within the organization or in the environment surrounding it.

In other words, information is the data which has been shaped into a form that is meaningful and useful to
human beings. Data, in contrast, are streams of raw facts representing events occurring in organizations or
the physical environment, before they have been organized and arranged into a form that people can
understand and use.

There are specific types of information systems that correspond to each organizational level. The organization
has Executive Support System (ESS) at the strategic level that helps senior management tackle and address
strategic issues and long-term trends, both in the firm and in the external environment. Their principal
concern is matching changes in the external environment with the organizational capability. Management
Information System (MIS) and Decision Support System (DSS) at the management level serve the monitoring,
controlling, decision-making and administrative activities of middle managers. Management level systems
typically provide periodic reports rather than instant information on operations, while some management
level systems support no routine decision- making. They tend to focus on less structured decisions for which
information requirements are not always clear. Transaction Processing System (TPS) at the operational
level support operational managers by keeping track of elementary activities and transactions of the organization
such as sales, receipts, cash deposits, payroll and the flow of materials in the factory. The principal purpose
of systems at this level is to answer routine questions and to track the flow of transactions through the
organization. Examples of operational level systems include a system to record bank deposits from Automatic
Teller Machines (ATMs).

1.7.1 Executive Support System
Senior managers use Executive Support System (ESS) to help them make decisions. ESS serves the strategic
level of the organization. ESS is designed to change data according to external events. An ESS filters,
compresses and tracks  critical data, displaying the data of greatest importance to the senior managers. ESS
employs the most advanced graphics software and can present graphs and data form many sources. Often,
the information is delivered to senior executives through a portal, which uses a web interface to present
integrated personalized business content from a variety of sources. ESS is not designed primarily to solve
specific problems, rather it provides a generalized computing and communications capacity that can be
applied to changing array of problems. ESS tends to make less use of analytical models. Figure 1.7 shows
the interrelationships among the system.
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The above figure shows how the systems serving different levels in the organization are related to one
another. Transaction processing system are typically a major source of data for other systems, whereas ESS
are primarily a recipient of data from lower-level systems. The other types of systems may exchange data
with each other as well. Data may also be exchanged among systems serving different functional areas. It
is definitely advantageous to integrate these systems, so that information can flow easily between different
parts of the organization and provide the management with an overall view of how the organization is
performing. But, integration costs money and integrating many different systems is extremely time consuming
and complex.

1.7.1.1 Application of ESS

The various applications of ESS are as follows:. Executive Briefing: ESS offers up-to-date information for the executive’s  interest to improve the
performance of the organizational functions. The briefing is related to analysing the performance of various
operations and status reports of the organization. In ESS, the information is automatically
       downloaded periodically from databases in the form  of finished reports. This automatic downloading
ensures that executives do not remain out of touch  with the information for a long time during the days of
extreme pressure of workload..  Personalized analysis: ESS offers facilities for data analysis using the models  of user’s choice such
as spreadsheets and statistical techniques. ESS not only helps the user in analysing data, but also in the
interpretation of the outcome of the analysis.. Forecast reporting: An important application of ESS is to forecast reporting of an organizational
function. ESS helps to solve the organizational functions effectively and forewarns the executives about the
outcome of  the organizational functions.

   . Model-based analysis: ESS provides model-based information analysis and this feature is common
with DSS. Model-based information analysis refers to computing the information for the desired data. The
model-based  analysis in ESS is different from that in DSS in the sense that the input data in ESS is limited
and obtained from both internal and external sources. Internal sources are the organizational database and
external sources are the market reports and customers analysis.

1.7.1.2 Benefits of  ESS
ESS is not an information system that only generates reports for the decision- making; it also Supports the
total information system in an organization. ESS offers the following benefits to a business organization:. ESS helps executives in relying more on facts depending on the analysis of  the reports than on intuition
and business judgement for their strategic decisions.. It is easier for an executive to pass on the message to managers regarding  the need to maintain quality
standards, just by making frequent queries using ESS.

   . ESS provides an opportunity to the top management to understand the benefits of information systems
in strategic decision-making. ESS also promotes understanding between top management and information
       technology (IT) professionals and improves communication among them,  which leads to the development
of the organization.

  . Successful ESS, which improves the functionality of organizational operations can provide visibility and
credibility to information systems and helps in implementing other information systems in the organization.

1.7.1.3 Problems in ESS implementation
ESS provides first-hand knowledge to top executives regarding the potential benefits of information systems
in the organization. Therefore, it is necessary to ensure that ESS, once planned, must be implemented
successfully. The various problems that occur during the implementation of ESS are as follows:. Difficulty in system specification: The intended users of ESS generally have no idea about their
specific information requirement and the time to chalk out the specifications of the information system. The
users, thus, deserve a few options to try out before they are able to specify the services required by the
system.
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. Large volumes of data: A user in ESS usually accesses a large volume of         information by
using queries. The satisfaction of such queries may require         use of statistical tools to process bulk
data, before it can meet the           requirement of information in the query. This can take time and the
response         of the system can be slow.. Conflicts from lower levels: The reports generated by ESS are likely to         face conflicts from
the. people at almost all the levels. The top-level         management accesses the updated information using
ESS regarding the        day-to-day functioning in each department before the departmental heads
       have gone through and understood this information.. Support to management styles: Some top executives do not favour the         use of information
systems in decision-making. They have more confidence         in their business judgement and wish to leave
data analysis either to their         subordinates or to the domain experts who assist them.. Increased size and cost: If the manager finds ESS useful, he expects his        subordinates also to
use it. Those who do not use ESS, find it very difficult to         keep it upto the expectations of their boss.
Thus, the ESS gets overloaded and           the cost increases because the number of users grows in
geometric proportions.

Thus, ESS should be implemented carefully. It is advisable to select a favourable time for implementation.
People resist changes more when the functions are going is smooth and are more willing to try out something
new in crisis. Therefore, the most favourable time of ESS implementation is when people are searching for
new solutions to their problems.

1.7.2 Management Information System
Management Information System (MIS) serves the management level of the organization, providing managers
with reports and often online access to the organization’s current performance and historical records. Typically,
MIS are oriented almost exclusively to internal,not environmental or external events. MIS primarily serves
the functions of planning, controlling and decision-making at the management level. Generally, they depend
on underlying transaction processing systems of their data. MIS summarizes and reports on the company’s
basic operations. MIS transforms transaction level data from inventory, production, and accounting into MIS
files that are used to provide managers with reports. MIS usually serves managers primarily interested in
weekly, monthly and yearly results. MIS generally provides answers to routine questions that have been
specified in advance and have a pre-defined procedure for answering them. MIS systems are generally not
flexible and have little analytical capability. Most MIS use simple routines such as summaries and comparisons,
rather than sophisticated mathematical models or statistical techniques.

1.7.2.1 Goals of MIS

MIS is the most common type of management support systems. The various goals of MIS in an organization
are as follows:. To provide information to managerial end-users to support their day-to- day decision-making needs. To produce reports for specific time periods designed for managers responsible for specific functions
in an organization, for example, departmental expense reports and performance reports. To provide correct information to the concerned manager at the right time. To help in carrying out regular and routine operations. To control, organize and plan better business operations

1.7.2.2 Role of MIS

MIS is the heart of any organization. Thus, MIS is very essential for the survival and success of any
organization. The information in MIS provides all the necessary data that are required for the Proper
management of organizations. The system makes sure that all the information is collected properly and sent
to the respective departments for further processing. MIS helps in satisfying the various requirements of
departments through a number of systems such as Query Systems, Analysis Systems, Modelling Systems
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and Decision Support System. These systems help in strategic planning, management control and transaction
processing.

MIS helps the personnel at all levels of management in performing their jobs efficiently. It provides the junior
management personnel with operational data for planning, scheduling and controlling that helps them in Lite
decision-making procedure. It provides the middle management personnel in short-term planning, target
setting and controlling the business functions. Finally, it helps the top management personnel in target setting,
strategic planning and evolving the business plans and their implementation.

1.7.2.3 Impact of MIS

MIS has a big impact on the functions, performance and productivity of an organization. It helps in the
proper functioning of all activities and also helps in the proper management of marketing, finance, production
and personnel departments, which are the essential parts of an organization.

The impact of MIS on the functions of an organization reflects from the impact on the management. The
information that the MIS provides helps in the planning and decision-making activities, which ultimately aims
for the achievement of the organization goals. With the use of  MIS in organizations, the managers are
informed about the progress, achievements and drawbacks of the organization. The managers can then act
accordingly so as to maintain their organizations’ standard in the market.

MIS has its impact on the production of an organization. The production managers are duly provided feedback
about the performance and the quality of the products that help them to improve the product value.

Another impact of MIS, as discussed above, is on the performance of an individual. MIS uses databases and
transaction-processing systems for the storage of data and information. The overall MIS system is
computerized that helps in reducing the manual work. This helps individuals to reduce their workload and
pay more attention on other work that need more of manual work such as planning and decision-making. If
all the personnel of an organization are involved in information processing, searching and arranging the
information, then there is no time to analyse the performance of the organization, and hence, there is no time
for achieving the organizational goals. In a computerized MIS system, the information is arranged in such a
way that it is easy to retrieve the required data.

1.7.2.4 MIS and academics

The foundation of MIS is the subject management. The MIS follows tile principles and practices of
management theory to provide a flexible system in the organization. One of the subjects of management that
is taken into account for developing a MIS system is the operations research. Operations research is used in
MIS for solving management problems. Inventory control, queuing theory and resource programming arc
used in MIS for incorporating the decision support systems that is helpful for decision-making processes.
The network theory is used for planning and controlling small and large projects.

MIS uses the subject of accounting arid the accounting principles to ensure that the information fed is
correct and reliable. The principles of accounting used in MIS are the double-entry bookkeeping for balancing
the accounts, trial balance and balance sheets for generating accounting methodology.

MIS uses the communication theory and the principles of feedback while in the analysis and reporting
systems. While generating the formats for reports, special attention is paid in order to avoid noise and
distortion in the communication process. The decision theory helps in MIS decision-making and helps in
taking decisions under risk and uncertainty.

MIS uses database management system to store data and information. It makes use of the data structures
such as the hierarchical and network structure to store information in certain levels. The relational database
management helps in maintaining the relationship between the information stored in the database.

1.7.2.5 MIS  and user

MIS touches every aspect in the organization, and thus, is naturally used by every individual at all levels that
comprise the organization. This user can be a clerk, an assistant, an officer, an executive or even a manager.
The MIS meets the needs of all these individuals.



16

For example, a clerk has to search through the data and make statements to submit to the higher authorities.
For this purpose, MIS can be used to carry out a quick search and report the same to the higher level
authority. Similarly, an assistant needs to collect and organize the data to conduct a rudimentary analysis. In
this case, MIS offers various tools to execute the necessary tasks. It facilitates an officer in integrating the
data from different systems and reporting the analysis in a proper format. It provides the decision support
system to an executive who has to plan for achieving targets and goals of the organization. A manager can
use MIS to prepare a structured or unstructured format of activities and functions of top management.
Thus, MIS caters to the ever-changing needs of several  individuals in an organization.

The MIS, however, has certain negative effects on individual employees. Since it takes away the drudgery
of search, .collection, writing and reporting the data, the work vacuum, so created is not easily filled, and
therefore, a sense of security emerges. Especially in the case of lower-level employees, the importance of
the person is lost, thus giving rise to fear of non-recognition in the organization. In the case of an officer and
an executive, since MIS facilitates the job of data integration, the concerned data is transferred from an
individual to MIS, and thus made available to all in the organization. This creates a sense of being neglected
for knowledge information and especially advice. MIS also creates a feeling of challenge and exposure for
the manager, since information is available to the middle management. As these employees can easily
access this information and interpret according to their abilities, the top-level managers have to face competition
and the fear that their decisions may be questioned or proved wrong.

MIS can yet create a positive influence on the organization’s personnel in several ways. Individual employees
become more efficient operators. Their time and efforts are concentrated on more productive work than
before and involves using analytical skills and knowledge. This is possible due to the information support
offered by MIS: Moreover, the managers can tackle complicated cases in the organization more effectively
as a result of their increased decision-making ability. They can use the systems and the models in MIS for
trying several alternatives in a given problem situation. Thus, the MIS plays a crucial role in organization’s
efficiency by collectively increasing the ability level of a number of individual employees simultaneously.

1.7.2.6 Limitations of MIS

There are fundamental weaknesses in the organization such as improper management and unclear
organizational functions. When the organization decides an MIS, these problems directly affect and limit an
MIS. The various limitations of MIS are as follows:. Organizational Framework: Some managers think that they can solve a company’s shortcomings
using MIS. MIS does not help to achieve this goal without good planning and control within the framework
of an organizational structure.

  .  Generation of Information: The lack of managerial and operational  applications to the MIS makes
a great impact, because it implies that the process of management is not being performed well to generate
the information. The information is the raw material of decision-making for MIS, and if information is not
being generated, disseminated and used for management, then no system-manual or computer will be able to
solve the organizational problems.

   .  Managerial Participation: The most striking characteristic of any successful organization is that
MIS development has been viewed as a responsibility of the management. Their success is attributed directly
to          the fact that managers are required to become involved in the design of         their own
systems. This includes both top management and operating line          management. Moreover, the
presidents need to take a personal interest         and participate directly in defining what work the
computer should do for          the company.

1.7.3 Decision Support System

Decision support systems also serve the management level of the organization. DSS help managers make
decisions that are unique and rapidly changing. They address problems, where the procedure for arriving at
a solution may not be fully pre-defined in advance. Although DSS use internal information from the transaction
processing system and management information system, they often bring in information from external sources
such as current stock prices or product prices of competitors. DSS have more analytical power than other
systems. They use a variety of models to analyse the data or they condense large amounts of data into a
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form in which they can be analysed by the decision-makers. DSS are designed in such a manner so that the
user can work with them directly; these systems include user-friendly software. DSS is a voyage estimating
system. A voyage estimating system calculates financial and technical voyage details. Financial calculations
include ship/time costs, whereas a technical detail includes ship cargo capacity, speed and port distances.
This voyage estimating systems draws heavily on analytical models.

1.7.3.1 Features of DSS

DSS helps to solve unstructured business problems. Unstructured problems are those problems which require
unprogrammed decisions. DSS has the following features, which makes it distinct from other types of
information systems:. DSS does not aim at any specific type of decisions. It has the flexibility of  using unexpected decision
situations, which are not predetermined and not known to the managerial level.. The user-friendly interface of DSS makes it different from other types of  information systems.. The software tools such as report generators and graphic facilities in DSS provide better ways of
presenting the information.. DSS offers complete control over the information systems. A user can control the input, method of
processing and output of the information using DSS interactive interface.

1.7.3.2 Benefits of DSS

DSS helps in generating information to assist in reporting and managerial decision-making process. The
various benefits that a DSS can offer include the following:. Evaluation of a larger number of alternatives in DSS reduces the time and effort in collecting and
analysing the data for different operations.. Modeling and forecasting becomes easy for managers to get more insight into the business processes
using DSS.

   . It is useful in intra-group and inter-group communication, because the information it derives regarding
the solution to a problem is easily understood by others.. It facilitates quicker analysis of data, thereby improving the speed of response in unexpected decision-
making situations.

   . DSS provides in-depth analysis of data, and therefore, data can be used more effectively to take
decisions.

1.7.3.3 Application of DSS

DSS helps the top management of an organization in various application areas such as support in making
decisions, training managers and a variety of decision- making situations. The areas of application of DSS in
production and finance are described as follows:. Production: DSS helps in various areas of production such as cost estimation and analysis, production
planning and scheduling, make or buy product decisions, inventory planning and control of manpower.

  . Finance: DSS helps in various areas of finance such as capital budgeting, financial planning and analysis,
tax planning, strategic financial planning,  budgeting, cash and working capital management, debt and equity
financing analysis, foreign exchange risk management, financial performance analysis and variance analysis.. Future Decision-Making: DSS help managers to activate simulation models to access the required
information from the database for decision- making. The simulation model is an interactive activity where
the manager can experiment and see projected results for the planned action that are to be  implemented in
future.

1.7.3.4 Interactive system for DSS

Interactive system for DSS helps a decision-maker to evaluate the result of a particular course of action to
solve a business problem. If a shortcoming exists in the solution then the decision-maker can modify the
solution or try another solution. In this way, the interactive system of DSS helps in providing the best solution
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to a particular problem that can be applied in the concerned department of the organization. Interactive
system for DSS is created using various query and high-level programming languages such as SQL, COBOL
and FORTRAN. These languages prompt and help a user to make commands to retrieve the information
with a user-friendly interface.

1.7.4 Transaction Processing System

A transaction processing system is a computerized system that performs and records the daily routine
transactions necessary to conduct business. Different examples of transaction processing system are sales
order entry, hotel reservation systems, payroll, employee record keeping and shipping. At the operational
level, tasks, resources, and goals are pre-defined and highly structured. TPS has a payroll system which is
a typical accounting transaction processing system found in most firms. A payroll system keeps track of the
money paid to employees. The master file is composed of discrete pieces of information called data elements.
Data is keyed into the system, updating the data elements. The elements on the master file are combined in
different ways to make up reports of interest to management and government agencies and to send pay
cheque to employees. These TPS can generate other report combinations of existing data elements. TPS
are often so central to a business that TPS failure for a few hours can lead to a firm’s demise and perhaps
that of other firms linked to it. Managers need TPS to monitor the status of internal operations and firm’s
relation with the external environment. TPS are also the major producers of information for the other types
of systems.

1.8  INFORMATION TECHNOLOGY IN MODERN
ORGANIZATIONS

IT refers to the study, design, development, implementation and management of information system, which
is based on computers using special software. In other words, IT enables you to convert, store, protect,
process, transmit and retrieve data from the information system using electronic computers and its related
technologies. It also serve the major business functions such as sales and marketing, manufacturing and
production, finance and. accounting and human resources. A typical organization has operational, management
and strategic level systems for each functional area. Figure1.8 shows the various levels of the information
system.

Technologies related to information systems at each level in turn are specialized to serve each of the major
functional areas of an organization.

Today, IT is used in almost every field of business for faster and efficient processing of data and information.
Information technology plays an important role in the working of modem organizations.
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1.8.1 Information Technology in Banking

Today, all major banks have branches in numerous locations and they need to recruit more and more staff to
cope with the increasing number of customers. The accepted wisdom is that cost is the main basis for
competition among different banks, and so the banks are making more efforts to reduce operational costs by
computerizing customer accounts. Computerization in banks has led to cost reductions by saving a lot of
back office work, but banks still needs to employ large number of front office staff to deal with customers.

The development of ATMs is a boon to the customers. They allow the customers to take advantage of
specific banking services, twenty-four hours a day and seven days a week,. ATMs make it easy to deposit
and withdraw money, check balance, request statements, etc. Coupled with the added advantage of round-
the-clock availability, they not only reduce staff workload, but also give the customers hassle-free banking.
Some of the areas where banks typically use computers as well as IT are:.Back-office Computerization: Nowadays, almost all Indian and international         banks run on fully
integrated and online systems, where all back-office         operations like accounts posting,
reconciliation and clearing house operations          are completely automated.

   . Front-office Computerization: All banks provide various types of facilities         such as instant
account statement, making fixed deposits, electronic funds         transfer and direct debit facility to
their customers. None of these would be         possible without the low transaction costs and
efficiency offered by         computerized systems..Automatic Teller Machines: These computerized machines enable customers         to do their
regular bank transactions such as depositing and withdrawing         money and ascertaining current
account balance without visiting a bank          branch. ATMs considerably reduce costs such as employee
cost and space         cost for banks. It also provides a better level of service to customers by
        enabling twenty-four banking access at numerous locations.

   .Internet Banking: Most banks like HSBC, Standard Chartered, HDFC and         ICICI have
extremely user-friendly websites, where the different banking           transactions such as making
request for cash and cheque pickup, cash delivery,         generating account statements, requests for
cheque books and drafts can be        carried out online without visiting the bank..Credit Card Operations: In a typical credit card operation, you purchase an          article or a service
and give your credit card to the vendor/service provider at         the time of clearing the bill. The
vendor, which is also called the merchant,         swipes your credit card on a Point Of Sale (POS)
machine that instantly dials         into the bank database to verify the authenticity and credit worthiness
of the         card. If the transaction is covered by your credit card limit agreed between         you and
the bank, then the POS prints an authentication receipt. The authen-         tication receipt authorizes
the merchant to collect the transaction amount          from the bank instead of collecting it from the
customers. Credit cards obviate         the necessity of carrying huge amounts of cash, and an option of
spending          more than one current cash status. On the other hand, banks earn money by
          charging a transaction fee from the merchant and interest on the credit facility.        This entire
operation is critically dependent on IT.

1.8.2 Information Technology in Hospital Management
Today, computers are revolutionizing the medical field. IT plays a very important role in patient monitoring
and automated drug administration. In the hospitals, computers are used to record the data of the patient and
their status. The pharmacists use computers to keep track of what type of medication should be given to the
patient.

IT supports Magnetic Resonance Imaging (MRl) , which uses radio waves and strong magnetic field to scan
the patient’s body. IT converts this information into pictures which can be used to detect any abnormalities
in the internal organs of the patient. IT also supports Automated Imaging Technique (ATI), which produces
pictures of internal organs more clearly as compared to the standard X- ray films. The most common
example of ATI is Computerized Axial Tomography (CAT) scans. The use of telemedicine enables the
patients to get high quality medical care irrespective of their physical location.
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1.8.3 Information Technology in Insurance Companies

Like banking, the insurance sector has also to deal with a lot of routine paperwork such as insurance
policies, claims filed, surveyor investigation reports and payment receipts. Computers can be of much help
in reducing costs and processing times. Typically, insurance companies use computerized databases to keep
track of all insurance policies, generating premium due statements, premium received receipts, lodging
claims for insurance recovery, etc. Basically, all kind of transactions are recorded and processed through
computerized systems. This enables insurance companies to provide quicker and more efficient service to
their clients. It also allows the insurance companies to minimize risks and maximize profits by enabling
complex financial, economic and demographic analyses of their customers. Using sophisticated computer
programs, an insurance company can easily determine which customer segments have the highest growth
rate, which are the most profitable and which are more risky than others.

1.8.4 Information Technology in Mobile Computing

Mobile computing is a technology which enables you to use information technology without using any physical
transmission media for connection. Mobile phone is a good example of mobile computing. Communication
between two mobile phones is possible through a base station, which consists of a tower and a small building
containing the radio equipment. Through switching devices in landline telephone exchanges, mobile phone
users can also access the global landline network.

The mobile phone industry owes its growth to information technology, which plays a central and pivotal role
in any mobile system. Technologies like Personal Communications Services (PCS), Time Division Multiple
Access (TDMA) , Global System for Mobile communication (GSM) and Code Division Multiple Access
(CDMA) are often associated with mobile phones.

PCS is a wireless phone service and it is similar to cellular telephone service. It is sometimes referred to as
digital cellular. Like cellular, PCS is for mobile users and requires a number of antennas to blanket an area
of coverage. As a user moves around, the user’s phone signal is picked up by the nearest antenna and then
forwarded to a base station that connects to the wired network.

TDMA is a technology used in digital cellular telephone communication that divides each cellular channel
into three time slots in order to increase the amount of data that can be carried.

GSM is a digital mobile telephone system that is widely used in Europe and other  parts of the world. GSM
uses a variation of TDMA and is the most widely used of the three digital wireless telephone technologies
TDMA, GSM, and COMA. GSM digitizes and compresses data then sends it down a channel with two
other  streams of user data, each in its own time slot. GSM is, in fact, the de facto wireless telephone
standard in Europe.

Some of the popular functions of  mobile computing that are based upon IT are  the following:

    . Short Messaging Service (SMS): SMS can be exchanged between people  who do not believe in long
verbal conversations over I communication channels.. Address book: Address book is a store of contact information maintained on  the mobile handset or the
central server. Thus, it prevents the need of maintaining a hard copy address book and allows the phone user
to access  phone numbers whenever required.  Schedules: You can store a list of important tasks that you wish to accomplish in your mobile phones.
Most mobile phones have software recording appointments schedules and reminders associated with these
tasks.. Get information updates: All mobile service providers now provide add-on facilities for their subscribers
to receive regular updates on news, entertainment and stock market prices. This can be accomplished by
integrating the web-based databases with the mobile user’s database. Service providers also
         use this capability to advertise new products, services and schemes.

All of the above facilities are based upon the usage of electronic computer databases and intelligent computer
software available on the mobile phone. Due to the global trend of convergence, the dividing line between
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information technology and telecommunications technology is getting increasingly blurred. Today’s computers
combine phone, fax, television, VCD/DVD drives and stereo in one seamless bundle.

1.9 SUMMARY

In this unit, you have learned about information technology and its use in business organizations. Information
technology and computers are closely related to each other. Computers are electronic devices that take
some input data from the user, process it and provide some pre-defined output. You have learned that the
different characteristics of computers are speed, accuracy, diligence, versatility, intelligence and storage.
Information technology can be defined as the process of acquiring, storing, processing and distributing
information with the help of computers.

You have also learned about business information that is, information related with business. It can include
sales reports, stock statements and financial analysis reports. Business organizations can also use flexible
systems to improve the efficiency of business. You have learned that the different types of flexible systems
used by business organizations include:. Client-server computing system. Collaborating computing system. Collaboration through Internet

Organizations can also make use of information systems. The unit described that information system generally
refers to the computer systems used by organizations to provide information about business operations. You
also got to know that the different types of information systems used by the organizations include:. Executive support system. Management information system. Decision support system.. Transaction processing system

In addition, you learned about the impact of information technology in modem organizations including banks,
hospitals, insurance companies and tele- communication companies.

1.10  KEY TERMS

.Computer: It can be defined as an electronic device that takes some input data from the user,
processes it and provides some pre-defined output.. Flexible systems: These are systems that are used by organizations according to their requirements.
For example, an organization can use the Internet according to its requirements to collaborate with business
        associates, customers and suppliers.. Hardware: Hardware is the term used to refer to the physical parts of the computer..Information system: An information system can be defined technically as a set of interrelated
components that collect, process, store and distribute information to support decision-making and control in
an organization..Software: It is the set of instructions and programs that are necessary for  the functjoning of a computer.

1.11  ANSWERS TO ‘CHECK YOUR PROGRESS’

   1.  A computer can be defined as an electronic device that takes some input data from the user, processes
it and provides some pre-defmed output.

   2.  The following are the different characteristics of computers:
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A. Speed

B.  Accuracy

C. Diligence

D. Versatility

E. Intelligence

F.  Storage

   3.  Business information is the information related to the business conducted by an organization. The
business information can include sales reports, stock statements and financial analysis report.

   4. The different types of business information are:

A. Action versus no-action information

B. Recurring versus non-recurring information

C. Internal versus external information

D. Planning information

E. Control information

F. Knowledge information

   5. Business organizations can use flexible systems to increase efficiency in conducting their business.
Flexible systems are those systems that are used      by the organizations according to their requirements.

   6. An information system can be defined technically as a set of interrelated components  that collect,
process, store and distribute information to support decision-making and control in an organization.

   7. The different types of information systems are:

A. Executive support system

B. Management information system

C. Decision support system

D. Transaction processing system

    8.  The following are the different features of DSS:

A. DSS does not aim at any specific type of decisions. It has the flexibility  of using unexpected
decision situations, which are not predetermined and not known at the managerial level.

B. The user-friendly interface of DSS makes it different from other types  of information systems.

C. The software tools such as report generators and graphic facilities in DSS provide better ways of
presenting the information.

D. DSS offers complete control over the information systems. A user can control the input, the
method of processing and the output of the information using DSS interactive interface.

    9.  A transaction processing system is a computerized system that performs and  records the daily routine
transactions necessary to conduct business.

1.12  QUESTIONS AND EXERCISES

Short-Answer Questions

     1.  What are the characteristics of a computer?

    2.  What are the different operations of computers?

    3.  Explain how computers and information technology are related.

    4.  What is business information?

    5.  What do you mean by information system?

Long-Answers Questions

    1. Explain the various types of business information.
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    2. What do you mean by information technology in business? Elaborate.

    3. Explain the different types of flexible systems.

    4. Explain the different types of information systems.

1.13 FURTHER READING

Rajaraman, V., Introduction to Information Technology. New Delhi: Prentice- Hall of India.
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Unit- I:

                                COMPUTER  HARDWARE
Structure
2.0 Introduction

2.1 Unit Objectives

2.2 Memory Units
      2.2.1 Read Only Memory (ROM);
      2.2.2  Random Access Memory (RAM);
      2.2.3 Cache Memory

2.3 Storage Devices

      2.3.1 Magnetic Tapes;
      2.3.2 Magnetic Disks;
      2.3.3 Floppy Disks;
      2.3.4 Hard Disks;
      2.3.5 Compact Disks with Read Only Memory (CD-ROM)

2.4 Mass Storage Devices
      2.4.1 Disk Arrays;   2.4.2 Tape Libraries;   2.4.3 CD-ROM Jukeboxes

2.5 Input Devices

      2.5.1 Keyboard;   2.5.2 Mouse;   2.5.3 Trackball;   2.5.4 Joystick;
      2.5.5 Light Pen;   2.5.6 Touch Screen;   2.5.7 Scanning Devices;
      2.5.8 Voice Recognition Devices;   2.5.9 Vision Input Devices

2.6 Output Devices ,
      2.6.1 Display Devices;   2.6.2 Printers;   2.6.3 Plotters;   2.6.4 Projectors;
      2.6.5 Computer Output Microfilm (COM)

2.7 Summary

2.8 Key Terms

2.9 Answers to ‘Check Your Progress’

2.10 Questions and Exercises

2.11 Further Reading

2.0  INTRODUCTION
In this unit, you will learn about the hardware components of the computer. Major components of the
computer are storage devices, input devices and output devices. The unit introduces you to the different
memory units. Storage devices are used to store data and instructions permanently. In this unit, you will
study about some of the commonly used storage devices, namely magnetic disks, floppy disks and optical
disks. You will also learn about mass storage devices.

You will learn that input devices are used to provide data to the computer for processing and that output
devices are used to display the output obtained after a computer completes the task of processing data. You
will learn the characteristics of some of the commonly employed output devices.

2.1  UNIT OBJECTIVES
After going through this unit, you will be able to:.Explain the different types of memory and their storage capacities.Describe the different kinds of storage devices. Describe the input devices that are based on point and draw functionality.   Explain the role of output devices in providing and displaying information to the users
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2.2  MEMORY UNITS.
Data, instructions for processing data, intermediate results of processing and processed data are stored in
the memory unit of a computer. Memory consists of a set of locations, with each location occupying eight
bits. Each bit in the memory is identified by a unique address. Data is stored in the machine-understandable
binary form in these memory locations. Binary data is a combination of Os and 1s. This means that information
such as numbers, characters and instruction codes are represented in terms of Os and 1 s to be stored in the
memory.

2.2.1 Read Only Memory (ROM)
ROM is the permanent memory of the computer that stores data and instructions, even when the computer
is switched off. The contents of ROM cannot be read or modified by an end-user. ROM is a chip that is
inserted into the motherboard. It stores the Basic Input/Output System (BIOS), which performs the Power
On Self Test (POST). POST is performed at the time of booting the system. The test checks whether the
computer components such as memory, input devices and output devices, are fully functional or not. After
performing the POST, BIOS displays a message that includes information such as memory size and hard
disk type. Figure 2.1 shows the structure of ROM.

ROM is used to store fixed programs such as application software that does not require modifications. The
following are the various types of available ROM:.  Programmable ROM (PROM): It enables the users to write information           to it only
once. The user cannot modify the information, once written in            PROM. PROMs are used for the
programs that are permanent and do not           require regular updating.

.  Erasable PROM (EPROM): It allows the erasing of  information written            in the
ROM  more than once by exposing  EPROM to high intensity ultraviolet           rays. EPROMs are widely
used to store programs that are permanent but          require regular updating..  Electrically Erasable PROM (EEPROM): It allows the erasing of         information written
in the ROM more than once by using electric signals.          EEPROMs are also used to store programs
that are permanent but require         frequent updating.

2.2.2 Random Access Memory (RAM)
RAM is the read/write memory unit, which is volatile in nature. Information is retained in RAM only as long
.as there is regular power supply. When the power supply is interrupted or switched off, the information
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stored in the RAM is lost. RAM temporarily stores data and applications as long as they are in use. When
the use of data or the application is over, the content in RAM is erased. Figure 2.2 shows the basic structure
of RAM.

The RAM is soldered to the motherboard, at the time of computer manufacturing. There are connectors on
the motherboard that enable an end-user to connect additional RAM, as per the requirements. The additional
RAM is required in a computer to perform multitasking and to operate large application software such as
Adobe Photoshop. Multitasking refers to the ability of a computer to execute multiple application programs,
simultaneously. RAM chips are available as chips with 4MB-128MB memory size. The different types of
RAM are:

     .   Static RAM (SRAM)

  .  Dynamic RAM (DRAM)

2.2.2.1  Static RAM

SRAM stores information without the need for any refreshing circuit to restore it. In SRAM, a form of flip-
flop which never has to be refreshed holds each bit of memory. A flip-flop for a memory cell takes 4 or 6
transistors along with some wiring. A SRAM is faster than a DRAM as refreshment is not required. However,

SRAM takes more space in a chip as it has more parts than a DRAM. Therefore, you get less memory per
chip and that makes SRAM more expensive than DRAM. Therefore, SRAM is used to create the speed-
sensitive cache of CPU, while DRAM forms the larger system RAM space. The various types of modes in
SRAM are standby mode, read mode and write mode.

SRAM is categorized under different types based on various elements such as the transistor type and the
function. These elements are as follows:.  By transistor type: There are two types of transistors used in a computer based on which SRAM
can be categorized. These types are:

  o    Bipolar Junction Transistor (BJT): These are very fast but consume  a lot of power. These
are used in Transistor-Transistor Logic (TTL)  and Emitter Coupled Logic (ECL).

  o    Metal Oxide Semiconductor Field Effect Transistor  (MOSFET): It consumes less
power and is used in Complementary Metal-Oxide Semiconductor (CMOS)..  By function: SRAM can be categorized into two types based on their functions. These types are:

               o    Asynchronous: These are independent of clock frequency and data in and data out are
controlled by address transition.
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             o    Synchronous: All the timings are initiated by clock edges. Address, data in and other clock
signals are associated with clock signals.

    .  By feature: There are again  two types of SRAM on the basis of their features. These types are:

              o    Zero Bus Turnaround (ZBT): The turnaround is the number of

                    clock cycles it takes to change access to the SRAM from write to

                    read, and vice versa. The latency or delay between the read and

                    write cycle is zero.

               o    Sync Burst SRAM: There is synchronous burst write access to the
                    SRAM to speed up write operation to the SRAM.

The power consumption of SRAM varies widely depending on how frequently it is accessed. It may be very
power hungry when used at high frequencies, while it may draw very little power when used at lower
frequencies. It draws negligible power when sitting idle.

2.2.2.2 Dynamic RAM

DRAM is the most common type of memory in use today. In a DRAM chip, each memory cell holds one bit
of information and is made up of two parts-a transistor and a capacitor. The capacitor holds the bit of
information, i.e., a 0 or a 1. The transistor acts as a switch that lets the control circuitry on the memory chip
read the capacitor or change its state.

A capacitor is able to store electrons. To store a 1 in the memory cell, the capacitor is filled with electrons.
To store a 0, it is emptied. For dynamic memory to work, either the CPU or the memory controller has to
come along and recharge all the capacitors holding a 1 before they discharge. For this, the memory controller
reads the memory and then writes it back. This refresh operation repeats automatically thousands of times
per second. DRAM has to be refreshed all the time or it forgets what it is holding. Hence, it slows down the
memory.

There are many variations of DRAM. Some of them are described as follows:.  Asynchronous DRAM: This is the basic form from which all  the other variations are derived. It has
power connections, some address lines and a few bidirectional lines. There are four active low control
signals in

         asynchronous DRAM:

             o   Row Address Strobe (/RAS): The address inputs are captured on the falling edge of /RAS
and select a row to open. The row is held open as long as /RAS is low.

             o   Column Address Strobe (/CAS): The address inputs are captured on

                the falling edge of /CAS and select a column from the currently open

                 row  to read and write.

o  Write Enable (/WE): This signal determines whether a given falling edge of /CAS is a read or
write. If it is high, then it indicates a read operation and if it is low, then it indicates a write operation and the
data inputs are captured on the falling edge of /CAS.

           o   Output Enable (/OE): This is an additional signal that controls output

                 to the data input/output pins.The data pins are driven by the DRAM chip

                if/RAS and /CAS is low, /WE is high and /OE is low..   Video DRAM (VRAM): It is a dual-ported version of DRAM,formerly used as the bit map in
graphic adapters. It was invented at IBM Research by F.Dill,  D Ling and R.Matick in 1980 and patent
issued in 1985. It was responsible for the advancement of graphics from poor quality, low resolution single
green colour screens of computers to the high resolution, multicolour displays of Super Video Graphics
Array (SVGA) and other higher features. It brought  personal computers to the masses by introducing
Windows, Spreadsheets and  high quality graphics at a very affordable price.
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.   Fast Page Mode DRAM (FPM DRAM): It is also called Page Mode           Memory, where a
row of the DRAM can be kept ‘open’ by holding/RAS low,          while performing multiple reads or
writes with separate pulses of /CAS,so          that successive reads or writes within the row do not suffer
the delay of           precharge and accessing the row. This increases system performance while
           reading or writing bursts of data.There are two types of variant of page modes:

o  Static column: In static column, there is no need to strobe the column                 address,
rather the address inputs may be changed with /CAS held low                  and the data output will be
updated accordingly a few nanoseconds later.

             o  Nibble mode: In nibble mode, four consecutive pulses of /CAS access
                   four sequential locations within the row.The address inputs are generated
    internally starting with the address supplied for the first /CAS edge..   Window RAM (WRAM): Developed by Samsung and marketed by Micron
        Technology, it is an obsolete type of semiconductor designed to replace           VRAM in graphic
adapters. WRAM has dual port DRAM structure, with one          parallel port and one serial port, but
has extra features  enabling fast block         copies and block fills..   Extended Data Out (EDO) DRAM: It is similar to Fast Page Mode DRAM            with an
additional feature that a new access cycle can be started, while keeping           data output of the previous
cycle active. This allows pipelining, thus increasing          the speed..  Burst EDO (BEDO) DRAM: It could process four memory addresses in         one burst,
saving an additional three clocks over optimally designed EDO

         memory.. Multibank DRAM (MDRAM): It allows the interleaving technique for

         main memory to cache memory to provide a cheaper and faster alternative         to SRAM. The chip
splits its memory capacity into small blocks of 256 KB         and allows operations to two different banks
in a single clock cycle..   Synchronous Graphic RAM (SGRAM): It is a specialized form of SDRAM          for
graphic adapters. It adds functions such as bit masking and block write.            It has single port, but it
can open two memory pages at once, which simulates         the dual-port nature of other video RAM
technologies.

2.2.3 Cache Memory

Cache memory is a memory unit that stores data and the related application that was last processed by the
CPU. The CPU copies the last processed data and instructions from the RAM into the cache memory. The
cache memory can be either soldered into the motherboard or are available as a part of RAM.

When the processor performs processing, it first searches the cache memory and then the RAM, for an
instruction. The processor checks the cache memory for instructions first. If the instruction is found in this
memory, the time spent by the processor in searching the cache memory and RAM is reduced. As a result,
the use of cache memory reduces the time required to perform the processing.

The cache memory transfers the blocks of data extracted from RAM to CPU. Figure 2.2 shows the data
flow between CPU, cache memory and RAM.
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The effectiveness of cache memory in reducing the processing time can be measured by the parameter
called hit ratio. A CPU produces a hit, when its search for an instruction in the cache memory is successful.
The CPU produces a miss if the instruction that it searches for in the cache memory is not found. The hit
ratio can be defined as the ratio of the number of hits to the total number of times the CPO has searched the
cache memory.

2.3 STORAGE DEVICES
Storage devices are connected to the computer to provide a non-volatile memory source in addition to the
primary memory of the computer. A storage device is either located in the CPU casing of the computer or
is connected externally to the computer. The storage devices ‘are used to store information that is not in use
currently. Storage devices are also called secondary memory. Storage devices can also be used to store all
system programs and system software. Some of the commonly used storage devices are magnetic tapes,
magnetic disks, floppy disks and hard disks. .

2.3.1 Magnetic Tapes
Magnetic tapes are used for storing files of data that are sequentially accessed or are not used very often
and are stored off-line. They are typically used as back-up storage for archiving data. In case of magnetic
tapes, a ‘.:ape (plastic ribbon usually 1/2 inch or 1/4 inch wide and 50 to 2400 feet long) is wound on a spool
and its other end is threaded manually on a take-up spool. A metal foil called marker is used to determine the
Beginning of Tape (BOT). When a write command is given, a block of data (records are usually grouped in
blocks of two or more) is written on the tape. The next block is then written after a gap called Inter Block
Gap (IBG). A series of blocks are written in this manner. The End of Tape (EOT) is indicated by an end-of
-tape marker which is a metal foil stuck in the tape. After the data is written, the tape is rewound and kept
ready for reading. Figure 2.4 shows a magnetic tape and data organization on a magnetic tape.
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The tape is read sequentially, i.e., data can be read in the order in which the data has been written. This
implies that if the desired record is at the end of the tape, all the earlier records have to be read before it is
reached. A typical example of a tape can be seen in a music tape cassette, where to listen to the fifth song
one must listen to, or traverse, the earlier four songs. The access time of information stored on tape is,
therefore, very high as compared to that stored on a disk.

The storage capacity of the tape depends on its data recording density and the length of the tape. The data
recording density refers to the amount of data that can be stored or the number of bytes that can be stored
per linear inch of tape. The data recording density is measured in Bytes Per Inch (BPI).

Thus
,Storage capacity of a tape = Data recording density x Length of tape

It is worth noting that the actual storage capacity for storing user data is much less
owing to the file header labels, file trailer labels, BOT and EOT markers, and the use of IBGs. Some
commonly used magnetic tapes are:. 1/2 inch tape reel. 1/2 inch tape cartridge. 1/4 inch streamer tape. 4 mm Digital Audio Tape (DAT)

2.3.2 Magnetic Disks
Magnetic disks are direct-access medium and so they are the most popular online secondary storage devices.
Direct-access devices are also called random-access devices because information is literally available at
random or in any order. Access to any location on the device is direct and so approximately equal access
time is required for each location. An example of this is a music CD, where if you wish to listen to the fifth
song, you can directly select the fifth track. It does not require you to fast forward the previous four songs.

A magnetic disk is a circular plate made of metal or plastic, coated with magnetized material. Often, both
sides of the disk are used. Data is recorded on the disk in the form of magnetized and non-magnetized spots
representing Is and Os. Figure 2.5 shows logical layout of a magnetic disk.

Data is stored in concentric rings or tracks. To minimize the interference of magnetic fields, the adjacent
tracks are separated by inter-track gaps. Tracks are commonly divided into sections called sectors. In most
systems, the minimum quantity of information that can be transferred is a sector. Usually eight or more
sectors per track are found.

A track in a given sector near the circumference is longer than the track near the centre of the disk. If bits
were recorded with equal density, some tracks would contain more bits than the other tracks. To ensure that
each sector can store equal amounts of data, some disks use variable recording density with higher density
on tracks near the centre than on tracks near the circumference.

Multiple disks are usually stacked and used together to create disk storage systems having large capacities.
In this case, multiple disks are fixed on a central shaft, one below the other to form a disk pack. This is then
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mounted on a disk drive that has a motor to rotate this disk pack about its axis. The disk drive also has an
access arm assembly with a separate read/write head for each surface of the disk pack. The access arms
for all the disks surfaces move together. A disk system, is thus, addressed by the disk number, the disk
surface, the sector number and the track within the sector.

Usually, the upper surface of the topmost disk and the lower surface of the bottom-most disk are not used,
since these are prone to getting scratched easily. For faster access of data from disk packs, a concept called
cylinders is used. A set of corresponding tracks on all the recording surfaces of the disk pack together to
form a cylinder. Thus, if there are 100 tracks on each disk surface, there are 100 cylinders in the disk pack.

Cylinder-based organization provides faster data access. The related records of the file can be stored on the
same cylinder (on multiple disks of a disk pack) and subsequently with one movement of the access arm, all
records on, say cylinder 5, (fifth track of every recording surface) can be simultaneously read. Figure 2.6
shows a disk pack with four disks.

The storage capacity of a disk system can be determined as follows:

Storage capacity  =  Number of recording surfaces  x  Number of tracks per surface x  Number of sectors
per track  x Number of bytes per sector

Example: If a disk pack consists of four plates each having 2655 tracks with125 sectors per track. Also,
each sector can store 512 bytes, then

Storage capacity = 6 x 2655 x 125 x 512 = 1,01,95,20,000 bytes = 1 x 109 bytes approximately or 1 GB or 1
Gigabyte

Note: There are six recording surfaces because of the presence of four disk plates.

2.3.3 Floppy Disks

The disks used with a floppy disk drive are small removable disks made of plastic coated with magnetic
recording material. The data in a floppy disk is stored in tracks that contain sectors. The read/write head of
the floppy disk drive also rotates and can move to any location on the disk surface, to read or write data to
the floppy disk. The floppy disk contains an oval shaped hole called the write-  protect notch, through which
the read/write head accesses the floppy disk. The end-user cannot read or write data to a floppy disk, if the
right access to the ) floppy disk is protected. The storage capacity of floppy disks ranges from 720 K  to 2.88
MB. The most commonly used floppy disk has diameter equal to 2½  inches. The floppy disk having
diameter equal to 2½ inches can store data on both sides of the disk, therefore, they are also called double-
sided disks. These disks come in three different capacities -double density, high density and very high
density. These are smaller and can store more data than the 5¼ inch disks can. Figure 2.7 shows a 2½ inch
floppy disk.
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The storage capacity for any disk can be calculated as:

Storage capacity = Number of recording surfaces x Number of tracks per surface x Number of sectors per
track x Number of bytes per sector

Thus, for a 2Y2 inch high-density disk, which has 80 tracks, 18 sectors/track, and 512 bytes/sector, the disk
storage capacity can be calculated as follows:

2 x 80 x 18 x 512 = 14,74,560 bytes or 1.4 MB (approximately)

2.3.4 Hard Disks

Hard disk consists of a metallic or plastic disk, coated with a magnetic material. In hard disks, data is stored
in concentric circles, which are known as tracks. A track is made up of a collection of sectors. The hard disk
drive contains disks that are placed one above the other on a shaft known as spindle. The spindle is placed
inside a dust-proof casing. The shaft rotates at the speed of 2400 revolutions per minute. Each disk contains
two surfaces- upper surface and lower surface. Each surface has a read/write head that is attached to a
moveable arm. Information is stored on the surfaces of a disk in such a manner that no information is stored
on the upper surface of the first disk and the lower surface of the second disk. The disks in the hard disk
drive rotate simultaneously with the movement of the shaft. Address bits are used for labelling the hard disk.
Address bits are a sequence of bits that indicate the disk number, disk surface, sector number and track in
the sector. When the read/write head is placed at a track, the computer system waits for performing the
read or write operation, till the sector indicated in the read/write head, is reached. Hard disks can be
classified into the following :categories:. Disk packs: Disk packs consist of two or more hard disks mounted on a single central shaft. Because
of this, all disks in a disk pack rotate at the

         same speed. It consists of separate read/write heads for each surface. Disk packs are removable in
the sense that they can be removed and kept offline when  not in use. They have to be mounted on the disk
drive before they can be used. Thus, different disk packs can be mounted on the same disk drive at
 different instances, thereby providing virtually unlimited storage capacity.Figure 2.8 shows a  disk pack.
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.  Winchester disks: These disks also consist of two or more hard disk platters mounted on a single
central shaft but are of the fixed type. The disk platters are sealed in a contamination-free container.Due to
this fact all the disk platters, including the upper surface of the topmost disk platter and the lower surface
          of the bottommost platter, are used for storing data. So, even though Winchester disks have limited
storage capacity as opposed to disk packs, they can store larger amounts of data as compared to the same
number of disk platters.Figure

2.9 shows a Winchester disk.

.

.  Zip disks: These are very common today. Zip disks consist of a single hard disk platter encased in a
plastic cartridge. Such a disk typically has a capacity of about 100 MB. Further, the zip drive can be fixed or
portable. The fixed zip drive is permanently connected to the computer system, while the portable o n e s
can be carried around and connected to any computer system for the duration of its use; Figure 2.10 shows
a zip disk.

2.3.5 Compact Disks with Read Only Memory (CD-ROM)

CD-ROM is a circular optical disk, which is used to store textual, graphical, audio and video content. It is
usually made from a resin named polycarbonate that is coated with aluminium to form a highly reflective
surface. The information on a CD-ROM is stored as a series of microscopic pits on the reflective surface by
using high-intensity laser beam. The process of recording information on these disks is known as mastering.
The information is retrieved from a CD-ROM with the help of a low-powered laser, which is generated in an
optical disk drive unit. The disk is rotated and the laser beam is aimed at the disk. The intensity of the laser
beam changes as it encounters a pit. A photo-sensor detects the change in intensity, thus recognizing the
digital signals recorded on the surface of the CD-ROM and converts them into electronic signals of Is and
Os. CD-ROMs are very useful for distributing large amounts of information to a large number of users. The
following are the advantages of CD-ROMs:.  Large storage capacity for storing data and information.  Fast and inexpensive mass replication.Suitable for archival storage since they are removable disks
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The disadvantages of CD-ROMs are:.  They are read-only and cannot be updated..  Access time of CD-ROM is greater than that of a magnetic disk.

2.4  MASS STORAGE  DEVICES
Any physical storage media has a limit to its capacity and performance. There is a constant effort towards
improving such media and as a result, larger capacity is secondary storage devices have emerged. These
are characterized by using ge multiple units of the same storage media, as a single unit, to provide higher
storage capacities. Disk arrays, tape libraries and CD-ROM jukeboxes are the three most commonly used
mass storage devices.

Mass data storage devices are characterized by relatively slow access time. This is because additional time
in terms of fIrst locating the desired disk, tape, or CD-ROM needs to be accounted for. However, they are
more cost effective in case of :s applications that require huge storage capacity and for which rapid access
to data is not the prime consideration. They can also be used for offline or archival storage of information/
data, since they can support huge volumes of information/data to be backed up.

2.4.1 Disk Arrays

RAID is an acronym for a disk array and consists of a number of hard disks and disk drives with a controller
in a single box. The basic idea of RAID was to combine multiple small, inexpensive disk drives into an array
of disk drives, which will yield performance exceeding that of a Single Large Expensive Drive (SLED).
Additionally, this array of drives appears to the computer as a single logical storage unit or drive.

The concept was pioneered through academic research funded by Digital Equipment Corporation and has
now become a standard in the computing industry for applications requiring fast and reliable storage of large
volumes of data.

There are several different types of RAID configurations that are described in terms of ‘levels’. The
various levels of RAID storage are as follows:. RAID 0: Data is split across drives, resulting in higher data throughput. Since no redundant information
is stored, performance is very good, but the failure of any disk in the array results in data loss. This level is
commonly referred to as striping..  RAID 1: It provides redundancy by writing all data to two or more drives.The performance of a level
1array tends to be faster on reads and slower on writes compared to a single drive, but if either drive fails,
no data is lost.This level is commonly referred to as mirroring.Mirroring is the most expensive RAID option,
but it is highly reliable.. RAID 0+1: It is a combination of striping and mirroring. This  configuration provides optimal speed
and reliability, but possesses the same cost problem as RAID 1..  RAID 5: It employs a combination of striping and parity checking. The use of parity checking
provides redundancy without the overhead of having to double disk capacity. Simply put, parity checking
involves determining whether each given block has an odd or even value. These values are summed across
the stripe sets to obtain a parity value. With this parity value, the contents of a failed disk can easily be
determined and rebuilt on a spare drive.

There are other RAID configurations in addition to the ones described, but these are the ones most commonly
used in the industry. As can be noticed, RAID configurations result in higher reliability due to the use of
multiple disks. In addition to this, both mirroring and striping also result in speeding up the read process since
different parts of the same file, residing on different disks, can be read at the same time.

2.4.2 Tape Libraries

Network administrators are hungry for technologies that will allow them to efficiently and economically
manage the explosive growth in data stored on networks. As the amount of data increases, the back-up
process takes longer time. Simply adding another tape drive to reduce the back-up time does not really help.
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Further, systems operated in this manner represent one of the largest operational costs of a data centre and
also typically represent the predominant need for human intervention.

The solution to this problem is the multi-drive automated tape library. These libraries consist of a set of
magnetic tapes with a controller mounted in a single unit. The unit may have one or more tape drives to read
and write data on the tapes in the tape library. Automated tape libraries allow random access to large
numbers of tape cartridges and concurrent use of two or more drives, rather than manually loading one tape
after another. The unit typically has robotic arms to retrieve the appropriate tape from the tape library and
mount it on one of the tape drives for processing.

Automated tape libraries can be designed to provide extremely precise control “and support for tape drives.
Properly implemented, library automation can significantly enhance the operational reliability of tape drives
by eliminating the highly variable human/machine interface. In this particular case, the objective of the
system design is to avoid failures rather than to tolerate them, as is the case in RAID systems.

Automated tape libraries are typically used for data archiving purposes and as an online data back-up device
for automated back-up. Figure 2.11 shows a RAID consisting of eight disks.

2.4.3 CD-ROM Jukeboxes

The CD-ROM jukebox is much like the automated tape library, but consists of a set of CD-ROM disks
instead of the magnetic tapes. The set of CD-ROM disks along with a controller are mounted on a single
unit. Once again, the unit can have one or more drives to read data from the disks in the jukebox. The unit
has robotic arms to retrieve the appropriate CD and mount it on one of the CD-ROM drives for processing.
At the end of processing, the CD is automatically returned to the appropriate slot.

CD-ROM jukeboxes are typically used for archiving read-only data that can be

accessed online, e.g., online encyclopaedias, online directories, etc. A large CD- ROM jukebox may consist
of hundreds of disks providing a storage capacity of terabytes.

2.5 INPUT DEVICES
An input device accepts data from the outside world and transforms it into a form, which the computer can
interpret. Keyboards are the most commonly used input devices. Point-and-draw devices are used to point
to, and select menu items or icons displayed on screen. They provide a means for Graphical User Interface
(GUI). The mouse, trackball, joystick, light pen and touch screen are commonly used point-and-draw devices.
However, scanning devices that provide direct data input from source documents are of two types -CONTACT
and LASER. Electronic card readers read the data encoded on electronic cards and convert it to machine-
readable form, for further processing. This unit also describes other voice recognition devices that input data
in the form of human voice, thereby providing an easy means of data input.

This can be explained with a very common scenario where the average marks of a student need to be
calculated, based on the marks obtained in various subjects by the student. The marks would typically be
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available in the form of a document containing the student’s name, roll number and marks scored in each
subject. This data must first be stored in the computer’s memory after converting it into machine-readable
form. The data will then be processed and sent from the memory to tile output unit, which will present the
data in a form that can be read by users.

Figure 2.12 shows the role of I/O devices in a computer system.

Input devices, which provide a means of communication between the computer and the outside world, are
known as peripheral devices. This is because they surround the CPU and the memory of a computer
system. While input devices are used to enter data from the outside world into the primary storage, output
devices are used to provide the processed results from primary storage to users. The following are the
examples of input devices, which are used for different types of multimedia applications:. Keyboard. Mouse. Trackball. Joystick. Light Pen. Touch Screen. Scanning Devices. Voice Recognition Devices. Vision Input Devices

2.5.1 Keyboard

Keyboard devices allow input into the computer system by pressing a set of keys, mounted on a board
connected to the computer system. Keyboard devices can be classified into the following categories:. General-purpose keyboards. Special-purpose keyboards

2.5.1.1 General-purpose keyboards

The most familiar means of entering information into a computer is through a typewriter-like keyboard that
allows a person to enter alphanumeric information directly.

The most popular keyboard used today is the 101-keys with a traditional QWERTY layout, having an
alphanumeric keypad, 12 function keys, a variety of special-function keys, numeric keypad and dedicated
cursor-control keys. It is so called because the arrangement of its alphanumeric keys in the upper left row.
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Figure 2.13 shows the QWERTY keyboard layout.

.  Alphanumeric Keypad: This contains keys for the English alphabets such as a to z or A to Z,
numeric numbers such as 0 to 9 and special characters like *, +, -and I.

.  Twelve Function Keys: These are keys labeled F1, F2 ...Fl2 and are a set of user programmable
function keys. The actual function assigned to a

         function key differs from one software package to another. These keys are  also called soft keys
since their functionality can be defined by the software.. Special Function Keys: Special function keys have special functions assigned to each of these keys.
Special keys include:

o   Shift key: This key is used to enter capital letters or special characters
    defined above the number keys.

o   Spacebar key: This key is used to enter a space at the cursor location.

o  Ctrl key: This key is used in conjunction with other keys to provide added functionality on the
keyboard.

o  Alt key: This key is the same as Ctrl key and it is used to expand the functionality of the
keyboard.

o  Tab key: This key is used to move the cursor to the next tab position defined.

o  Backspace key: This key is used to move the cursor one position to the left and also delete the
character in that position.

o  Caps Lock key: This key is used to toggle between the capital letter lock feature. When ‘on’, it
locks the keypad for capital .letters input.

o  Num Lock key: This key is used to toggle the number lock feature on and off. When ‘on’, it
inputs numbers when you press the numbers on the numeric keypad.

o   Insert key: This key is’ used to toggle between the insert and overwrite
     mode during data entry -when ‘on’, entered text is inserted at the cursor location.

o   Delete key: This key is used to delete the character at the cursor location.

o  Home key: This key is used to move the cursor to the beginning of the work area which could
be the line, screen or document depending on the software being used.

o  End key: This key is used to move the cursor to the end of the work area.

o  Page Up: This key is used to display the previous page of the document being currently viewed
on the screen.



15

o  Page Down key: This key is used to view the next page of the document  being currently viewed
on the screen.

o  Escape key: This key is usually used to negate the current command.

o  Print Screen key: This key is used to print what is being currently
    displayed on the screen.

o  Numeric Keypad: It consists of keys having numbers 0 to 9 and mathematical operators such as
+, -, * and I defined on them. It is usually located on the right side of the keyboard and supports quick entry
of numerical data.

o  Cursor-control key: This includes keys defined by the arrow keys used to move the cursor in
the direction indicated by the arrow.

2.5.1.2 Special-purpose keyboards

These are stand-alone data entry systems used for computers deployed for specific applications. These
typically have special purpose keyboards to enable faster data entry. A very typical example of such keyboards
can be seen at the Automatic Teller Machines or the ATMs, where the keyboard is required for limited
functionality by the customers. Point-of-Sale or POS terminals at fast food joints, Air/Railway reservation
counters are some other examples of special-purpose keyboards. These keyboards are specifically designed
for special types of applications only.

2.5.2 Mouse

A mouse is a small device that a computer user pushes across a desk surface in order to point to a place on
a display screen and to select one or more actions possible from that position. The mouse first became a
widely used computer tool when Apple Computer made it a standard part of the Apple Macintosh. Today,
the mouse is an integral part of GUI of any personal computer. The mouse apparently got its name by being
about the same size and shape as a toy mouse. Figure 2.14 shows a mouse.

                                                        Fig2.14: Mouse

The most conventional kind of mouse has two buttons on top: the left one is used most frequently. In the
windows operating systems, it lets the user click once to send a ‘Select’ indication that provides the user
with feedback that a particular position has been selected for further action. The next click on a selected
position or two quick clicks on it causes a particular action to take place on the selected object. For example,
in Windows operating systems, it causes a program associated with that object to be started. The second
button, on the right, usually provides some less-frequently needed capability. For example, when viewing a
Web page, you can click on an image to get a pop-up menu that, among other things, lets you save the image
on your hard disk. Some models have a third button for additional capabilities. Some mouse manufacturers
also provide a version for left-handed people.

2.5.3 Trackball

The trackball is a pointing device that is much like an inverted mouse. It consists of a ball inset in a small
external box, or adjacent to-and in the same unit as-the keyboard of some portable computers. Figure 2.15
shows a trackball.
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It is more convenient and requires much less space than the mouse, since here the whole device is not
moved as in the case of a mouse. The trackball comes in various shapes but supports the same functionality.
Typical shapes used are a ball, a square and a button.

2.5.4 Joystick

The joystick is a vertical stick that moves the graphic cursor in the direction the stick is moved. It consists of
a spherical ball, which moves within a socket, and has a stick mounted on it. The user moves the ball with the
help of the stick that can be moved left or right, forward or backward, to move and position the cursor in the
desired location. Joysticks typically have a button on top that is used to select the option pointed by the
cursor. Video games, training simulators and control panels of robots are some common uses of a joystick.
Figure 2.16 shows a joystick.

                                                   Figure 2.16 : joystick

2.5.5 Light Pen

The light pen is a pen-shaped device allowing natural movement on the screen. It is made up of a light
sensitive cell and a lens assembly designed in such a way that it focuses onto itself any light in its field of
view. The pen contains a light receptor and is activated by pressing the pen against the display screen. The
receptor is the scanning beam that helps in locating the pen’s position (X and Y coordinates on the screen).
Suitable system software is provided to initiate the desired action once the area on the display screen is
located with the help of the light pen. Light pens are typically used in Computer Aided Design (CAD)
applications to directly draw on screen. Figure 2.17 shows a light pen.

                                             Figure 2.17 shows a light pen

2.5.6 Touch Screen

A touch screen is probably one of the simplest and most intuitive of all input devices. It uses optical sensors
in, or near, the computer screen that can detect the touch of a finger on the screen. Once the user touches
a particular position on the screen, sensors communicate the position to the computer. This is then interpreted
by the computer in order to understand the user choice for input. The most common usage of touch screens
is in information kiosks, where users can receive information at the touch of a screen. These devices are
becoming increasingly popular today.

2.5.7 Scanning Devices

Scanning devices are input devices used for direct data entry from the source document into the computer
system. Scanners facilitate the capturing of information and storing it in a graphical format for displaying it



17

back on the graphical screen. They consist of two components, one to illuminate the page so that the optical
image can be captured and the other to convert the graphical image into a digital format for storing. The
graphical images thus scanned can be ; seen and processed directly by the computer.

There are two types of scanners, CONTACT and LASER. Both bounce a beam of light off an image, and
then measure the reflected light to determine the value of the image. Hand-held contact scanners make
contact as they are brushed over the printed matter to be read. Laser-based scanners are more versatile and
can read data passed near the scanning area. Hand-held scanners are used where the information to be
scanned or the volume of documents to be scanned is very low. They are much cheaper as compared to the
flatbed scanners. Figure 2.18 (a), (b) shows hand-held and flatbed scanners, respectively.

Capturing information using scanners reduces the possibility of human error typically seen during large data
entry. The reduction in human intervention improves the accuracy of data and provides for timeliness of the
information processed.

Most recent trends for data input are towards source data automation. The equipment used for source data
automation capture data as a by-product of a business activity, thereby completely eliminating manual input
of data. Some common examples of these are described below.

2.5.7.1 Optical Mark Recognition (OMR)

OMR devices can sense marks on computer readable paper. This kind of devices are typically used by
academic institutions to grade aptitude tests, where candidates need to mark the correct option from a
number of alternatives, on a special sheet of paper. These answer sheets can then be directly read by the
optical mark recognition device and can be used for further processing by the computer.

The actual technique used by an OMR device once again involves focusing a light on the page being
scanned, thereby detecting the reflected light pattern for the marks. Pencil marks made by the user reflect
the light determining which responses are marked. Figure 2.19 shows an example of a pre-printed answer

sheet that can be read by an OMR device.



18

2.5.7.2 Magnetic Ink Character Recognition (MICR)

MICR is similar to optical mark recognition and is used exclusively by the banking industry. MICR devices
are used by the banking industry to read the account numbers on cheques directly and subsequently do the
necessary processing.

Banks using the MICR technology print cheque books on special types of paper. The necessary details of
the bank are pre-printed on the cheques using ink that contains iron oxide particles that can be magnetized.

MICR readers are used to read and sort cheques and deposits. An MICR reader- sorter reads the data on
the cheques and sorts the cheques for distribution to other banks and customers or for further processing.
Figure 2.20 shows a bank cheque using MICR technology.

2.5.7.3 Optical Bar Code Reader (OBR)

Data coded in the fonn of small vertical lines forms the basis of bar coding. Alphanumeric data is represented
using adjacent vertical lines called bar codes. These are of varying widths and the spacing between them is
used to uniquely identify books, merchandise in stores, postal packages, etc.

A barcode reader uses laser beam technology. The laser beam is moved across the pattern of bars in a bar
code. These bars reflect the beam in different ways. The reflected beam is then sensed by a light-sensitive
detector, which then converts the light patterns into electrical pulses, thereby transmitting them to logic
circuits for further conversion into the alphanumeric value.

Barcode devices are available as hand-held devices. Figure 2.21 shows a barcode reader.

2.5.7.4 Digitizers

Digitizers are used to convert drawings or pictures and maps into a digital format for storage in the computer.
A digitizer consists of a digitizing or graphics tablet, which is a pressure sensitive tablet, and a pen with the
same X and Y coordinates as on the screen. Some digitizing tablets also use a crosshair device instead of a
pen. The movement of the pen or crosshair is reproduced simultaneously on the display screen. When the
pen is moved on the tablet, the cursor moves simultaneously to the corresponding position on the computer
screen. This allows the user to draw sketches directly or input the existing sketched drawings easily. Digitizers
are most commonly used by architects and engineers as a tool for Computer Aided Designing (CAD).
Figure 2.22 shows a digitizing tablet.
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2.5.7.5 Electronic-card reader
Card readers are devices that also allowdirect date input into a computer system. The electronic-card
reader is connected encoded on an electronic card and transfers it to the computer system for further
processing.

Electronic cards are plastic cards with data encoded on them and meant for a specific application. Typical
examples of electronic cards are the plastic cards issued by banks to their customers for use in Automatic
Teller Machines or ATMs. Electronic cards are also used by many organizations for controlling access of
various types of employees to physically secured areas.

Depending on the manner in which the data is encoded, electronic cards may be either magnetic strip cards
or smart cards. Magnetic strip cards have a magnetic strip on the back of the card. Data stored on magnetic
strips cannot be read with the naked eye, a useful way to maintain confidential data. Figure 2.23 shows an
access card security system.

2.5.7.6 Smart cards

Smart cards, going a stage further, have a built-in microprocessor chip where data can be permanently
stored. They also possess some processing capability making them suitable for a variety of applications. For
example, to gain access, an employee inserts a card or badge in the reader. This device reads and checks
the authorization code before permitting the individual to enter a secured area. Since smart cards can hold
more information as compared to magnetic strip cards, they are gaining popularity.

2.5.8 Voice Recognition Devices

Voice recognition devices consist of a microphone attached to the computer system. A user speaks into the
microphone to input data. The spoken words are then converted into electrical signals. A digital-to-analog
converter then converts the analog form to digital form (Os and 1 s) that can be interpreted by the computer.
The digitized version is then matched with the existing pre-created dictionary to perform the necessary
action.
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Voice recognition devices have limited usage today because they have several problems associated with
them. Not only do they require the ability to recognize who is speaking, but also what is being said. This
difficulty arises primarily because people speak with different accents and different tone pitches. The computer
requires a large vocabulary to be able to interpret what is being said. Today’s voice recognition systems are,
therefore, successful in a limited domain. They are limited to accepting words and tasks within a limited
scope of operation and can handle only small quantities of data. Figure 2.24 shows the different steps in a
voice recognition system.

Most speech-recognition systems are speaker-dependent, that is, they respond to the unique speech of a
particular individual, a feature not necessarily inconvenient, .but nevertheless limiting in generalized
applications. It, therefore, requires creating a database of words for each person using the system.

2.5.9 Vision Input Devices

Vision input devices allow data input in the form of images. It usually consists of a digital camera, which
focuses on the object whose picture is to be taken. The camera creates the image of the object in digital
format, which can then be stored within the computer. The system then compares the digitized image to be
interpreted to the pre-recorded digitized images in the computer’s database; much like a speech-recognition
system does with voice input. The computer identifies the image by matching the structure of the input
image with those images in the database. Based on whether on not the match is found, the appropriate
action is taken.

Video input or capture is the process of entering full-motion recording into a computer and storing the video
on a hard disk or some other medium. Video capture cards are needed for entering video information in the
computer. The video files thus created usually take up huge amounts of space on a hard disk and so are
usually compressed before storage. The most popular standard used for compression is the Motion Pictures
Expert Group (MPEG). Web cameras and Video Cameras are most commonly used to input visual data.

2.6 OUTPUT DEVICES

The output of the processing done by the computer can be obtained on a display unit or on a paper. Other
kinds of output like speech output and mechanical output are also used in certain applications. Output
produced on display units or speech output that cannot be touched, is referred to as softcopy output while
output produced on paper or material that can be touched, is known as hardcopy output. A wide range of
output devices is available today and can be broadly classified under the categories of:. Display devices. Printers .Plotters. Projectors c,. Computer output microfilm
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2.6.1 Display Devices

One of the most common and important peripherals in a computer system is the display device. Conventional
computers used display terminals known as alphanumeric terminals. These used a form of multi-dot (7 x 5
or 9 x 7) array to display characters. These were used to read text information displayed on the screen. The
increasing demand for displaying graphs and pictures, for visual presentation of information, brought about
the advent of graphic display devices.

Graphic display is typically made up of a series of dots called ‘pixels’, whose pattern produces the image.
Each dot on the screen can be addressed uniquely and directly. Owing to the fact that each dot can be
addressed as a separate unit, it provides greater flexibility for drawing pictures. The following are the
commonly

used display devices:.  Cathode Ray Tube (CRT). Liquid Crystal Display (LCD). Projection display. Monitors

2.6.1.1 CRT

The main components of a cathode ray terminal are the electron gun, the electron beam controlled by an
electromagnetic field and a display screen, which is phosphor-coated. The screen’s phosphor coating is
organized into a grid of dots called pixels. The electron gun emits an electron beam, which is directed
towards the phosphor-coated display by the electromagnetic field, and this in turn creates the image. There
are two types of CRT displays:.Vector CRT display: Here, the electron beam is directed only to the places where the image is to be
created..Raster scan display: Here, the image is projected on the screen by directing the electron beam across
each row of the picture elements from the top to the bottom of the screen. This type of display provides a
high dynamic capability since the image is continuously refreshed. It offers full colour display at a relatively
low cost, and is therefore becoming increasingly popular.

The quality of display is indicated by the resolution of the display device. The number of horizontal and
vertical pixels determines the resolution. Typical resolutions in graphic display range from 800 x 600 to 1024
x 1024 pixels. Based on the resolution and the number of colours supported, several standards for colour
monitors have evolved. The most popular of these include:. Colour graphics adapter (CGA) which has a resolution of 220 x 200 and supports up to 16 colours..  Extended graphics adapter (EGA) has a resolution of 640 x 250 and supports up to 16 colours.. Video graphics adapter(VGA) has a resolution of 640 x 480 and supports up to 256 colours.. Super VGA having a resolution ranging 800 x 600 to1280 x 1024 and supporting up to 256 or more
colours.

Note that each one of these is implemented by installing an add-on card in the computer, commonly known
as graphics adapter or the video card. This card is then connected to the appropriate monitor.

2.6.1.2 LCD

This was introduced in watches and clocks in the 1970s and is now applied in the display terminals. Here, the
cathode ray tube was replaced by the liquid crystal to produce the image. It does not have colour capability
and the image quality is relatively poor. The main advantage of LCD is its low energy consumption.
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It finds its most common usage in portable devices, where compactness and low energy requirements are of
prime importance.

2.6.1.3 Projection display

Projection display technology is characterized by replacing the personal size screen with large screens upon
which the images are projected. These systems are connected to the computer, and whatever appears on
the computer terminal gets enlarged and projected on a large screen. These are being used today for large
group presentations.

2.6.1.4 Monitors

Monitors use CRT to display information. It resembles a television screen and is similar to it in other respects.
The monitor is typically associated with a keyboard for manual input of characters. The screen displays
information as it is keyed in, enabling a visual check of input before it is transferred to the computer. It is also
used to display the output from the computer and hence serves both as an input and an output device. The
monitor along with the keyboard is called a Visual Display Unit (VDU). This is the most commonly used
input/output device today and is also known as a soft copy terminal. A printing device is usually required to
provide a hard copy of the output. Figure 2.25 shows a CRT monitor.

2.6.2 Printers

The printer is an output device that can be used to transfer the text displayed on the screen onto the paper.
The printer is connected to the.computer as an external device with the help of cables. Printers can be
classified as impact or non-impact printers, based on the technology they use for producing output. Impact
printers use variations of standard typewriter printing mechanism, in which a hammer is used to strike the
paper through an inked ribbon. These printers have a mechanism that touches the paper in order to create an
image. Dot matrix printers and character printers fall under this category. Non-impact does not touch the
paper while creating the image. They use chemical, heat or electrical signals to etch symbols on paper.
Many of these require special coated or treated paper. lnkjet, laser and thermal printers fall under this
category of printers.

Printing quality is determined by the resolution of printing and is characterized by the number of dots that can
be printed per linear inch, horizontally or vertically. It is measured in terms of Dots-Per-Inch DPI. On the
basis of their printing quality, printers can be classified as Near-Letter-Quality (NLQ), Letter-Quality (LQ),
Near Typeset Quality (NTQ), and Typeset-Quality (TQ) printers. NLQ printers has resolution equal to 200
DPI, LQ has resolution equal to 600 DPI, NTQ has resolution equal to 1200 DPI, and TQ has resolution
equal to 2000 DPI. NLQ and LQ printers are used for ordinary printing in day-to-day activities, while NTQ
and TQ printers are used to produce top-quality printing, typically required in the publishing industry. The
following are the examples of commonly used printers:. Dot matrix printers. Inkjet printers. Laser printers
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2.6.2.1 Dot matrix printers

Dot matrix printers are the most popular impact printers used in personal computing. The dot matrix printers
make use of perforated sheets to print the text. These printers use a print head consisting of a series of small
pins to strike a ribbon coated with ink, causing the ink to transfer to the paper at the point of impact.
Characters thus produced are in a matrix format. The shape of each character, i.e., the dot pattern, is
obtained from information held electronically.

The speed, versatility, ruggedness and low cost of Dot matrix printers make such printers particularly attractive
in the personal computer market. Typical printing speeds in case of dot matrix printers range between 40 -
1000 cps (characters- per-second). The one major disadvantage of this technology is that the print quality is
low. Figure 2.26 shows characters formed using dots and a Dot matrix printer.

2.6.2.2 Inkjet printers

Inkjet printers use a series of nozzles to spray drops of ink directly on the paper. These, therefore, fall under
the category of non-impact printers. The inkjet printers contain the ink cartridges that are attached to the
printer head that moves horizontally, from left to right. The print head of an inkjet printer consists of a
number of tiny nozzles that can be selectively heated up in a few microseconds by an IC register. When this
happens, the ink near it vaporizes and is ejected through the nozzle to make a dot on the paper placed in front
of the print head. The character is printed by selectively heating the appropriate set of nozzles as the print
head moves horizontally. Figure 2.27 shows an inkjet printer.

2.6.2.3 Laser printers
Laser printers use dry ink, static electricity and heat to place and bond the ink onto the paper. They use a
combination of laser and photocopier technology. Printing is achieved by deflecting laser beam onto the
photosensitive surface of a drum after which the latent image attracts the toner to the image. The toner is
then electro-statistically transferred to the paper and fixed into a permanent image. Figure 2.28 shows a
Laser printer.
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Laser printers are capable of converting computer output into print, page by page. Since characters are
formed by very tiny ink particles, they can produce very high quality images such as text or graphics,
generally offer a wide variety of character fonts, and are silent and fast in use. Laser printers are faster in
printing speed than the other printers discussed above. Their speeds can range from ten pages a minute to
about 200 pages per minute, depending upon the make/model.

Laser is high quality, high speed, high volume, and non-impact technology that work on plain paper or pre-
printed stationary. This technology is relatively expensive, but is becoming very popular because of the
quality, speed and noiseless operations.

2.6.3 Plotters
Plotters are used to produce graphical output on paper. It is a device capable of producing charts, drawings,
graphics, maps, etc. It is much like a printer but is designed to print graphs instead of alphanumeric characters.

Based on the technology used, plotters may be pen plotters or electrostatic plotters. While pen plotters have
an ink pen attached to draw the images, electrostatic plotters work similar to a laser printer. Using plotters,
image is produced by charging the paper with high voltage. This voltage attracts the toner, which is then
melted on the paper with heat. Electrostatic plotters are fast, but the quality is generally considered to be
poor when compared to pen plotters. This is why pen plotters are more extensively used as compared to
electrostatic plotters. Flatbed plotters and drum plotters constitute the most commonly used plotters.

2.6.3.1 Flatbed Pl.otters

Flatbed plotters have a flat base like a drawing board on which the paper is laid as shown in Figure 2.29. One
or more arms, each of them carrying an ink pen, moves across the paper to draw. The arm movement is
controlled by a microprocessor (chip). The arm can move in two directions, one parallel to the plotter and the
other perpendicular to it. With this kind of movement, it can move very precisely to any point on the paper
placed below.
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The computer sends commands to the plotter which are translated into x and y movements. The arm moves
in very small steps to produce continuous and smooth graphics. The size of the plot in a flatbed plotter is
limited only by the size of the plotter’s bed.

The advantage of flatbed plotters is that the user can easily control the graphics. He can manually pick up
the arm anytime during the production of graphics and place it on any position on the paper to alter the
position of graphics to his choice. The disadvantage here is that flatbed plotters occupy a large amount of
space.

2.6.3.2 Drum plotters

Drum plotters use a drum revolver to move the paper during printing as shown in Figure 2.30. The arm
carrying a pen moves only in one direction, perpendicular to the direction of the motion of the paper. Thus,
in drum plotters the pen is moved in a single axis track and the paper itself moves on a cylindrical drum to
add the other axis or dimension. The combination of the pen and paper movement creates the graphics.

The size of the graph, is therefore, limited only by the width of the drum and can be of any length. Drum
plotters are very compact and lightweight as compared to flatbed plotters. This is one of the advantages of
such plotters. The disadvantage, however, is that the user cannot freely control the graphics when they are
being created.

Plotters are more expensive when compared to printers. Typical application areas for plotters include:
Computer-Aided Engineering (CAE) applications like Computer-Aided Design (CAD), Computer-Aided
Manufacturing (CAM) and architectural drawing.

2.6.4 Projectors

A projector is an output device that integrates a light source, optics system, electronics and display for the
purpose of projecting the information from the computer or video device onto a wall or screen. Thus, the
information projected by the projector can be viewed by a large number of people. A projector is a device
that is connected to a computer or video in the same manner as the monitor is connected to the computer.
Projectors are widely used for giving presentations. The computer can be used to prepare the audio, video,
image and animation in the presentations and then the projector can be used to make these presentations
more lively and interesting. Projectors are thus used to show the information to more people.

One form of the projector is video projector. A video projector is used to take the video signal from the
computer or some other video device and project the corresponding image on to the wall or projection
screen using a lens system. The video projects use the bright light to project the information. Video projectors
can be used for conference room presentations, classroom training; and home theatre applications. Figure



26

2.31 shows the video projector.

Video projector can be of four types. These are described as follows:. LCD projector: A Liquid Crystal Display (LCD) projector is one kind of  video projector that can be
used to display the images, video or computer data on a screen or other flat surface. LCD projectors display
the information by sending light from a halogen lamp through three LCD panels. Each of   these LCD panel
is used for red, green and blue components of the video signal. The individual pixels in these panels can be
opened to pass through  the light or can be closed to block the light. This combination of open and  closed
pixels can produce a wide range of colours and shades in the projected image.Halogen lamps are used in the
LCD projector, because they produce an ideal colour temperature and a wide range of colours. These lamps
can also spread a large amount of light in a very small area.. CRT projector: A Cathode-Ray Tube (CRT) projector is another kind of  projector that displays the
image by using a high-brightness picture tube. The image generated by this type of projector can be focused
and enlarged by using a lens kept in front of the CRT face. Modem projectors use three CRTs instead of a
single CRT and their own lenses to achieve colour images. The red, green and blue components of the video
signal are processed independently and are sent to the respective CRT. The lenses of the CRT focus the
images to achieve the overall picture on the screen. CRT projectors are compatible with the output of most
computers as well as televisions.. DLP projector:Digital Light Processing (DLP) is a technology used in video projectors. This kind of
video projectors use a semiconductor chip and the image is created by microscopically small mirrors that are
laid out in a matrix  known as a Digital Micromirror Device (DMD).Each mirror in this projector  represents
one pixel in the projected image.The resolution of the corresponding image depends on the number of
mirrors in the projector..  LCOS projector: Liquid Crystal on Silicon (LCOS or Lcos) projectors is another kind of video projectors
that uses the micro display technology. This technology is mostly used for projection televisions. The technology
of these      projectors is similar to DLP projects, but these projectors use liquid crystals  instead of individual
mirrors. LCOS projectors produce high resolution images by using silicon technology rather than liquid
crystal display and plasma display technologies.

2.6.5 Computer Output Microfilm (COM)

COM is a process characterized by copying/printing data from media located on PCs, mini or mainframe
computers onto a microfilm. It consists of a high-speed recorder, which transfers digital data onto a microfilm
using laser technology, and a processor that develops the microfilm once exposed to the light source.

COM device translates information normally held on magnetic tape into miniature images on a microfilm
(also called microfiche-’fiche’ pronounced as ‘fish’). The device displays information as characters on a
CRT screen and then using photographic methods records the display onto the film. Drawings and images
can also be displayed along with narrative text.

A special reader/printer can subsequently be used to view the processed film. The reader operates on a
‘back projection’ principle displaying one frame at a time on a translucent screen, typically about A4 size.
The printer can then be used selectively to produce a hard copy of what is presented on the screen. Figure



27

2.32 identifies the various steps in COM production.

A  CO M  system  provides an easy and com pact w ay of recording and storing inform ation, and subsequently
retrieving the desired pieces of inform ation. It offers various advantages like reduction of paper, reduction in
cost (since it is cheaper than m ost electronic m edia), im proved quality (CO M  technology provides superior
im age quality) and electronic record retention/archiving.

CO M  is ideal for data that requires long-term  storage, because m icrofilm  is less volatile than m agnetic
m edia such as disks and tapes. It stores data in a very com pact form at; up to 270 pages can be contained in
a single 4 x 6 inch fiche.

Converting m agnetic tapes to m icrofilm  is quite inexpensive for closed files. H ow ever, if the data is highly
active, or requires regular updating, m icrofilm  m ay be less efficient than retaining the inform ation online. It
is therefore useful for data that m ust be archived for long periods of tim e and referenced only occasionally,
e.g., inform ation that m ust be archived to com ply w ith legal regulations, inform ation m aintained by insurance
com panies, banks, governm ent agencies and various other organizations of this type.

2.7 SUMMARY

This unit introduced you to the hardware components of a computer. You can store information in the
computer system .on devices like magnetic tapes and disks. You have learned that the storage capacity of
storage devices can be used to determine the amount of data that can be stored in the storage devices.

This unit also explained the input devices used to provide communication between the computer and the
outside world. They are also known as peripheral devices. Finally, in this unit, you have learned about
various output devices that accept data from the computer and translate it into a form that can be understood
by the outside world. Thus, you now know that output can be produced in two ways -on a display unit/
device, or on paper. Output produced on a display unit or device is called softcopy output while that produced
on paper is referred to as hardcopy output.

2.8 KEY TERMS.Cache Memory: It is the memory unit that stores the data and the related  application that was last
processed by the CPU..  CD-ROM: It is a circular optical disk which is used to store textual, graphical, audio and visual
content.
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.  Hit ratio: It can be defined as the ratio of number of hits to the total number  of times the CPU has
searched the cache memory.. Laser: Laser is high-quality, high-speed, high-volume, and non- impact technology that work on plain
paper or pre-printed stationary..  Light pen: The light pen is a pen-shaped device allowing natural movement on the screen.. Magnetic Disk: It is a circular plate made of metal or plastic, coated with magnetized material.. Mastering: The process of recording information on the disks is known as mastering.. Mouse: It is a small device that a computer user pushes across a desk surface in order to point to a
place on a display screen and to select one or more actions possible from that position.. Peripheral Devices: Input devices which provide a means of communication  between the computer
and the outside world, are. known as peripheral devices.. Printer:It is an output device that can be used to transfer the text displayed on the screen on to the
paper.. Projector:It is an output device that integrates a light source, optics system,  electronics and display
for the purpose of projecting the information from the computer or video device onto a wall or screen.. ROM:It is the permanent memory of the computer that stores data and instructions, even when the
computer is turned off.. RAM: RAM is the read/write memory unit, which is volatile in nature..  Storage Device: Storage devices are the devices that are connected to the computer to provide a
non-volatile memory source in addition to the primary memory of the computer. Storage devices are also
called secondary memory.. Scanning Devices: These are input devices used for direct data entry from the source document into
the computer system.. Tracks: In hard disks, data is stored in concentric circles, known as

         tracks.. Trackball: The trackball is a pointing device that is much like an inverted mouse.

2.9 ANSWERS TO ‘CHECK YOUR PROGRESS’
1. Storage devices are used to store all system programs and system software.

2. The following are examples of storage devices:

     A. Magnetic tapes

    B. Magnetic disks

    C. Floppy disks

    D. Hard disks

3. A magnetic disk is a circular plate made of metal or plastic, coated with magne-

    tized material. Often, both sides of the disk are used. Data is recorded on the disk in the form of magnetized
and non-magnetized spots representing Is and Os.

4. The following are the types of hard disks:

    A. Disk packs .

    B. Winchester disks

    C. Zip disks

5. The disadvantages of CD-ROMs are:

    A. They are read-only and cannot be updated.

    B. Access time of a CD-ROM is greater than that of a magnetic disk.

6. The following are the most commonly used mass storage devices:

     A. Disk arrays

    B. Tape libraries
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    C. CD-ROM jukeboxes

7. An input device accepts data from the outside world and transforms it into ~ a form the computer can
interpret.

8. The following are the examples of input devices:

     A. Keyboard

     B. Mouse

     C. Trackball

     D. Joystick

    E. Light Pen

     F.. Touch Screen

    G. Scanning Devices

    H. Voice Recognition Devices

    I. Vision Input Devices

9. Keyboard devices can be classified into the following categories:

    A. General-purpose keyboards

    B. Special-purpose keyboards

10. A mouse is a small device that a computer user pushes across a desk

      surface in order to point to a place on a display screen and to select one or more actions possible from
that position.

11. The following are the examples of output devices:

      A. Display devices

      B. Printers

      C. Plotters

      D. Projectors

      E. COM

12. The following are the types of CRT displays:

      A. Vector CRT displays

      B. Raster scan display

13. The following are the types of commonly used printers:

      A. Dot matrix printers

      B. Inkjet printers

      C. Laser printers

14. Plotters are used to produce graphical output on paper. A plotter can be

       defined as a device capable of producing charts, drawings, graphics and maps. It is much like a printer
but is designed to print graphs instead of alphanumeric characters.

15. The following are the different types of projectors:

       A. LCD projectors

       B. CRT projectors

       C. DLP projectors

       D. LCOS projectors
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2.10 QUESTIONS AND EXERCISES
Short-Answer Questions

  1.  What do you mean by static :RAM?

  2.  What is the difference between static RAM and dynamic RAM?

  3.  Explain the different types of ROM.

  4.  Explain the organization of the data stored in magnetic tapes.

  5.  How is the storage capacity of the data stored on a magnetic tape

       calculated?

  6. .Explain the difference between magnetic disks and magnetic tapes.

  7.  What do you mean by RAID?

  8.  What is the difference between tape libraries and disk arrays?

  9.  Explain special purpose keyboards.

  10. What is the function of a trackball?

  11. Explain joystick.

  12. What do you mean by voice recognition devices?

  13. What are the main components of CRT?

  14. What is the difference between LCD and CRT?

  15. What do you mean by projection display?

  16. Explain how an image can be created using dot matrix printers.

  17. What is the difference between flatbed plotters and drum plotters?

  18. Explain COM.

Long-Answer Questions

  1. Explain ROM and cache memory.

  2. Explain the following terms:

       A. Hard disks

      B. Floppy disks

       C. CD-ROMs

3. Explain the following mass storage devices:

     A. CD-ROM jukebox

     B. Tape libraries

4. Describe general-purpose keyboards.

  5.  Describe the following input devices:

        A. Touch screen

       B. Scanning devices

   6.  Describe the different types of printers.

   7  .Explain the different types of projectors.

2.11 FURTHER READING

Shepherd, Robert D., Introduction to Computers and Technology. New Delhi: Pentagon Press, First
edition.
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3.0  INTRODUCTION
In this unit, you will learn about computer software. A computer software consists of a set of instructions
that control and manage the working of a computer. You will learn about the three classes of computer
software, namely application software, system software and programming software. This unit will also give
you an insight into the most commonly used programming tools included in an IDE (Integrated development
environment).

3.1 UNIT OBJECTIVES
After going through this unit, you will be able to:. Define software system. Explain the various application software. Explain the various types of system software. Describe the different programming tools
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3.2 WHAT IS SOFTWARE?
 The term computer software refers to a program or a set of instructions that i controls the entire functioning
of the hardware in a computer. The software instructs the Central Processing Unit (CPU) what to do and
how to do, so that the hardware can read or write the data given to it. Computer software enables a
computer to perform particular tasks, whereas the hardware can only perform the tasks they are mechanically
designed for. The computer software can be divided into three classes, which are explained as follows:.  Application software: This enables the users to perform one or more specific

       tasks. Some examples of application software are industrial automation,  business software, educational
software, medical software, databases and computer games. Application software has wide range of uses
in businesses, though it is now used in many other fields.. System software: This enables the functioning of the computer hardware  and the computer system.The
objective of the system software is to isolate the application programmers from the details of the complex
functioning of the computer such as the functioning of memory and various accessory
       devices.Operating systems, device drivers, diagnostic tools, servers, windowing systems and utilities
are some of the types of system software.. Programming software: This consists of the tools that help a programmer in writing computer
programs and software using different programming languages in a much easier way. Some of the
programming software tools are text editors, compilers, interpreters, linkers and debuggers. An Integrated
        Development Environment (IDE), having an advanced Graphical User Interface (GUI) merges all
these tools into a software bundle, so that the programmer need not type multiple commands for the functions
such as compiling, interpreting, debugging and tracing.

3.3   APPLICATION  SOFTWARE
Application software is the software designed to accomplish specific tasks such as automation and education
software. Application software is used to automate different functions in every field of business and human
activities. Figure 3.1 shows the basic classification of software in a computer system:

Application software can be used for automating different tasks such as maintaining employee records and
providing education to the students. Some examples of application software are:.  Enterprise Software.  Business Workflow Software.  Document Management System.  Media and Entertainment Software
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.  Educational Software

3.3.1 Enterprise Software

Enterprise software is used to fulfil the needs organization processes and data flow, often in large distributed
ecosystems, for example, financial customer relationship management and supply chain management. As
many business enterprises have similar departments and systems, enterprise software is available as a
bunch of programs with helping tools to modify the common programs for specific work. Mostly these
development tools are complex programming tools that require specialist capabilities. This software provides
business logic support for an organization. These are typically used in commercial organizations which aim
to improve productivity and efficiency. Services provided by enterprise software are business oriented such
as online shopping and online payment processing and automated billing system. It performs different business
functions such as accounting, production scheduling, customer information tracking and bank account
maintenance. Most common examples of enterprise software are SAP, Oracle, Tally, and Microsoft Office.
Enterprises software helps in maintaining and processing account transactions within functional modules
such as account payable, account receivable, payroll and trial balance. As every organization needs an
accounts department for various tasks, there are variety of accounting software developed for different
purposes like banking, construction, medical and retail. Enterprise software like back-office software is the
most common corporate software. Examples of back-office system are IT system that keeps the phone and
computer running. A back-office system also keeps a record of company’s sale and purchase transactions
and updates the inventory as needed. Invoices, receipts and reports can also be produced by the back-office
system. Enterprise software also helps the human resource department in Human Resource Management
(HRM). The goal of this software is to help an organization to meet strategic goals by maintaining database
of employees and their salary structure, leaves, bonus, transfers and promotions. Another significant feature
of enterprise software is Customer Relationship Management (CRM). CRM provides supportto business
processes including sales and marketing. Each interaction with customer is generally added to customer’s
contact details and the customer can retrieve information from the database. CRM also helps in designing
marketing campaigns to optimize effective marketing. Supply Chain Management (SCM) is another benefit
of enterprise software. SCM is the processof planning to satisfy customer requirements as efficiently as
possible. It manages all business activities of an organization from storage of raw material to finished goods.

3.3.2 Business Workf1ow Software

Business workflow software is informational software, which makes the business task easier. More specifically,
workflow is the aspect, which tells how tasks are structured, who performs them, what their relative order
is, how they are synchronized, what information is needed to support the tasks and how the tasks are being
tracked. Workflow problems can be modelled and analysed using graph-based techniques. Workflow supports
documents and imaging software as well. Workflows can be classified in two categories: scientific workflow
and business workflow. Scientific workflow is mostly concerned with entering data  through various algorithms,
applications and services. Business workflow concentrates on scheduling task executions, which are not
necessarily data-driven and may include human efforts. Scientific workflows are widely used in the fields of
bioinformatics and chemical engineering to meet the need for multiple interconnected tools, handling of
multiple data formats and large data quantities.

Business workflows are used for structuring and scheduling of tasks within a software application and
organizing electronic document. The main advantage of business workflow is that the entrance of the work
stream path is modelled in such a way as to evaluate the efficiency of the flow route to identified business
characterstics. It also helps in the evaluation of resources, both physical and human, and creates smoother
transitions between tasks. Workflow automation is most appropriate for work in which human involvement
is limited to key data entry and decision points. In a workflow application various applications, components
and people must be involved in the processing of data to complete a part of a process. For example, consider
a purchase order that moves through various departments for authorization and purchase. The orders may
be treated as messages, which are put into various queues for processing. Similarly, a workflow process
involves constant change and update. There are two ways of developing workflow applications. The first
one is to design workflow models in a dedicated language and then to link the tasks in these models. Workflow
languages usually come with an associated graphical notation, but some are textual or XML-based. Another
approach to develop workflow applications is to I use a programming language in conjunction with libraries
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and interfaces that I capture abstractions for task coordination. Examples of such libraries and interfaces
are Windows Workflow Foundation and Workflow OSID.

3.3.3 Document Management System

A document management system (DMS) is a set of computer programs used to track and store electronic
documents and images of paper documents. Electronic document management is content-based networking
for communication infrastructure, where information is driven by the content throughout the network. The
users express their interests and the senders simply input the message into the network. The network
delivers all the information to the right people. DMS manages documents by creation, storage, organization,
transmission, retrieval, manipulation, updating and disposition of documents to fulfil an organizational purpose.

Using DMS, all the data and information can be put in a central database/intranet, which can be used by
everyone in the organization. There are different ways of improving communication tool. Suppliers can use
the software to share information and make their clients (employees) to use the system. One way to do this
is by introducing long-term profile of clients consisting of a number of standing queries to represent their
information need. Users can easily get information in their field of interest from existing profiles. Therefore,
search costs and search time for employees decrease.

DMSs commonly provide various functions, which are as follows:.  Extraction of metadata: The DMS may extract metadata from the document
        automatically or prompt the user to add metadata. The metadata is typically stored for each document.
It includes the date on which the document was stored and the identity of the user who stored it..  Integration: Many DMSs attempt to integrate document management  directly into other applications,
so that users may retrieve existing documents directly from the DMS repository, makes changes and saves
the changed document back to the repository. Such integration is commonly available for e-mail or groupware
software..  Capture: This function involves capturing of images from paper documents using scanners or
multifunction printers. Optical Character Recognition (OCR) software is often used to integrate the hardware
with stand-alone software, in order to convert digital images into machine readable text..  Indexing: This function involves tracking of electronic documents. It is as simple as keeping track of
unique documents. Indexing exists mainly to support retrieval. One area of critical importance for rapid
retrieval is the creation of an index topology..  Storage: This function is used to store electronic documents. Storage of  the
           documents often includes management of those same documents; where they are stored..  Retrieval: This function involves retrieving electronic documents from storage devices. It allows the
user to specify the unique document identifier, and having the system use the basic index (or a non-indexed
query on its data store) to retrieve the document.

3.3.4 Media and Entertainment Software

Media and entertainment software application is provided to entertain and enhance knowledge. Media players,
Web browser and Hybrid editor players are the examples of media and entertainment software application.
Media player software is used for playing back multimedia files. Most software media player supports both
audio and video files. Some media players focus only on audio or video and are known as audio players and
video players, respectively. Some operating systems like Microsoft Windows comes with pre-loaded Windows
Media Player. The latest is Windows Media Player 11. Many media players use libraries. The library is
designed to organize music into categories. Few examples of media players that include media libraries are
Winamp, iTunes and Real Player. Another media and entertainment software is Web browser. A Web
browser is a software application that enables a user to display and interact with text, images and other
information located on a Web page at a web site on the World Wide Web (WWW). Text and images on a
Web page can contain hyperlinks to other Web pages at the same or different website. Web browsers allow
a user to quickly and easily access information provided on many Web pages. Web browsers use Hyper
Text Markup Language (HTML) code. Some of the Web browsers available for personal computers include
Internet Explorer, Mozilla Firefox, Safari, Opera and Netscape.
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Web browsers communicate with Web servers using Hypertext Transfer Protocol HTTP to fetch Web
pages. H1TP allows Web browsers to submit information to Web servers as well as fetch Web pages from
them. Pages are located by means of a Uniform Resource Locator (URL), which is treated as an address.
Most browsers support a variety of formats in addition to HTML such as the JPEG i!llage formats. Another
type of media and presentation software is Hybrid Editor Player. A Hybrid Editor Player is a computer
software application used to display information, normally in the form of a slide show. There are many
different types of presentations like professional, educational and general communication. Presentation
programs are excellent alternative for paper documentation such as pamphlets, handouts, chalkboards and
flip charts. Many presentation programs such as Adobe Photoshop or Adobe lllustrator have pre- designed
graphic images. Programs like Adobe Photoshop also include presentation functions for displaying them in a
slide show format. For example, Apple’s iPhoto allows groups of digital photos to be displayed in a slide
show.

3.3.5 Educational Software

Educational software is a computer application whose purpose is teaching or self- learning. There are
various types of software aimed at the home education of younger children. The design of educational
software programs for home use has been influenced strongly by computer gaming concepts -in other
words, they are designed for fun as well as education. However, there is a large difference between proper
learning modules and software games. An example of educational software is the software designed for use
in school classrooms. Such software may be projected onto a large whiteboard at the front of the class or
run simultaneously on a network of desktop computers in a classroom. This type of software is often called
classroom management software. Electronic-learning (E- learning) module is very popular educational
software. E-learning is a general term used to refer to computer-enhanced learning. E-learning is naturally
suited to distance learning and flexible learning, but sometimes it can also be used for face-to-face.teaching.
There are many universities, which offer academic degree and certificate programmes via the Internet.
Some programmes require the students to attend some campus classes or orientations, which are delivered
completely online. In addition, several universities offer online student support services such as online advising
and registration, e-counselling, online textbook purchase and student newspapers. E-learning is also used
extensively in the business sector to provide cost-effective online training. Advantages of E- learning are
flexibility, convenience and the ability to work at any place where an Internet connection is available. E-
classes allow learners to participate and complete coursework in accordance with their daily commitments.
This makes e- learning education an effective option for those who cannot participate easily.

3.4  SYSTEM  SOFTWARE

System software is an essential part of the computer software, which controls and manages the hardware
and its functioning,, so that the application software can perform a particular operation. System software is
known as fIrmware if it is stored in a non-volatile storage such as integrated circuits. Thus, system software
can be said to be a set of instructions that arrange, utilize and control the hardware of a computer system.
Some of the common types of system software are:.  Operating Systems.  Device Drivers.  Other system software such as utility programs and language translators

3.4.1 Operating Systems

An operating system is a type of software that acts as an interface between the user and the computer. It is
the frist program that gets loaded into the computer memory through the process called booting. Operating
system manages all the operations of the computer and performs fundamental tasks. An operating system
acts as a platform on which various application programs can run.

An operating system is a set of instructions stored on a storage device such as hard disk, Compact Disk
Read Only Memory (CD ROM) or floppy disk. When you switch on a computer, the power-on routine
activates and a set of power-on routine activities is performed. These power-on routine activities verify the
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devices attached to the CPU such as keyboard, hard disk, floppy disk, CD ROM and printers for their
proper functioning. The instructions for these power-on routine activities are stored in the Read Only Memory
(ROM). ROM is permanent in nature and stores the data even when the power is switched off. However,
ROM stores only a few kilobytes of instructions due to its finite size. As a result, the power-on routine
activities are stored permanently in the hard disk as operating system and are transformed from the hard
disk into the Random Access Memory (RAM) on booting the computer.

RAM is also called main memory, which is volatile in nature and as a result, the programs and instructions
are temporarily stored on it and are lost on power failure. Secondary memory such as hard disk is non-
volatile and thus, retains information even in case of power failure. For example, you are working in MS
Word and saving your content in the main memory. The content will be erased from the main memory if the
computer is switched off.

Some of the important functions of an operating system are mentioned below:. Process management. Resource management. File management .I/O management.  Storage management

3.4.1.1 Process management

A process goes through various states for performing several tasks. The transition of a process from one
state to another occurs depending on the flow of the execution of the process. It is not necessary for a
process to undergo all the states. There are the following process states related to a process:.  New: It indicates that the process has just been created..  Ready: It indicates that the process is waiting for a chance to be allocated the CPU time for execution..  Running:  It indicates that the process has been allocated the CPU time and is executing the tasks.. Waiting: It indicates that the process is waiting for the completion of either another process or an I/O
task such as reading a file.. Terminated: It indicates that the process has finished its execution. All the tasks in the process are
complete.

3.4.1.2 Resource management

In resource management, the resources of distributed system are divided into two broad categories- I/O
devices and files. Files are the central element in a distributed system, because files provide input to an
application for execution and the output of the execution is recorded in the files.

For every I/O operation, you need to access the files that are stored on disks or on specialized servers,
which are assigned with the function of managing a file system only. In order to achieve the high data
transfer rate and increase performance, CPU enhances the rate of processing I/O operations of files. As
the client has to access the remote files, so it becomes critical to access the files in case of a distributed
system.

3.4.1.3 File management

Files are stored permanently on secondary storage devices such as the hard disk. File system is a part of
operating system that is responsible for controlling secondary storage space. It hides device-specific
complexities and provides a uniform logical view to the users. The following are the various functions of file
management system:
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. It enables users to give user-defined names, to create, modify and delete files.. It maps user-defined names with low-level identifiers, which are the names in machine understandable
format through which a machine identifies a file         uniquely.. It provides a uniform logical view of data to users rather than physical view, i.e., internal structure by
giving user-friendly interface.. It controls transferring of data blocks between secondary storage and main memory and also between
different files.. It provides semantics or the rules for file sharing among multiple processes and users.. It also allocates and manages space for files on secondary storage devices such as disks or magnetic
tapes. Space management is an important function of file management system.. It protects the files from system failures and applies measures for recovery and backup.. It provides security measures for confidential data such as electronic funds or criminal records.

It also provides encryption and decryption facilities to users. Encryption is a mechanism of converting data
into some code form that is unreadable to everyone except the recipient.

3.4.1.4 I/O management

Controlling all the input/output devices is one of the most important functions of an operating system. Issuing
commands to the devices, catching interrupts, handling errors and providing interfaces between the various
devices of the system are some of the functions of the operating system.

3.4.1.5 Store management

Storage or memory management is a very important function of operating system. A program is a set of
sequential instructions, which are given to a computer. The programs are usually stored in a secondary
storage device as an executable file. When you run a program, the computer reads the instructions and loads
them as process in the ready queue. The ready queue is a collection of processes to be executed by a
computer. The operating system selects a process sequentially from the ready queue and executes it.

3.4.2 Device Drivers

Device drivers are the device specific codes that control the I/O device attached to a computer. These
codes are written by the device’s manufacturer and delivered along with the device. Device manufacturers
supply device drivers for commonly used operating systems, since each operating system has its own specific
drivers.

Each device driver usually handles only one type of device or a class of closely related devices. For example
a SCSI disk driver can handle disks having different sizes and speeds and sometimes even CD ROM but, a
single device driver cannot be used for a mouse as well as a joystick as these two devices are very much
different. However, a single device driver controlling multiple devices that are different is technically not
restricted.

The device drivers need to be a part of the operating system, especially a part of the current architecture for
accessing the device’s hardware, i.e., controller’s registers. Constructing device drivers that run in user
space, with system calls for reading and writing the device registers can isolate the kernels from the drivers
and the drivers from each other so as to reduce a major source of system crashes. Most of the operating
systems define a standard interface, which must be supported by all the block drivers and a second standard
interface that must be supported by all the character drivers. The remaining operating system can call these
interfaces that contain a number of procedures such as reading a block or writing a character string to
perform some function.

The most important function of a device driver is to accept abstract read and write from the device-independent
software above it. Some other functions of device drivers are to initialize the device when needed, and
manage its power requirements and log events. Most of the device drivers have a similar structure. First, a
device driver checks the validity of the input parameters. If it is not valid an error is returned; otherwise, the
parameters are translated from abstract to concrete terms. Next, the drivers check the availability of the



8

device. The request is queued for later processing if the device is in use. If the device is idle the hardware
condition is examined so that the request can be handled at the instant. The actual device control begins
once the device is switched on and becomes ready.

Issuing a sequence of commands to the device is called controlling. The command sequence is determined
at the driver place. The drivers start writing the command into the controller’s device registers only after it
has the full knowledge of the commands to be issued. After writing each command to the controller, it is
checked if the controller accepted the commands and is ready to accept the next command. In this way, all
the commands are issued. After all the commands are issued, there arise two cases. One case can be that
the device driver blocks itself until the interrupt comes to unblock it. The second case can be that the
operation finishes without any delay and the driver remains unblocked.

3.4.3 Other System Software

There are various other types of system software that are commonly used. Some

of these are as follows:. Language translators: It is a computer program which accepts the text in a  particular language such
as French or German and converts it into another language.While converting the language of the text, the
format of  the document  is maintained.Various sites such as yahoo and gmail that offer the language
       translation facility enable you to convert text in one language into another.. Utility programs: These are a type of system software, designed to manage the computer hardware
and operating system. Various examples of utility programs are given below:

o  Disk defragmenters: It helps detect computer files whose content

     is stored in disjoin fragments on the hard disk. It also moves the fragments
     together to increase the efficiency of the hard disk. It also helps the user to decide what to delete when
his hard disk is full.

o  System profilers: It provides detailed information about the software  installed and the hardware
attached to the computer. Back-up software can make a copy of all information stored on a computer and
restore either the entire system or selected files.

o  Virus scanners: It scans the computer system to find computer viruses
    among files and folders.

o  Binary/Text Editor: It helps modify the text or data of a file without the
    What You See Is What You Get (WYSIWYG) view in editor suites.

o  Compression: It executes the output in a shorter stream or a smaller file when provided with
a stream or file.

o   Encryption: It uses a specific algorithm to produce an encrypted stream or encrypted file when
provided with a key and a plain text.. Communication software: This is an application program that helps exchange text, audio and video
messages between users situated at different computer systems. This type of communication is used in:

o  Instant messaging:  This is a real time conversation, which helps users exchange instant
messages using a special online program,

                known as instant messengers. These instant messengers use a single protocol program that
support file transfer, gaming, audio-video chat

                and SMS  messaging.

o  Chatting: This is also real time conversation that takes place at one website to allow multiple
users to chat and exchange messages in the form of text, audio and video.

3.4.4 Functions of System Software

System software performs some very important functions in a computer system. The following are the
functions of system software:.    System software provides the facility for process management. Process management deals with
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monitoring the program currently in execution. It   maintains the order of process execution such that it can
provide necessary resources for execution. The various resources that are required to execute a process
are CPU time, memory, I/O devices and files. The following are the tasks performed during process
management task of a system software:.     System software provides various mechanisms to handle deadlock situation  among different
processes. Consider a deadlock situation, process A is  waiting for a resource that is already held by process
B,  process B is  waiting for a resources that  is held by process C and Process C is also waiting for a
resource that is held by process A. This situation is known as deadlock situation..   System software implements various mechanisms for synchronization  process.. It creates, deletes and suspends system processes to manage various processes, so that each process
can optimize the utilization of CPU..    System software supports memory management. Memory management manages memory space
such that you can increase CPU utilization and decrease CPU response time. The following are the tasks
performed by system software during memory management:.    System software allows you to manage memory space that is used by different users..     It allows you to load new processes into memory respective to their order of priority..     It allows you to allocate and deallocate memory space provided to different
            processes..    System software supports I/O system management, which is used to manage
              various I/O devices such as keyboard, mouse and printer. System software
           performs the following tasks with respect to I/O system:.    It handles various input and output devices by issuing the input and output  request..  It captures interrupts such as hardware failure..  It handles errors that appear in the reading and writing process of devices..  System software provides the facility for file management. File management manages various files
such as data file, source file and object file on the basis of information stored in them. Data fIles represent
the information in numeric, alphabetic or alphanumeric mode. Source files store the code for programs
and object files are created when you compile the programs. Files are stored in storage devices such as hard
disk, floppy and CD.Files are grouped together into directories for easy access.The various file management
tasks performed by system software are as follows:.  It creates and deletes files and directories..  It maps fIles onto disk storage and takes the back-up of the files..  Security provided by system software is used to protect various resources such as memory segment,
files and CPU against unauthorized users. The operating system also uses timers that prevent unauthorized
processes to access CPU..  Networking provided by the system software is used for exchanging information among different
computers that are distributed across various locations. Distributed systems consist of multiple processors
and each processor has its own memory and clock. The processors communicate using various
        communication links such as telephone lines or buses. Bus is a collection of  wires that runs parallel
across the width of the motherboard.These wires transfer the data from one device to another. Distributed
systems include  general-purpose computers, minicomputers, microcomputers and workstat-
         ions. Their processors are connected through a communication network that  maintains security among
networks.. System software contains command interpretation system, which provides an interface between a
computer and a user. A user interacts with computer using control statements that give commands to the
operating system. These control  statements also control the execution of other statements. A program that
        interprets control statements is executed automatically in an operating system.  The command interpreter
system is also known as control card interpreter,  command line interpreter or shell. The function of command
interpreter is to acquire command statements and execute them. The command statement itself deals with
process management, main memory management, secondary storage management, I/O system, file system,
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protection and networking.

3.4.5 Firmware

Firmware is a software that you can embed in a hardware device to improve the performance and reliability
of the hardware device. This software is a computer program, which can be a ROM integrated circuit,
EPROM chip or EEPROM chip. Recording devices such as DVD and CD are embedded with a firmware
that constantly updates the software configuration of DVD and CD devices. Some examples of firmware
are:.  BIOS found in IBM compatible computers..  Run-Time Abstraction Services (RTAS), used in IBM computers..  Open firmware used in systems from Sun Microsystems and Apple computer.

3.5 PROGRAMMING SOFTWARE
Programming software is a collection of programming tools that a software programmer uses while developing
the software programs and applications. These tools help a developer to create, edit, maintain and debug the
software applications.

The different programming tools such as linkers, loaders and other control programs came into existence
during 1950. However, these tools got popularity with the invention of UNIX operating system during 1970.
The UNIX operating system came with strong programming tools such as grep, awk and make.

The programming tools are generally included into Integrated Development Environments (IDEs), which
help a developer to create, run and debug software applications easily. The most commonly used programming
tools included in an IDE can be:. Text editors. Compilers. Interpreters. Linkers. Debuggers. Visual Studio. NET IDE

3.5.1 Text Editors

A text editor is a software program that is used to edit plan text files. Plain text files are simply the straight
text files that do not contain any types of formatted data. Some text editors come with operating system
such as notepad or can be provided as third-party tool such as MS Word. However, some IDEs also come
with their own text editors that help programmers to edit the source code easily. For example, the programming
software such as Visual Studio provided by Microsoft comes with its own editor, which helps a programmer
to edit the source code easily. Some features of the text editors are as follows:. Search and replace: This feature allows a user to find a string in the document and replace it with
some other string.. Copy, cut and paste: This feature allows a user to move the text within a file or between different
files.. Text formatting: Some text editors provide formatting features such as word wrap, bullet list and
comment formatting.. Undo and redo: Text editors also provide the feature of undo and redo. Undo is a command that is
used to revert back the last change made by the  user. Undo is very powerful feature provided by the text
editors. The  redo command is used to reverse the effect of undo command.. Importing: This feature is used to read and merge the contents of another text file into the original
file.
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. Filtering: This feature allows you to send some contents of a file to ( another utility and read the result
back into the file.

3.5.2 Compilers

Compilers are the computer programs that can be used to convert the source  program into machine
understandable code, which is also called the object code. The compiler actually converts the program
written in some high-level programming language into machine language. The various types of operations
performed by the  compiler are:.  Lexical analysis: It is the process of converting the sequence of characters of the source code into
sequence of tokens. This process is generally performed by the lexical analysers or lexers..  Preprocessing: Preprocessing is the process of processing the source code before it is parsed by the
parser. For example, in C language, preprocessors can be used to implement macros..  Parsing: This process is also called as the syntactic analysis and is carried  out by the parser. Parser
is generally the component of the compiler. This process is used to analyse the sequence of tokens against
the grammatical structure. The output generated by this process is called the parse tree..  Semantic analysis: It is the process of adding semantic information to the parse tree..  Code generation: It is the process of converting the internal representation of the code into machine
understandable code..  Code optimization: It is the process of executing the computer programs  more speedily.

3.5.3 Interpreters

An interpreter is a program that executes instructions written in high-level  language. An interpreter translates
a high-level language into an intermediate form. This intermediate form is then used for executing a program.
An interpreter is designed to execute high-level  languages such as BASIC and LISP.

3.5.4 Linkers

A linker is a software program that is used to assemble the different objects generated by the compilers into
a single executable program. The objects for the linkers can also come from the library. Some linkers only
include specific symbols from the library instead of linking the whole library.

3.5.5 Debuggers
Debugger is a computer program which is used to fmd out the bugs in the code. A bug is an error, mistake
or a fault in a computer program that prevents it from doing the intended function.

3.5.6 Visual Studio.NET IDE .
Visual Studio.NET IDE is programming software that provides the common interface for building projects
for the .NET framework. IDE is a common environment for creating the user interface for the application,
writing code, compiling and debugging code.

Applications in Visual Studio.NET are created as files and folders and use the components provided by the
IDE. The projects and solutions are the containers to organize files and folders. A project consists of interrelated
files and folder. A project enables you to manage, build and debug files and folders to create an application.
A solution contains one or more projects. A solution enables you to operate multiple projects at the same time
on the Visual Studio .NET IDE.
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Figure 3.2 shows the projects and the solutions of Visual Studio .NET.

To open the Visual Studio .NET IDE, you need to select Start  Programs  Microsoft Visual Studio
.NET 2003 Microsoft Visual Studio .NET 2003 to display the Visual Studio .NET IDE. Figure 3.3 shows
the Visual Studio .NET IDE.

The Visual Studio .NET IDE contains the following components:. Solution Explorer window: It represents the projects and items such as Class and Class File included
in the projects hierarchy. The Solution Explorer window also contains a solution file that Visual Studio 2003
creates for a project with the same name as that of the project. The solution file helps add new projects and
items in the existing project.. Toolbox: It contains various controls such as ListBox and TextBox that you can use in an application.
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. Properties window: It allows you to set various properties such as size and
        background colour of controls added in an application to change the appear-         ance of Web and
Windows applications. The Properties window helps set the         properties of controls at design-time..  Start page: It contains three tabs, Projects, Online Resources and My Profile.         By default,
the Projects tabbed page appears. This page allows you to view         and open the already existing
projects. The Online Resources tabbed page         helps connect to the Internet, open the hyperlinks
related to Visual Studio         .Net and search the information about the uses and features of Visual Studio
         .Net. The My Profile tabbed page allows you to customize the environment of         Visual
Studio .Net.

Note: When you create Windows-based application, the user interface and the code of the application
appears in place of Start page.

Creating a Windows Application Using Visual Studio .NET

You can create, edit, compile, run and debug a Windows application in Visual Studio.NET IDE. To create a
Windows application using Visual Studio.NET IDE:

1. Open the Visual Studio .NET IDE and then open the New Project dialog box as shown in Figure 3.4.
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2. Click the OK button to open a new Windows Application, say WindowsApplication5. The
WindowsApplication5 window appears containing the Form! Windows form as shown in Figure 3.5.

3. Drag a button from the Toolbox to the Form form to design a user interface of Windows Application5.
Figure3.6 shows the user interface of WindowsApplicationS .

4. Double-Click the Form 1 to open the From. vb page as shown in Figure 3.7. This is the text editor of the
Visual Studio.NET IDE, where you can edit your source code.
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5. Add the following code to the Forml.vb page under the Click event of the Buttonl control:

Compiling VB.NET Program

6. You can compile your VB.NET program directly from the Visual Studio . NET      IDE. There are two
options to compile the VB.NET program in Visual Studio.NET     IDE. You can either build the solution
first and then deploy it or build and deploy it in a single step. Building a solution means deciding which
components should be a part of the application, how a project should be built and which platform should be
used. The output window provided by the Visual Studio.NET IDE displays error and success or failure
messages when a solution is being built or complied. To build the above code:

7. Select Build~Build Solution to compile the WindowsApplication say WindowsApplication5.

8.  An Output window showing the result of the compilation of WindowsApplication5 appears as shown in
Figure 3.8.

The Visual Studio.NET IDE also provides the Error List window to display errors that occur during compilation
of the project. The description column the Error List window explains the error and the File column shows
the location of the file that has generated the error. Figure 3.9 shows the Error List window.
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Running VB.NET Program

You can run the WindowsApplication5 application by performing the following steps.

1. Press F5 to run the WindowsApplication5 application. The Form 1 window appears as shown in Figure
3.10.
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2. Click the Button! button to display the sum of two numbers as shown in Figure 3.11.

Debugging VB.NET Programs

Visual Studio.NET IDE provides debugger windows such as the Command window and the Watch window
using which you can debug or check for errors line by line. This enables you to observe the flow of program
execution. The Visual Studio.NET IDE creates both the debugged and executable version of the code. The
debug and executable versions of the code are stored in a file with .pdb extension. These versions provide
additional information about the code to the debugger. The debug version of the code is used to test the code
and the executable version is used to implement the application.

Watch Window

The Watch window enables you to keep track of the values of the variables as a program is being executed.
To view a variable, select the variable in the code window and drag and drop it to the Watch window. As the
code gets executed line by line, the IDE refreshes the value of the variable in the Watch window. Figure
3.12 shows the Watch window for the Windows Application, WindowsApplication5.

3.6 SUMMARY
In this unit, you have learned that a computer software is a program that enables a to perform a specific
task. You have also learned that computer be divided into three classes, namely application software, system
I programming software. You now know that application software is designed to accomplish specific tasks
such as automation and education You also know that system software controls and manages the hardware
its functioning and programming software is a collection of programming that a programmer uses while
developing the software programs and applications.

3.7 KEY TERMS.   Application Software: It is the software designed to accomplish specific
            taskssuas automation and education software..    Business Workflow Software: It is the informational software which makes the business task
             easier..    Computer Software: It refers to a program or a set of instructions that controls the entire functioning
         of the hardware in a computer.
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. Communication Software: It is an application program that helps exchange text,audio and video

           messages between users on different computer systems..  Device Drivers: These are the device-specific codes that control the I/O device attached to a

           computer..     Document Management System: It is a set of computer programs used to track and store

            electronic documents and images of paper documents..     Educational Software:It is a computer application whose purpose is teaching or self-learning.. Firmware: It is a software that you can embed in a hardware device to improve the performance and

         the reliability of the hardware device..   Hybrid Editor Player: It is a computer software application used to display information, normally in
the form of a slide show..    Language Translator: It is a computer program which accepts the text in a particular language
such as French or German and converts it into another language..   Operating Software:It is a type of software that acts as an interface

           between  the user and the computer..  Program: It is a set of sequential instructions which are given to a computer..  Programming Software: It is a collection of programming tools that a software  programmer uses
while developing the software programs and applications..  System Software: It is an essential part of the computer software which controls and manages the
hardware and its functioning, so that the application software can perform a particular operation.. Web browser: It is a software application that enables a user to display and interact with text, images
and other information located on a Web page at a website on the world wide web (www)

3.8 ANSWERS TO ‘CHECK YOUR PROGRESS’

  1.   The three classes into which computer software can be divided are:

A. Application software

B. System software

C. Programming software

  2.   Some of the important types of application software are:

A. Enterprise Software

B. Business Workflow Software

C. Document Management System

D. Media and Entertainment Software

E. Educational Software

  3.   Some of the important functions of operating systems are:

A. Process management

B. Resource management

C. File management

D. Storage management

E. Input utput management

  4.   The following are the examples of utility software:

A. Disk defragmenters

B. System profilers

\C. Virus scanners !
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  5.    A linker is a software progr~ t~at is ~sed to assemble the different f objects generated by the
complIers mto a smgle executable program. r

  6.   The properties window allows you to set various properties such as size and background colour of
controls added in an application to change the appearance of Web and Windows applications. The Properties
window helps set the properties of controls at design-time.

3.9 QUESTIONS AND EXERCISES

Short-Answer Questions

   1.  Define computer software.

   2.  Explain system software and application software.

   3.  Define the different types of system software.

  4.  What are the major functions of an operating system?

  5.  Name some of the most commonly. used programming tools that are

       included in IDE.

Long-Answer Questions

  1.  Explain the various functions of system software.

  2.  Explain briefly the commonly used application software.

  3 . Explain the functions of an operating system in detail.

  4.  Define programming software. Briefly explain the most commonly used

       programming tools that are included in IDE.

3.10 FURTHER READING

Shepherd, Robert D., Introduction to Computers and Technology. New Delhi: Pentagon Press, First
edition.
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4.0 INTRODUCTION
In this unit, you will learn about the Internet, intranet and the extranet. You will learn about the internet
connectivity concepts, Internet protocols and the basic services of the Internet. You will also learn about
intranet, which is a network of computers used in an organization. In addition, this unit will also explain the
concept of extranet. An extranet is a network that allows two or more organizations to share information.



4.1  UNIT OBJECTIVES
After going through this unit, you will be able to:.  Describe the characteristics of the Internet.  Evaluate the various uses and applications of the Internet.  Understand the concept of Internet connectivity.  Describe the various protocols used in Internet.  Describe the working of an intranet and extranet

4.2 THE INTERNET
The Internet is a global network connecting millions of computers to exchange data such as files, applications
and messages. It is a network of networks, which uses a common set of protocols for communication
between two computers on the network. Each computer in the network, referred as host, is independent and
its operators can choose which Internet service to use and what local services to make available to the
global Internet community.

4.2.1 Brief History of the Internet

In 1973, the US Defence Advanced Research Projects Agency (DARPA) initiated a research program to
investigate techniques and technologies for interlinking packet network.The purpose was to develop
communication protocols, which would allow networked computers to communicate transparently across
multiple, linked packet networks (the networks capable of transmitting data in form of packets). This was
called the Internetting project,The system of networks, which emerged from the research, was known as
the Internet.

From this research, two types of protocols were developed: Transmission Control Protocol (TCP) and
Internet Protocol (IP). In 1986, the US National Science Foundation (NSF) initiated the development of the
NSFNET, which today, provides a major backbone communication service for the Internet. NSFNET has 45
megabit per second facilities to carry 12 billion packets per month between the networks it links. The
National Aeronautics and Space Administration (NASA) and the US Department of Energy contributed
additional backbone facilities in the form of the NSINET and ESNET, respectively.

During the late 1980s, however, the population of Internet users and network constituents expanded
internationally and began to include commercial facilities such as shares marketing. Since then, the Internet
has rapidly grown to become the world’s largest communication network. Indeed, the bulk of the system
today is made up of private networking facilities in educational and research institutions, businesses and in
government organizations across the globe. After 1989, the Internet system began to integrate support for
other protocols that fits into the basic networking fabric. The present emphasis in the network system is on
multiprotocol internetworking and on Open Systems Interconnection (OSI) protocols.

4.2.2 Characteristics of the Internet
The Internet is one of the fastest growing technologies in the field of computers. The different characteristics
of the Internet are as follows:. It is the network of networks comprising over 150 million computers.. The architecture of the Internet is disorganized so that it contains no central indexing scheme or
database. This disorganized architecture of the Internet can create confusions even for the experienced
users.. It is generally considered as the decentralized system. The decentralized system is the self-regulating
system that functions without the organized centre or authority.. It is composed of billions of files having different formats.. It is a widely-used technology. Almost 40 million people use the Internet daily.. It is accessed by users in approximately 140 countries.



. It is a dynamic technology. In every 30 minutes, a new network is connected to the Internet.

4.2.3 Elements of the Internet
The hierarchical model of the Internet consists of three elements. These elements are described as follows:
. .Clients: These are the computers- that communicate with the server for receiving the required
information. These computers generally maintain the part-time connections to the Internet. If your computer
is connected to the Internet then  your computer is categorized as the client computer.. Servers: These are powerful computers that have the full-time Internet connection. These computers
satisfy the requests sent from the multiple client computers simultaneously.. Networks: The network is generally the collection of one or more server computers and multiple
client computers.

4.2.4 Key Uses of the Internet

The Internet has many uses, some of which are described as follows:. Direct Communication: You can send messages to family and friends, business associates and
acquaintances using the electronic mail facility. Mail messages can be sent and received from anywhere in
the world within a few seconds.. Internet Relay Chat (IRC): Using the Internet relay chat, you can converse with people over the
net.You can log into a chat room and converse with others by typing messages that are instantaneously
relayed.Today, with the improvement in connectivity speed and proliferation of broadband you can not only
        type, but also use medium such as voice and graphics to converse with people.. Online Shopping: The Internet has helped remove all barriers of distance and
         nationality. You can shop for products and services across the world by logging onto a web portal.
What more -you can also pay online! Using your credit and debit cards you can transfer money between
different accounts without having to move from your computer table.. Distance Education: The Internet is a perfect medium for knowledge sharing and information
dissemination because of the intrinsic flexibility.Courses are available on the Internet-you can register, pay
and complete a course on different  interest areas.You can now pursue specialized higher studies in the
        comfort of  your own office or home.. Knowledge Base: The Internet is like a huge warehouse of data that can be accessed by people around
the globe. Using special programs called  search engines you can search for detailed information on virtually
any topic under the sun..  Banking: The banking industry was one of the first to use information  technology to automate operations
and save costs. The use of  ATMs marked a major breakthrough in shifting the mundane back-office work
to the customer himself. Instead of hiring an army of bank clerks, ATMs are operated directly by the
customers. This has helped to considerably reduce time and operational costs for the banks..  Travel: The Internet boom has resulted in the travel boom. Airlines, railways, taxi or car rental
companies have all gained tremendously by the Internet. They can now publish their services on the Web
along with the  latest discounts, packages and availability details. The customers on the  other hand,
        have benefited because they can now compare rates, make online booking and avail the discounts
without having to run around multiple offices.. Bill Payments: The government sector has also realized the benefits of IT.  It is now possible to make
online payments for public utilities such as water, electricity, phone, etc., using credit cards as the payment
medium.

4.3 INTERNET CONNECTIVITY CONCEPTS
Internet access is one of the most important concepts that emerge in the field of  networking. The most
common option available for the customers is to purchase the Internet services from the different service
providers. The customers that buy  the Internet from the service provider do not need to care about issues



such as  security, routing, additional management and monitoring. Therefore, it is the best option for the
customers to buy the Internet services from the service providers.

There are generally two options available that can be used for connecting to the Internet. These options are:. Direct connection. Internet Service Provider (ISP)

4.3.1 Direct Connection
A direct connection consists of a dedicated machine that acts as a gate, connected to the Internet backbone.
While this method provides full access to all services, it is very expensive to implement and maintain. This is
the reason why such an option is suitable only for very large organizations or companies.

4.3.2 Internet Service Provider (ISP)
ISP provides the gateway that the customers can use to connect to the internet, The range of services
available through different ISPs varies, so you ml the one that is best suited for your requirement. You could
connect to your ISP by using either of the two methods:.Remote dial-up connection: A dial-up connection provides connecting a device to the network using
a modem over the public telephone network (the modem converts the computer bits or digital signals to
modulated or analog signals that the phone lines can transmit. These signals are received on the ISPs end
and demodulated into bits and bytes for the Iter). Dial-up access is either by way of SLIP (Serial Line
Internet 01) or PPP (Point to Point Protocol). Since the dial-up uses the regular telephone lines, the  quality
of connection is not always good. In the past the maximum data transfer rates supported by a dial-up
connection was limited to 56 kbps (56,000 bits per second)..  Permanent dedicated connection: You can also have a direct connection to ISP which typically
translates into having a dedicated phone line ISP. A dedicated Internet connection is a permanent telephone
connection between two points. Computer networks that are physically separated are often connected using
leased or dedicated  lines. These lines are preferable because these are always open for communication
traffic unlike the regular telephone lines that require a dialing sequence to be activated. Often, this line is an
ISDN (Integrated Services Digital Irk) line. As the name suggests, it is a digital communication line lows
transmission of data, voice, video and graphics at very high ..ISDN applications have revolutionized the way
businesses communicate. ISDN lines support upward scalability which means that m transparently add
more lines to get faster speeds -going up to 1.28mbps (million bits per second). TI and T3 are the other two
types of only used dedicated line types for network connections. Dedicated lines are  becoming popular
because of their faster data transfer rates. It is a cost-effective method for businesses that use Internet
connectivity extensively.

4.4 INTERNET  PROTOCOLS
The different computers, peripherals and devices connected in a network with each other for the purpose of
transferring data and information. Therefore, it is necessary to define a set of rules for transmitting and a in
order to avoid collision. A network protocol defines a rules and conventions for communication between
different devices over the network. It includes, for example, rules that specify how to package data into,
message acknowledgement, data compression, etc., to support reliable and high performance network
communication.

The most commonly used Internet protocols can be:. Transmission Control Protocol /Internet Protocol (TCP/IP). UserDatagram Protocols (UDP).    HyperText Transfer protocol (HTTP). File Transfer Protocol (FTP). Telnet



4.4.1. Transmission Control Protocol/Internet Protocol (TCP/IP)
TCP/IP is a two-layer program that is used to connect hosts on the Internet. TCP-or Transmission Control
Protocol, works at the transport layer and manages the assembling of  a message or file into smaller packets
that are transmitted over the Internet to be received by a TCP layer on the other side, which then reassembles
the data packets into the original message.

IP -or Internet Protocol, works at the network layer and handles the of each packet so that it reaches the
right destination. Usually, each gateway computer on the network checks this address to see where to
forward the message. This implies that even though some packets of the same message may be routed
differently from the others, they will be reassembled at the destination.

The working of TCP/IP can be compared to shifting your residence location. This activity would involve
packing your belongings in smaller boxes for ease of transporting, with the new address and a number
written the boxes. You would then load these on multiple vehicles. These vehicles may take  different routes
to reach the same destination guided by the amount of traffic and the length of the route. Once these boxes
reach the destination check these to make sure all have arrived in good shape, then unpack the boxes and
‘reassemble’ your house.

4.4.2 User Datagram Protocol (UDP)

UDP is a connectionless protocol, which transports the information that does not require a reliable delivery.
Connectionless protocol means that the data is  transferred from the source to the destination without setting
up any v in between them. UDP does not sequence the segments it receives from the upper  layer protocol
and it does not care in which order these segments destination. UDP does not provide any acknowledgement
for the data it has sent to the destination. Figure 4.1 shows the format of UDP segment.

Figure 4.1: The UDP segment format

The UDP segment contains the following fields:. Source port: It specifies the port number of the application the source host, which is responsible for
sending the data to the destination host.. Destination port: It is the port number of the application residing on the destination host, which
receives the data sent to it by the application present at the source host.. Length: This field specifies the length of the UDP header and the data.. Checksum: This field contains the checksum of both urn UDP data fields. Checksum provides a
method for ensuring of the data sent by the source to the destination and it is placed  at the end of the data.
Checksum is a number calculated from a series of values taken through a sequence of mathematical
        functions.When the data reaches the destination, checksum is again calculated at the receiving end by
using the same mathematical functions which are used at the source host.. Data: This field specifies the data UDP has received from the upper layer protocol. It is an optional
field which depends on whether there is any data to be sent or not.



4.4.3 HyperText Transfer Protocol (HTTP)
HTTP is a set of rules for transferring files (text, image, sound, video, and other multimedia files) on the
World Wide Web. It is an application protocol that runs on top of the TCP/IP suite of protocols (which is the
foundation protocol of the Internet). It defines how such messages are formatted and transmitted, and what
actions the Web servers and browsers should take in response to the commands issued.

HTTP is based on a Client/Server principle, where your Web browser acts as a HTTP client making requests
to the Web server machines. These server machines contain, in addition to the Web pages, the files which
can serve as HTTP daemon. This is a program that is designed to, wait for HTTP requests and handle them
when they arrive. Typically, when a user (client) makes a request by either typing a URL (Uniform Resource
Locator) or clicking on a hypertext link, the browser builds an HTTP request and sends it to the IP address
as indicated in the URL. The HTTP daemon on the destination server then receives this request, and
responds by sending back the requested Web page. Figure 4.2 shows how a HTTP request is processed.

                                                 Figure 4.2: processing of a HTTP Request

HTTP is a stateless protocol, which means that each request or command is executed independently, without
any knowledge of the commands that came before it. This is the reason why newer technologies like
ActiveX, Java, etc., have gained popularity.

4.4.4 File Transfer Protocol (FTP)
FTP is an application protocol for exchanging files between computers over the Internet. It is the simplest
and most commonly used method to download/upload a file from a computer to a server (e.g., downloading
a document or an article from a website). Like other technologies, the FTP also uses the Internet’s TCP/IP
to enable data transfer. Figure 4.3 shows the interaction between the FTP client and the FTP server.

       Figure 4.3: Interaction between  FTP Client and FTP Server

FTP also works on a client/server principle, where an FTP client program is used to make a request to an
FTP server. (Files can be stored on computers referred to as FTP servers). Basic FTP support is usually
provided as part of the TCP/IP suite of programs. You can use FTP using a simple command line interface
(for e.g., from the Windows MS-DOS prompt window) or use a commercial program that provides a graphical
user interface. Using FTP you can update files on a server. Your Web browser can also make FTP requests
to download programs you request from your Web page. Typically, you would need a login to an FTP server.
However, publicly available files can be easily accessed using anonymous FTP.



4.4.5 Telnet

Telnet is a protocol that allows you to access someone else’s computer (host) provided you have been given
the permission to do so. It is typically referred to as ‘remote login’.

To make a clear distinction -HTTP and FTP allow you to request specific files from remote computers only,
while with Telnet you log on as a regular user on a remote machine with whatever privileges you may have
been granted on that computer (to access specific application and data).

A request for a connection to a remote host (which may be a computer lying physically in a neighbouring
room or miles away) will result in an invitation to log on with a user-id and prompt for a password. If
accepted, the user can enter commands through the Telnet program and these would be executed as if they
were being entered directly from the host machine. The user’s monitor would also display what is taking
place on the remote computer during the connected Telnet session. In other words, once connected, the
user’s computer emulates the remote computer.

Program developers who need to access data and/or applications located at a particular host computer
typically use Telnet.

4.5  BASIC SERVICES OF THE INTERNET
The Internet today is a large-scale network of millions of computers that allow fast and easy communication
between the Internet users across the globe. Telnet is one of the important services provided by the Internet.
Apart from Telnet, the other basic services or applications that make use of the Internet are as follows:. Electronic mail. Usenet. The World Wide Web (WWW). Internet Relay Chat (IRC). Videoconferencing

4.5.1 Electronic Mail
Electronic mail (E-Mail) is one of the most popular features of the Internet. It permits the Internet user to
send and receive messages and files to one another via modems almost instantly. The term ‘e-mail’ applies
both to the Internet e-mail system based on the Simple Mail Transfer Protocol (SMTP) and to the Intranet
systems allowing users within one organization to e-mail each other. SMTP is a simple, text-based protocol,
where one or more recipients of a message are specified and then the message text is transferred. The
messages in e-mail service can contain not only text documents, but also images, audio and video data. The
audio and video data is converted into a format that a computer accepts such as GIF and JPEG file format,
before it is attached to the e-mail message. With the e-mail service, the Internet has proved to be a productive
communication tool for millions of users. The following are the advantages of an electronic mail:. E-mail is faster than ordinary mail.. An e-mail is sent through the Internet and thus, it transcends geographical boundaries. It can be sent to
distant places instantly at a very low cost..E-mail documents can be stored in a computer and can be easily edited.

4.5.1.1 Accessing the E-Mail
Before, accessing the e-mail, you just need to create an e-mail account for , yourself using a website that
offers such services.Various sites provide this facility-some charge for it, while others provide it for free.
Yahoo.com, Rediffcom, hotmail.com and gmail.com are some of the sites that provide free e- mail services.
Once you register yourself on a website, you become a member and can simply log into your mail account
to start sending and receiving e-mails. For all future access you would require to remember your user id and
password because that is the key to your log in.



The steps for accessing the e-mail are described as follows:

   1.  Select StartProgramslnternet Explorer to open the Microsoft Internet Explorer window, as shown
in Figure 4.4.

                    Figure 4.4: The microsoft Internet Explorer Window

   2.  Enter the URL such as, http://www.yahoomail.com, in the address bar, which appear in the Microsoft
Internet Explorer window to display the sign in page of the yahoo mail website, as shown in Figure 4.5.

                          Figure 4.5: The Sign in Page of the Yahoo Mail Website

    3.   Enter an id such as yogesh52 and a password in the Yahoo ill and Password text boxes to specify the
e-mail id and the password to sign in the Yahoo mail website for accessing E-mail.



   4.   Click the Sign In button to display the Welcome page containing hyperlinks          such as Inbox and
Sent as shown in Figure 4.6.

                       Figure 4.6: The Welcome Page of the  Yahoo Mail Website

5. Click the Inbox hyperlink that appears on the left pane in the Microsoft Internet Explorer window to
access the e-mail messages contained in the Inbox.

4.5.1.2 Sending an E-Mail
You have to first compose an e-mail message before sending it to your contacts for communicating specific
information to them. To compose and send an e-mail

message:

    1.  Click the Compose button that appears in the Welcome page of the Yahoo mail website to display the
Compose page as shown in Figure 4.7.

                              Figure 4.7: The Compose Page of the Yahoo Mail Website



   2.  Enter an id such as abc@yahoo.com in the ‘To’ text box to specify the

        e-mail id of the recipient of the e-mail.

   3.  Enter text such as Meeting at Chicago in the ‘Subject’ text box to specify

         the subject for the e-mail.

    4.  Enter text in the text box that appears below the Attach Files button to specify  the e-mail that you

        want to send.

   5.  Click the Send button to send the e-mail.

4.5.1.3 E-Mail Protocols
E-mails are sent to a mail server that stores the received messages in the recipient’s e-mail mailbox. The
recipient uses the e-mail retrieval protocols to receive the messages in the mailbox. While some clients and
servers preferentially use vendor specific, typically proprietary protocols, most clients and servers support
the Internet standard protocols SMTP for sending e-mail and Internet Message Access Protocol (IMAP)
for retrieving e-mail, allowing interoperability with other servers and clients. E-mail clients can generally be
configured to use IMAP4 to retrieve e-mails and SMTP for sending the e-mail. The various e-mail protocols
are described as follows:.  IMAP: It is an application layer Internet protocol that allows the local client to access the e.-mail on
a remote server. IMAP is often used in large networks such as a college-campus mail system to retrieve e-
mail from the e-mail server.IMAP allows users to access new messages instantly on their
          computers, since the mail is stored on the local college-campus e- mail server..  IMAP4: Unlike many older Internet protocols, IMAP4 natively supports encrypted login mechanisms.
Plain-text transmission of passwords in IMAP4 is also possible. Plain-text passwords are used in some
combin-          ations of clients and servers, because the encryption mechanism to be used must be agreed
between the server and client. IMAP4 works over a TCP/IP connection using network port 143..   Simple Mail Transfer Protocol (SMTP): It is the most widely used protocol for sending e-mails
between servers. The messages can then be retrieved with an e-mail client using either POP or IMAP In
addition, SMTP is generally used to send messages from a mail clIent to a mail  server. This is  why you need
to specify all, the POP3, IMAP server and the SMTP server when you configure your e-mail application.

4.5.2 Usenet
Usenet service allows a group of Internet users to exchange their views, ideas or information on some
common topic. Usenet is different from the e-mail, as e-mail is for person-to-person communication and
Usenet is for communication between groups. Tom Truscott and Jim Ellis, two graduates from Duke University,
developed the Usenet, which stands for User’s Network, in the year 1979. It is a global and distributed
Internet discussion system, where users can read and post articles to a number of distributed news group
categories. These distributed newsgroups are known as Usenet newsgroups, which are somewhat similar to
the bulletin board systems. A Usenet newsgroup normally deals with different subject areas such as Windows
graphics, university admissions, latest fashion or technology, etc.

The Usenet is a useful place for resolving queries of the users as thousands of questions are asked and
answered using the Usenet news groups. For this, the users need to be members of the particular newsgroups,
as members of a newsgroup have the privilege to post messages to a particular group and the same members
can have access to the messages posted by other members. This helps,the users to get regular postings on
their desired topics. Usenet also functions as a forum for getting help or information from the fellow users on
various topics. Through this forum, a user can post any question and other users can post their answers on
the message board.

Newsgroups are of two types- moderated and non-moderated. In a moderated newsgroup, only selected
members have the right to post a message. The message first goes to the authorized members, who have the
right to post a message on the virtual message board. The authorized member checks the message for its
content first and if the message is appropriate, only then it is posted. If the message requires any editing, the
authorized member edits it. This member then posts the message on the message board. The main idea of



the moderated news group is to ensure the quality of the content that is being exchanged. In a non-moderated
news group, any member can directly post a message to the virtual message board or newsgroup.

The Usenet groups available are categorized by the Usenet on the basis of a classification system, which
divides the newsgroups into different sections according to their subject matter. The Usenet also provides a
designator code to a particular section that distinguishes the section from other news group sections. Table
4.1 shows some of the news group sections along with their designator codes.

               Table 4.1:  NewsGroup Sections and their Designator Codes.

A Usenet newsgroup needs to specify its designator code to its name. Some of the

available Usenet newsgroups are:. alt.fashion.  alt.education research. biz.job.offered.  comp.os.ms.windows.prograrnmer.graphics.  comp.os.mswindows.announcements.  comp.sys.mac.portable. soc.college.admissions

   . soc.college.financial-aid

4.5.3 The World Wide Web
WWW or W3 is a collection of online documents stored on servers around the world that are connected to
::he Internet. The online documents are written in HTML (Hyper Text Mark-Up Language) language,
which provides links to other documents stored on a web server. These hypertext online documents on the
Internet are known as Web pages.

WWW uses an Internet Protocol called the Hyper-Text Transport Protocol (HTTP) for interaction between
the computers on the Internet. Any computer on the Internet, which uses the HTTP protocol, is called the
Web server and any computer, which can access that server, is called a Web Client. In a client-server
model, a link can be shown on the screen in multiple ways like highlighted text or different coloured text.
Link is a special type of item in a hypertext document, which connects the document to another document
that provides more information about the hypertext document. These documents can be accessed over the
Internet using a Web browser such as the Internet Explorer or the Netscape Navigator.

4.5.4 Internet Relay Chat

IRC is a popular and interactive communication service available via the Internet, where people from all



around the world can involve in real time conversations.The conversations in IRC are known as channels
and each channel is organized by a topic. The channels  involve transfer of speeches and video images over
the Internet with the help of voice modems, digital cameras and microphones. You can use various types of
IRC software to perform IRC for real time conversations. Some of the popular windows-based IRC software
includes:. mIRC. PIRCH. Visual IRC

4.5.5 Videoconferencing
This feature of the Internet allows a group of users located in different parts of the world to talk and interact
with each other. Individuals interacting can see each other talking on their computer screens and can hear
each other’s voice through a special audio-device fixed in their computer. The ‘CU-SeeMe’ system developed
at the Cornell University is an example of an Internet-based videoconferencing system.

Videoconferencing involves transmission of audio and video. For example, a point-to-point (two-person)
videoconferencing system works much like a video telephone. Here, each participant has a video camera,
microphone and speakers mounted on his or her computer. As the two participant~ speak to one another,
their voices are carried over the network and delivered to the other’s speakers and whatever images appear
in front of the video camera appear in a window on the other participant’s monitor. This reproduces the
effect of an actual meeting.

Multipoint videoconferencing allows three or more participants to sit in a virtual conference room and
communicate as if they were sitting right next to each other. These systems are based on PCs featuring a
digital camera and run on visual communication software.

The communication links are still quite expensive making the desktop videoconferencing useful only for
selected applications. The most common applications of computer-based teleconferencing include management
communications and training, budget meetings, technical consultations, project reviews and contract
negotiations.

4.6 INTRANET

The Intranet is a private network connecting all the computers of an organization to share the organization’s
information and resources. It may be a network of more than one LANs and uses protocols of the Internet
for communication between two computers. However, it is different from the Internet. It can be called a
‘private version of the Internet’. The users use the graphical Web browsers to navigate the Intranet sites.
However, the choice of a Web browser depends on the requirements of the users and the organization.

4.6.1 Comparing Intranet and Internet
The Intranet and the Internet, both are used to exchange information between the server and the client.
Both of them use the same protocols and services for  sharing information, yet there are a number of
differences between these two, which are listed below:. The speed of the Intranet is faster than the speed of the Internet.. The Intranet contains more complex applications than the Internet.. The Intranet provides websites related to a particular organization. The users of that Intranet are very
limited as compared to the Internet, because the  Internet is spread all over the world.. The amount of information available on the Intranet is less than that on the Internet, because that
information is related to a fixed number of files of the organization. So, the information space of the Intranet
is smaller than that of the Internet.. The user interface design for the Internet and the Intranet are different.. The Internet has more variety of information than the Intranet.



. The searching process for a specific content or a word over the Internet is          more complex than
the Intranet.

4.6.2 Advantages of Intranet
Maintenance of applications and databases on computers over a network in any organization is a tedious
task. The Intranet makes it easy by providing a common Web server. Apart from this, the Intranet has many
other advantages, which are as follows:. It provides easy access to information without any time bounds.. It saves time by providing fast and smooth communication between the management and the employees
of an organization.. It provides virtual conferencing place for discussing matters related to the organization.. It provides file sharing system to the members of an organization.. It provides a common platform for developing and deploying new applications in an organization.

4.6.3 Disadvantages of Intranet

The Intranet provides various facilities such as easy communication and easy access of information, but
every coin has two sides. Likewise, the Intranet also has some disadvantages. These disadvantages are as
follows:. There may be a need to train the employees to access the Intranet.. A critical change of information is not reflected to the common database resulting in inconsistent state
of information.. The Intranet needs extra care and budget for security and maintenance

         purpose.

4.6.4 Hardware and Software Requirements for Intranet
An Intranet requires three basic tools- a Web server software, an authoring tool and a Web browser (the
client software). If the Intranet grows in size and some special applications are to be used, then search
engines and programming tools such as Java and VB.Net are also needed. The behaviour and functionality
of the Intranet depends on the software selection for the server or the type of the browser.

4.6.4.1 Web Server Software
A Web server is a specialized computer inside a network that sends out Web content in the form of pages,
graphics, files, etc., when a request is made by a Web browser client. A Web server can run other programs
such as database- related applications or search engines. Before selecting a Web server-software, the type
of services and performance level required in the network should be analysed. Some of the most popular
server software packages are as follows:. Microsoft Internet Information Server (IIS): It was released in early 1996. It is a powerful Web
server that is closely integrated with NT Server’s operating system security controls. IIS also includes a
Gopher server and an FTP server. It supports SSL 2 security and Virtual servers,  Perl and CGI
        scripts, server-side Java and Microsoft’s Internet Server  API (ISAPI) for developing complex Web-
based applications.. Netscape FastTrack Server: It .is a popular Web server that speeds up the Intranet. It has SSL 3
support, Navigator Gold page-authoring tool, extensive server-level access control and excellent performance.. Netscape Enterprise Server: It builds on the foundation of FastTrack  server. It includes MKS
Integrity Engine for HTML such as document , check-in,  check-out and revision control. Once a document
is checked out  no one can modify the document until it is checked in again. The MKS  system maintains
       copies of all the previous versions of a document on the  server.

To select the right server-software packages, the requirements and functionality of the Intranet should be
clear. The following factors should be considered before selecting the package:



. Type of hardware environment available.

   . Type of software environment and facilities provided by the underlying operating system.. Level of performance required.. Connection with the Internet.. Technical support required within the available budget.

4.6.4.2 Hardware Requirements
The hardware requirements depend on the number of users and the complexity of the Intranet design. More
sophisticated hardware is required if the number of people using the network increases. The hardware
platform that will integrate the current network infrastructure with the available software in the best possible
way should be selected. For example, a simple Window-based Intranet for a small company could function
properly using Web server software on a PC with at least 16 MB of memory, a 486 or Pentium CPU, a 500
MB to 2 GB hard disk and at least VGA graphics.

Network hardware devices are also required to connect the systems in the network. Networking hardware
facilitates the use of computer networks. The basic network devices used in the Intranet are as follows:. Gateway: A gateway is a network point that acts as an entrance to another network. In an organization,
the gateway is the computer that routes the traffic from a workstation to the outside network.. Router: It is a network device that connects two similar networks having the same network protocol
and determines the next network point to which a packet should be forwarded towards its destination. A
packet is the unit of data that is routed between an origin and a destination on the network. It also
         chooses the best path between two networks when there are multiple paths.. Bridge: It is a device that connects multiple networks along the data link layer. A bridge copies the
data frame from one network to the next network along the communication path. A frame is the data that is
transmitted between network points as a unit with addressing and necessary protocol control information.. Switch: It is a device that controls the flow of traffic between multiple network nodes. Unlike a hub,
a switch splits the network traffic and sends it to different destinations rather than to all systems on the
network.. Hub: It is a device into which one or more computers are connected.. Repeater: It is a device to amplify or regenerate digital signals received

        while setting them from one part of a network into another.. Multiplexer: It is a device that combines several electrical signals into a single signal.. Network Interface Card: It is a computer circuit board or card that is installed  in a computer so that
it can be connected to a network. The NIC provides connectivity between the computer and the physical
medium of the network such as a copper or a fibre-optic cable.. Modem: It is a device that converts digital signals from your computer into analog signals to send
over the phone lines (MODulation) and converts the phone’s analog signals into digital for the computer
(DEModulation).

4.7  EXTRANET

The Extranet is another type of network similar to the Intranet. Like the Intranet, it is also privately owned
by an organization. It is used by the organization to share its private information with its business partners,
customers and vendors for different business transactions. An extranet can be viewed as part of an
organization’s Intranet that can also be used by the users outside the company. Thus, it can also be said as
an ‘Intranet mapped onto an Internet’. Such privately owned networks connected to the Internet are also
called Virtual Private Networks (VPNs). The Extranets are also used to designate the restricted parts of a
company’s website, which requires the registered users to login and prove their authentication through login
ID and password.



The extranet uses the Internet protocols and the public telecommunication system for securely sharing the
information. These networks are more secure than other networks because they implement a well-defined
security policy and provide privacy, passwords and security to information and resources accessible over
the Extranet. Implementation of a proper security system is essential to restrict the access of users to the
confidential information and resources of the organization. Some of the security mechanisms implemented
are firewalls, encryption of messages, and user authentication. Any organization can use an Extranet for the
following purposes:. Exchange large volumes of data using EDI.. Share product catalogues exclusively with wholesalers.. Work with other companies on joint development efforts.. Jointly develop and use training programmes with other companies.. Share news of common interest exclusively with partner companies.. Offer customer discussion forums for reporting problems related to the products and relevant suggestions
to the problems.. Establish a network to discuss and coordinate financial and research related queries about the
product development projects with outside partners.

4.7.1 Virtual Private Network (VPN)
An organization member communicates with the members of the other organization using WAN. Virtual
Private Network (VPN) performs the same function using the Internet among the companies to transfer
information. It basically acts like a tunnel, separating a community’s data over an Internet. The information
is sent as data packets. It uses the ISP to assign a unique name and password to every user on the network
to access the network.

A VPN is of two types: remote access and site to site. The remote access VPN provides the connection
between a user and a LAN connection, i.e., a user is privately connected to the LAN of the organization.
The site-to-site VPN allows a company to connect its network over the Internet, called ‘the Intranet based
VPN’ or it can connect its network to the network of another organization.

VPN provides the following advantages:. It increases the geographic connectivity.. It extends the security between the networks.

   . It increases tile productivity.

   . It provides network opportunities to the organization.

   . It simplifies the design of the network.

   . It provides features such as security, reliability, scalability, network management and policy management.

4.7.1.1 Understanding VPN
An employee in a company communicates with the employee in another company using a private network
called WAN. For example, Consider a company has various offices in different parts of the country. The
offices exchange information with each other using leased lines. In addition, a company connects to the
Internet using an Internet service provider. This adds extra cost to the whole network. Figure 4.8 shows the
network diagram of a particular company.



                                         Figure 4.8: Network Diagram of a Company

In the network diagram of a company, HO and RO denote the head office and the regional office of the
company. The regional offices are connected to the head office using leased lines.

An alternative to this is to connect the head office to the regional office using the Internet. Figure 4.9 shows
the network connection between a regional office and a head office using the Internet.

                                         Figure 4.9: Networking Using Internet

Using the Internet between the head office and the regional office reduces the cost of transferring data.
While sending the data from one office to another, it can be corrupted on the way to the Internet. VPN
enables you to connect offices and other organizations using the Internet. Figure 4.10 shows a virtual private
network.

Figure 4.10: Virtual Private Network



VPN uses ISP to send and receive data packets through the network between two offices. An unidentified
user can also access the Internet services because VPN provides user name and password to the user who
wants to access the network outside the office. The advantages of VPN over LAN and WAN are as
follows:. Any user can access the network with its name and password because it

        involves low cost.. ISP reduces the number of leased lines.. Less bandwidth reduces the total cost.. User authentication and code encryption provides good security.. Interconnected network helps to share data and information.. A user can access the network from anywhere.. Resource sharing is possible with VPN.

Tunnelling process, used in VPN, provides security of data packets over the Internet. The tunnelling process
encapsulates data and encrypts it into standard TCP/IP packets, which can then safely travel across the
Internet. Tunnelling, thus, hides the private network computers during transmission of data packets. The
three types of protocols used in tunnelling are described as follows:

    . Point-to-point tunneling: .It uses the Internet to connect the private network computer across
different offices by creating a network between the client and remote computer..Layer two tunneling: It enables the users to access the data from remote networks.

   .IPSec: It provides encryption of the data that prevents the hacking of information over the Internet.

4.7.1.2 Types of VPN

The following are the three types of VPN that provides connection across the network:. Remote access: It allows a private network user to connect to remote computers.. Site-to-site Intranet: It connects the sites of the same organization using the Intranet.. Site-to-site Extranet: It provides connectivity between two organizations that access network service
of each other.

Remote access: Remote access VPN connects user to network and it is called point-to-site VPN or a
dial-up VPN. It is used to connect a single computer to the. whole network and uses dial-up lines or the
Internet for providing the connection. The user must be connected to the local ISP in order to access the
network. The dial-up lines for the connection can be a cable modem or a PSTN (Public Switched Telephone
Network). A client computer establishes a connection with the VPN software after connecting to the local
Internet Service Provider (ISP).

VPN provides various advantages over leased line connections. For example, if a company wants to connect
to a global network for getting information. The company uses a dial-up line and connects to the network via
dialling. Figure 4.11 shows remote access using dial-up lines.

                                                Figure 4.11: Remote Access Set-up



The private computers of the organization are connected to the LAN service provider. The costs of using
these dial-up connections are very high. Figure 4.12 shows a virtual private network connection.

Figure 4.12: Remote Access VPN

The  remote-user computer accesses information from a network using the :p or the Internet. The remote
user calls the Internet service, which in turn seeks the permission of the computers on the network to share
the information of LAN.

Site-to-site Intranet: Site-to-site Intranet VPN connects two sites of the same organization using network
connection between them. A site on a remote ient accesses information using an interface. Sites can access
different applications on the Intranet depending upon the network structure and the server applications.

Some sites use the same structure, therefore VPN provides the same file- sharing services to both the sites
and if they have different network structure, then VPN provides protocols for only messaging and browsing
the applications.

For example, if two branch offices situated apart are connected by a leased line, then the cost of connecting
the two offices includes router and cable cost, plus the ost of using and maintaining WAN across them.
Figure 4.13 shows the WAN onnection between two offices.

        Figure 4.13:WAN Connection between two Networks

Office I and office 2 share information across the network using WAN. LAN ystems transfer information



to the router, which then passes information to the ox that connects the different offices. The advantages of
site-to-site VPN over leased line connections are the following:. Reduces cost: It creates a connection using the Internet service provider         that has less cost
than the point-to-point leased line connection..Point-to-point connection: It uses components that require high         maintenance.

Figure 4.14 shows a site-to-site VPN connection.

               Figure 4.14: Site-to-Site VPN Connections

The Internet is connected between the two routers of the offices that provide the Internet service to both the
offices. For example, if a computer on the LAN wants to transmit data, then the data is sent to its router that
uses the Internet for forwarding the information.

Site-to-site extranet: The site-to-site Extranet VPN connects two offices of different organizations to
share each others’ services. For example, if two  companies are developing a joint project and one already
contains database for the project, which the other company needs to access. The site-to-site Extranet
implements the function of connecting the two offices. This network reduces the cost of using leased line
among different offices. The features provided by the site-to-site Extranet VPN are the following:

. Encryption: It provides data encoding and data decoding across the

         network.. Encapsulation: It provides the facility of putting data into another

         function.. Authentication: It provides security over the network.



 Figure 4.15: Site-to-Site Extranet VPN Connection

         Figure 4.15: Site-to-Site Extranet VPN Connection

4.7.1.3 Connection Issues for VPN

A VPN should be designed in such a way that it reduces time and cost for the organization. In addition, it
should provide security over the network. The two types of connections for connecting client computers to
the Internet using VPN are:. Direct: It connects the user to the Internet usine ISDN, PSTN and DSL.. Connection using network components: It uses routers, proxy servers or firewalls for connecting
the client to the server.

Direct connection uses a VPN device between the client and the server. Communication protocols remove
the inconsistencies between the client and the server.

Connection using network components considers the following issues:. IP Address Assignment: It assigns an address to each computer on the network..User Authentication: It provides security services to each user of the network..Connectivity Types: It provides different types of connection such as leased line or ISP..Routing Capabilities: It provides routing services to each client..Hardware and software requirements: It determines the hardware and software required for

        connection..Data Encryption: It decodes or encodes the information across the network.

4.7.1.4 VPN Architectures

VPN architecture shows how client computers are connected to the server. It consists of the following main
components:. Client: It connects the VPN client to the VPN server, using tunnel between them..Server: It serves the request of all clients.



. Internet architecture: It serves as an intermediary communication device          between the VPN
client and the VPN server.

Figure 4.16 shows the architecture of VPN.

             Figure 4.16: VPN Architecture

Users of VPN are PCs, administrators and office computers that are connected to the Internet using the
ISP. The Internet supplies information to the clients by accessing information from the server through the
Internet service provider. The three types of VPN architecture are:. Fully outsourced: It provides complete solution of VPN to the company using ISP.. In-house VPN: It provides and controls the solution of VPN through the organization.

   . Hybrid VPN: It combines the feature of ‘in-house VPN’ and ‘fully outsourced  VPN’.

Fully Outsourced VPN:

Fully outsourced VPN is used in an organization where cost is the primary factor. For example, if an
organization has a network across all its branches and clients on one branch need to connect to clients on
other branches. An organization has to invest a lot of money for long distance telephone lines. Instead, it can
use fully outsourced VPN. The components that are needed to set up a fully outsourced VPN are:. Network components for security purpose.. The components for encoding, decoding and routing of data.. The tunnel process to increase the performance.

An organization uses a firewall between the private and global networks to ensure security of data. A
process can communicate between fully outsourced VPN and the external network. For example, the client
on a local machine connects to the In local point in the network. The client provides his account information
to the ISP. The server checks this information for authentication and connects the client to  the Internet.

The server provides all the ISP facilities to the client and act as intermediary between the main server and
the client as a proxy server. The information across the client and the ISP is decoded on the network by the
local point in the network. This whole process is called gateway process. A fully outsourced VPN needs
extra resources for implementation. These VPN provide higher security between the client and the ISP
network. Figure 4.17 shows a fully outsourced VPN.



   Figure 4..17: Fully Outsourced VPN

Fully outsourced VPN connects user, administrator and private network clients to the main server. The user
and the administrator directly access the information from the server. In addition, the private network takes
the help of outer network to access the information through main server. Clients on private network access
information from server using router that is provided by another network across the circuit.

In-House VPN:

In-house VPN is controlled by the organization. ISP provides the service of transmitting data and act as a
carrier between the private network and the main server. The Internet obtains information from the network
by accessing data through the local point. The information is tunnelled, encoded and encapsulated in the
remote server. Figure 4.18 shows the network structure of the in-house VPN.

Figure 4.18: In-House VPN



In in-house VPN, users share the information from the main server through the Internet. In addition, clients
on LAN access information from the Internet via VPN network that act as intermediary devices called
proxy servers.

Hybrid VPN

Hybrid VPN combines the features of in-house VPN and outsourced VPN. In hybrid VPN, the ISP transfers
information across the network and controls the whole network structure. For example, if there are two
networks across the Internet. One network controls the VPN and the other network performs the functions
of the ISP. Figure 4.19 shows a hybrid VPN consisting of two networks.

           Figure 4.19: A Hybrid VPN

Hybrid VPN, both user and administrator access the information from th e network.Clients on the LAN
access the information from network by using VPN that provides all the ISP services.

4.7.2 Disadvantages of VPN

The various disadvantages of VPN are as follows:. It is costly to implement and maintain (the set-up costs of hardware, software and employee training
costs).. Security is a main concern. The security methods and system access should be implemented with great
care to avoid valuable information passing into wrong hands.

4.8  SUMMARY

In this unit, you have learned about the basics of the Internet, an intranet and an extranet. You have learned
about the Internet connectivity concepts. Thus, you know that the Internet allows you to connect your
computer with other computers  and share information. This unit has also explained the various protocols
which  are needed to transfer data over a network. Another type of network that is used via in a specific
organization is intranet. The unit has enabled you to analyse the differences between intranet and the
internet. Finally, this unit explained the :l” concept of extranet. Thus, you have learned about VPN which is
one of the most common type of extranet.



4.9 KEY TERMS

. Clients: These are the computers that communicate with other machines for receiving the required

         information..  HTML (Hyper Text Mark-Up Language): It is the language which provides links to other documents

        stored on a web server..  IMAP: It is an application layer Internet protocol that allows the local client to access e-mail on a

         remote server.. Internet: It is a global network connecting millions of computers to exchange data such as files,

         applications and messages.

  .  ISDN (Integrated Services Digital Network): It is a digital communications line that allows

           transmission of data, voice, video and graphics at very high speeds.. ISP: It provides the gateway that the customers can use to connect to the Internet..  Modem: A modem converts the computer bits or digital signals into modulated or analog signals

         which are transmitted through the telephone lines. These signals are received on the ISP’s end and

        demodulated into bits and bytes for the computer.. Network: The network is generally a collection of one or more server computers and multiple client

       computers..Protocol: A network protocol defines a ‘language’ of rules and conventions for communication between

    different devices over the network.

  . Servers: These computers satisfy the requests sent from multiple client computers simultaneously.. WWW: WWW or W3 is a collection of online documents stored on servers around the world that

        are connected to the Internet.

4.10 ANSWERS TO ‘CHECK YOUR PROGRESS’

    1.  The Internet is a global network connecting millions of computers to exchange data such as files,

         applications and messages.

     2.  The basic elements of the Internet are clients, servers and networks.
    3.  The key uses of the Internet are direct communication, banking, travel, knowledge base, etc.

    4.   The two advantages of e-mail are:
A. E-mail is faster than ordinary mail.

B. An e-mail is sent through the Internct and thus, it transcends geographical boundaries. It can

                be sent to distant places instantly at a very low cost.
    5.  Videoconferencing allows a group of users located in different parts of  the world to talk and
         interact with each other.
    6.  An intranet is a private network connecting all the computers of an organization to share the
organization’s information and resources.

    7.  The advantages of intranet are the following:
A. It provides easy access to information without any timc limits.

B. It saves time by providing fast and smooth communication between the management and the

                 employees of an organization.
    8.  The three types of protocols used for tunnelling are point-to-point, layer two, and IPSec.
     9.  The three types of VPN are remote access, site-to-site intranet and site-to- site extranet.

    10. The three architectures ofVPN are fully outsourced, in-house and hybrid.



4.11 QUESTIONS AND EXERCISES

Short-Answer Questions

   1. What are the steps used to access an email?

  2. How do we send an email?

  3. Briefly explain the Usenet.

  4. Distinguish between an intranet and the internet.

  5. Write a short note on extranet.

Long-Answer Questions

  1. Describe the various protocols used for e-mail.

  2. Explain VPN architecture in detail and add a note on its advantages.

  3. Explain the different types of VPN.

  4. Write an essay on the services provided by the Internet.

4.12  FURTHER READING

Rajaraman, V., Fundamentals of Computers. New Delhi: Prentice-Hall of India, Fourth edition.
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Unit - II

Microsoft Office and Word Processing

2.0 Objectives:
This lesson provides an introduction to the Microsoft Office. It covers Microsoft Office Products, 
introduction to Word-Processing and features of Word-Processing.

Structure of the Lesson:

2.1    Introduction to Microsoft Office

2.2    Word-processing

2.3.   Features of word-processing

2.4. Summary 

2.5. Technical Terms

2.6. Model Questions 

2.7. References

2.1. Introduction to MS-OFFICE:
Microsoft Office for windows is a suite of applications that are also available as independent 

programs. Microsoft Office is a major facility in computer applications field. Microsoft Office 
comes in two ways. One is called Standard and other one is called Professional. Both the 
versions have the following primary applications.

1. Microsoft Word

2. Microsoft Excel

3. Microsoft PowerPoint

4. Microsoft Access

5. Microsoft Mail

6. Microsoft Graph

7. Microsoft Clip Art Gallery

8. Microsoft Word Art

9. Microsoft Organization Chart

10. Microsoft Equation Editor

11. Microsoft Publisher
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1. Microsoft Word 

This is a full-featured word processor that can create letters, menus, reports, 
newsletters, manuals and any kind of documents. You can use it for daily correspondence and 
desktop publishing also. It is having more menus, keyboard shortcuts and toolbars.  Toolbars 
containing buttons that you can click to perform, common tasks like centering text, saving and 
printing documents.  After developing our own working style we can make custom toolbars. 
Word provides macro capability to do repetitive tasks.  It provides some model reports called 
templates, rather than typing all the matters it gives skeleton reports.  Wizards are more 
powerful than templates. Word having spell checker that checks the document and more 
features like Auto formatting, Printing envelops and labels, Mail Merge.

2. Microsoft Excel

This is a spreadsheet program that allows you to organize, analyze information. It is 
designed to work with numbers.  You can enter data in cells arranged horizontal rows and 
vertical columns on work sheets. Excel organizes the worksheets with workbook.  Every 
workbook having 3     (default) worksheets and you can add up to 255 worksheets and you can 
remove 1 or 2 worksheets from the three.  Worksheets contains 65,536 rows and 256 columns 
(numbered A to IV)..The address of the cell is combination of row and column labels.  Excel 
provides tool bars, menu choices and functions.  Other than these features excel provides 
Screen wizard, autocalc, auto complete, templates, templates wizard etc

3. Microsoft PowerPoint

It is a presentation tool.  We can create slides, handouts and speaker notes.  The slides can be 
arranged sequentially in presentations.

4. Microsoft Access

This is a powerful database program but you can store, retrieve, and organize data. Access 
comes with wizards and variety of predefined database elements.

2. Microsoft Mail

Microsoft Mail is a product that comes with a license to use mail on the workstation where office 
is installed. If your workgroup is using Microsoft Mail, this license allows to copy the necessary 
software to your machine.

6. Microsoft Graph

Microsoft Graph is used to convert the tabular as well as text data into the graphs and charts.  A 
number of graphs and chart options are provided by this component of Office.

7. Microsoft Clip Art Gallery

Clip Art Gallery is a collection of ready-made graphics that the user can import into any of the 
primary applications to make them more effective.

2. Microsoft Word Art

Word Art enables a user to convert the text into various shapes for logos, banners, and 
headlines.
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2.  Microsoft Organization Chart

Microsoft Organization Chart provides the tools for creating figures such as organization charts 
by selecting the different styles and organizations for charts.

10. Microsoft Equation Editor

Microsoft Equation Editor enables a user to format complex equations correctly.

Microsoft Publisher

It helps to organize the material of textbooks in the form of chapters and volumes.

2.2. Word Processing:
Using a computer to create, edit, and print documents is called word processing. Of all 

computer applications, word processing is the most common. To perform word processing, you 
need a computer, a special program called a word processor and a printer. A word processor 
enables you to create a document, store it electronically on a disk, display it on a screen, modify 
it by entering commands and characters from the keyboard and print it on a printer. 

The great advantage of word processing over using a typewriter is that you can make 
changes without retyping the entire document. If you make a typing mistake, you simply back up 
the cursor and correct your mistake. If you want to delete a paragraph, you simply remove it, 
without leaving a trace. It is equally easy to insert a word, sentence, or paragraph in the middle 
of a document. Word processors also make it easy to move sections of text from one place to 
another within a document, or between documents. When you have made all the changes you 
want, you can send the file to a printer to get a hardcopy. 

2.3. Features of word processing:
Insert text: Allows you to insert text anywhere in the document. 

Delete text: Allows you to erase characters, words, lines, or pages as easily as you can erase 
them on a black board. 

Cut and paste: Allows you to remove (cut) a section of text from one place in a document and 
insert (paste) it somewhere else. 

Copy: Allows you to duplicate a section of text. 

Page size and margins: Allows you to define various page sizes and margins, and the word 
processor will automatically readjust the text so that it fits. 

Search and replace: Allows you to direct the word processor to search for a particular word or 
phrase. You can also direct the word processor to replace one group of characters with another 
everywhere that the first group appears. 

Word wrap: The word processor automatically moves to the next line when you have filled one 
line with text, and it will readjust text if you change the margins. 

Print: Allows you to send a document to a printer to get hardcopy. 
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File management: Many word processors contain file management capabilities that allow you 
to create, delete, move, and search for files. 

Font specifications: Allows you to change fonts within a document. For example, you can 
specify bold, italics, and underlining. Most word processors also let you change the font size 
and even the typeface. 

Footnotes and cross-references: Automates the numbering and placement of footnotes and 
enables you to easily cross-reference other sections of the document. 

Graphics: Allows you to embed illustrations and graphs into a document. Some word 
processors let you create the illustrations within the word processor; others let you insert an 
illustration produced by a different program. 

Headers, footers, and page numbering: Allows you to specify customized headers and 
footers that the word processor will put at the top and bottom of every page. The word 
processor automatically keeps track of page numbers so that the correct number appears on 
each page. 

Layout: Allows you to specify different margins within a single document and to specify various 
methods for indenting paragraphs. 

Macros: A macro is a character or word that represents a series of keystrokes. The keystrokes 
can represent text or commands. The ability to define macros allows you to save yourself a lot 
of time by replacing common combinations of keystrokes. 

Merges: Allows you to merge text from one file into another file. This is particularly useful for 
generating many files that have the same format but different data. Generating mailing labels is 
the classic example of using merges. 

Spell checker: A utility that allows you to check the spelling of words. It will highlight words that 
it does not recognize. 

Table of contents and index: Allows you to automatically create a table of contents and index 
based on special codes that you insert in the document. 

Thesaurus: A built-in thesaurus that allows you to search for synonyms without leaving the 
word processor. 

Windows: Allows you to edit two or more documents at the same time. Each document 
appears in a separate window. This is particularly valuable when working on a large project that 
consists of several different files. 

WYSIWYG (What You See Is What You Get): With WYSIWYG, a document appears on the 
display screen exactly as it will look when printed.

2.4.Summary:
At the end of this lesson you have learnt the importance of Microsoft Office products and 

important features of Word Processing. In all the MS-Office products, the familiar products are 
MS Word, MS Excel, MS PowerPoint and MS Access. Word processor enables you to create a 
document, store it electronically on a disk, display it on a screen, modify it by entering 
commands and characters from the keyboard and print it on a printer. 
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2.5. Technical Terms:
Cut and paste: Allows you to remove (cut) a section of text from one place in a document and 
insert (paste) it somewhere else. 

Copy: Allows you to duplicate a section of text. 

WYSIWYG: What You See Is What You Get.

Spell checker: A utility that allows you to check the spelling of words.

Word wrap: The word processor automatically moves to the next line when you have filled one 
line with text, and it will readjust text if you change the margins. 

2.6. Self Assessment Questions:
1. Explain in detail about Ms-Office

2. Define Word-Processing? Explain the features of Word Processing?

2.7. References:
RON MANSFIELD, ‘Working with MS OFFICE’, Tata Mc Graw Hill – 2000 Edition

GUY HART DAVIS, ‘ The ABC’S Of Microsoft Office. ‘ BPB Publications, New Delhi

MS OFFICE 2000 Complete, BPB Publications, New Delhi 

                    Y. SURESH BABU, M.Com., M.C.A.,
                              Lecturer, Dept.Of Computer Science,
                               JKC College, GUNTUR.
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UNIT- II

Microsoft Word

2.1.2  Objectives:

This lesson provides an introduction to the fundamentals of Microsoft Word. It covers starting 
Word, the Word interface, creating a Word document, editing a Word document, selection 
techniques, text formatting, page setup and print documents. 

Structure of the Lesson:

2.1     Starting word and components of word window
2.2       Creating and saving a document
2.3       Adding & modifying text
2.4      Selecting Text
2.5      Cut, Copy and Paste Text
2.6      Paste Special
2.7      Find and Replace
2.8 Redo and Undo
2.9 Formatting Text & Paragraphs
2.10   Header and Footer
2.11   Bullets and Numbering
2.12.   Zooming
2.13. Page Break
2.14. Auto Correct and Auto Text
2.15. Page Setup
2.16. Print Preview and Printing
2.17. Summary 
2.12. Technical Terms
2.12. Model Questions 
2.20. References

2.1. Getting Started with Microsoft Word:

Starting Word
On the PC, select Start followed by  Programs, and Microsoft Word from the Start list. 
Components of the Word Window
Besides the usual PC window components (close box, title bar, scroll bars, etc.), a Word 
window has other elements, as shown in the following figure.
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Figure 6.1

Component Functionality or Purpose of the Component 

Menu Bar Contains File, Edit, View, Insert, Format, Tools, Table, Window 
and Help menus.

Standard Toolbar Contains icons for shortcuts to menu commands.

Formatting Tool Bar Contains pop-up menus for style, font, and font size; icons for 
boldface, italic, and underline; alignment icons; number and 
bullet list icons; indention icons, the border icon, highlight, and 
font color icons. 

Ruler Ruler on which you can set tabs, paragraph alignment, and 
other formats. 

Insertion Point Blinking vertical bar that indicates where text you type will be 
inserted. Don't confuse the insertion point with the mouse I-
beam. To move the insertion point, just click the mouse where 
you want the point moved. 

End-of-File Marker Non-printing symbol that marks the end of the file. You cannot 
insert text after this mark. 

Selection Bar (Gutter) Invisible narrow strip along the left edge of the window. Your 
mouse pointer changes to a right-pointing arrow when it is in 
this area. It is used to select a line, a paragraph, or the entire 
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document. 

Split Handle Double-click to split the window in two (to view different portions 
of the same file). Double-click to return to one window 

Status Bar Displays page number, section number, and total number of 
pages, pointer position on page and time of day. 

Task Pane Displays and groups commonly used features for convenience. 

Office Assistant An animated character that can provide help and suggestions. 

There are multiple characters to choose from, and it is possible 
to turn the Office Assistant off. 

2.2. Creating and Saving a Document:
Opening and Closing A Document

To open a file, select Open... from the File menu. In the dialog box, click on the filename and 
then on the Open button. If your file is not in the opened folder, click on the down arrow (next to 
folder name) to see a directory listing. The Up One Level button icon on the right enables you to 
move up one level. You can then switch to the floppy disk, hard drive or Desktop where the 
appropriate file or folder is located.

                                               
                                                   Figure 6.2

For example, to open a file from a floppy disk, select Open... from the File menu. If the disk's 
name does not appear on the left side of the dialog box, click on the down arrow. Select its 
name in the box at the left or if it is not displayed, click the Up One Level button to see a 
different display of files and folders. When you locate the desired diskette or file, click Open. 
(Double-clicking on the name will also open it). 

To close a document, click its close box in the upper right of the title bar (box with the large X on 
it) or select Close from the File menu. The keyboard shortcut is <Ctrl + W>.
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Saving a Document

Saving means preserve the content in a Secondary Storage device. It is a good idea to save 
your document right away and they continue saving every 5 or 10 minutes so if your computer 
crashes you will not be losing  much. Your document and changes you make to a document are 
not saved to disk until you issue a save command. Saving is quick and easy. You should save 
often to minimize the loss of your work. Word has two save commands - Save and Save As. -
that work similarly. Both are under the File menu. 

Save Save As

When you save a new document for the first 
time, Word displays a dialog box. Select 
where you want to save your document and 
give it a name. When you save an existing 
document that you have been editing, the 
newly saved version is written over the older 
version. 

This command always displays a dialog box 
where you can choose a document name and 
disk. Use the Save As command whenever you 
want to save a copy of the current document 
under a different name or in a different folder 
(or disk). The newly saved copy becomes the 
active document.

2.3. Adding and Modifying Text

Entering Text

To enter text, just start typing. Word inserts the text you type at the insertion point. If you press 
a wrong key, use the Delete key to erase the mistake. Word automatically starts a new line 
when you reach the end of the current line. This is called "word wrap". Do not press Enter at the 
end of a line. Press Enter only at the end of paragraphs. 
For typing a paragraph follow the procedure given below:

Remember, don't press Enter at the end of the line. 

To move the insertion point with the mouse, click the mouse in the desired location. If the 
location you want is not visible, use the scroll bars to move up or down in the document. To 
move the insertion point to the top of the document, press <Ctrl + Home>. To move to the end 
of the document, press < Ctrl + End >. 
To insert new text, just click the mouse at the point where you want to insert the additional text 
and start typing. Existing text moves to accommodate your additions. 

Type <Ctrl + Home> to move to the very beginning of your document.

Deleting Text
The Backspace key deletes one character to the left of the insertion point. The Delete key 
deletes one character to the right of the insertion point. You can use these keys any time. To 
delete more than just a few characters, select the text and press the Delete key. 

Undoing Mistakes
If you have accidentally deleted an important paragraph, use the Undo command under the 
Edit menu immediately (The keyboard shortcut is < Ctrl + Z >). The deleted portion of the text 
is brought back.   This command can bring back the deleted contents only if you have not 
pressed any other key in between.
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2.4. Selecting Text:
You select a portion of text in order to perform some operation on it. You can then delete, 
replace, copy, move, or format it. The Selection Bar is located to the left of the document 
window. When you put your mouse pointer, which is a left pointing arrow in that area, the arrow 
swings to the right. The following table gives the process of selection of text contents.

To Select... Do this...

Word Double click anywhere on the word. 

Line Click right-pointing arrow in the selection bar to left of line. 

Sentence <Ctrl + click> anywhere in sentence. 

Paragraph Double-click the right-pointing arrow in the selection bar to the left 
of the paragraph, or triple-click in paragraph. 

A block of text of any size 
Click at one end of the block and shift-click at the other end of the 
block. Or click at one end of block and drag to the other end of the 
block. 

Entire document 
Press < Ctrl + A> or hold down the Ctrl key and click in the 
selection bar. 

Deselect text Click anywhere outside the selection. 

Extend a selection 
Shift-click an additional block. For example, if you have selected a 
paragraph and you shift-click on another paragraph, it will be added 
to the selection. 

2.5. Cut, Copy and Paste Text:
You can copy selected text from one place to another with the Copy and Paste commands. 

Cut - The Cut command extracts the selected text and puts it on the Clipboard (a temporary 
storage area). The contents of the Clipboard are overwritten with each copy or cut. This can be 
done either by selecting Edit from the menu bar and opting the cut option in it. Alternative usage 
of the short cut key is CTRL +X.

Copy - The Copy command puts a copy of the selected text on the Clipboard. By selecting the 
Edit from the menu bar and opting the Copy option in it. Alternative is usage of the short cut key 
is CTRL + C.

Paste - The Paste command inserts the Clipboard's contents at the insertion point. The text that 
has been selected using Cut/ Copy command will be pasted at the insertion point. Existing text 
moves to accommodate pasted text. By selecting the Edit from the menu bar and opting the 
Paste option in it. Alternative usage of the short cut key is CTRL + V.

2.6. Paste Special:
Paste Special is a way to paste information from one application/document to another.  The 
Paste Special dialog box allows you to paste information in different ways.  Choose Paste 
Special from the Edit Menu.
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You can paste in the information in several ways:

Formatted Text, Unformatted Text, Picture Object.

When we paste Formatted Text, it will paste all formatting (such as Bold, etc.) along with the 
text.  When we use Paste Special option the formatted text can be pasted as unformatted text 
or an object. 

2.7. Find and Replace:
Word allows us or helps us to search for a word in a document

Find: Find is used for searching a word in your document.
1.On the Edit menu, click Find. 
2.In the Find what box, enter the text that you want to search for. 

Replace: Replace is used to replace the searched word by another text.
Click On the Edit menu, click Replace.

In the Find what box, enter the text that you want to search for.
In the Replace with box, enter the replacement text.

The other options you have are Replace, Replace All, Find Next and Cancel.
Replace button replaces a word selected, at the first occurrence of the word in your document 
after the insertion point.

Replace All button replaces all the searched words in your document.
Find Next button searches for the next occurrence of the word being searched.
Cancel button cancels the search process. 

2.2. Undo and Redo:
Undo

When working in Microsoft Word you will often commit mistakes. Instead of manually trying to 
undo these actions you are able to rectify the mistake just by clicking the Undo button on the 
Standard toolbar.
To practice the Undo Feature:
1) Press CTRL +End to move to the end of the document
2) Highlight the last paragraph in the document
3) Press the Delete key on the keyboard
To Undo the Previous Action:
Click the Undo button on the Standard Toolbar

Redo
You may accidentally click Undo too many times and thus, need to redo it.  This command 
works exactly in the reverse of Undo command.
To Redo the Previous Action:
Click the Redo button on the Standard Toolbar
Save and close the file.
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2.2. Formatting Text and Paragraph
Microsoft Word allows you to format a document very easily. Without formatting, a document 
looks very plain and may not get the attention that is desired.

                                                                  Figure 2.9a

Making Font Changes

In Microsoft Word you are able to change the font size, color, type and attributes. Below we 
demonstrate various ways to change the font.

Select a document of unformatted text for formatting.

                                                                      Figure 2.9b
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To edit the font style
1) Highlight the paragraph
2) Select Format menu
3) Select a Font type.
4) Notice the Preview window at the bottom of the dialog box, which displays the style of the 
font, selected.
5) Click OK

Font Size
Opting the one of the numbers in size box does changing the font size for a selected portion of 
the text. 

Using Bold, Italics and Underline
Another way to make text stand out in a document is by using bold, italics and underline (or a 
combination of these) formatting.
To Bold Text in a Document

1) Select any word(s) in the document 
2) Click the Bold icon on the Formatting Toolbar

To Italicize Text in a Document
1) Select any word(s) in the document
2) Click the Italic icon on the Formatting Toolbar

To Underline Text in a Document
1) Select any word(s) in the document 
2) Click the Underline icon on the Formatting Toolbar

Formatting Paragraphs
In Microsoft Word, a paragraph is any amount of text followed by a paragraph symbol (¶). A 
one-word heading is a paragraph. A 100-word job description is a paragraph. Even a blank line 
terminated by a ¶ is a paragraph. 

You can perform paragraph formatting from the Format menu.
Highlight the paragraph you want to format. 
Click on Format from the Command menu. 
Choose Paragraph.
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                                  Figure 2.9c
Make the changes from the options that are displayed in the window. For example, to change 
line spacing from single to double, click on the Line spacing drop down arrow, and choose 
double. You can also choose options from the Formatting Tool Bar to format paragraphs.

2.10. Header and Footer
A header or footer is text or other information such as graphics that is stored at the top or 
bottom of the page throughout your document. You can use the same header and footer 
throughout a document or change for part of the document. For example, you can use your 
corporate logo in the first-page header, and then include the document's file name in the header 
for subsequent pages. 

To view Headers and Footers in Normal View, click View > Header and Footer. If you are in 
Page Layout View (Word 97) or Print Layout View (Word 2000), simply double click the visible 
header or footer that appears as gray text. 

In either case, the Header/Footer toolbar appears. 

                                                                 
Figure 
2.10
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2.11. Bullets and Numbering:

Word has a feature of giving automatic numbers and bullets for paragraphs or for points. For 
bullets fist select the paragraph or points to be bulleted and then select bullets icon form the 
standard toolbar or select Format from menu bar and opt for Bullets and numbering. Select 
different types of symbols as bullets.

2.12. Zooming:

The level of magnification of the text can be controlled by this zooming control. Choose 
percentage value from the zoom popup menu and size of magnification of text.

2.13. Page Break:

After allowing certain number of lines MS Word automatically inserts a dotted line in the 
document called page break. We can insert a page break at any line in the document. Select 
Insert Menu from menu bar and click break. Now the page break dialog box appears. Here 
select page break button and click on it. Then page break will be inserted at the current cursor 
position.

2.14. Auto Correct and Auto Text:

Auto Correct

Auto Correct is used to correct the repeated typing mistakes. Select Tools menu from the menu 
bar and click Auto Correct option, then activate Auto correct tab. Here type frequently 
misspelled words in ‘Replace box’ and the correct one’s in ‘with box’. Click the Add button to 
add this to the dictionary. Afterwards if we misspell a word, which was added to the dictionary, 
word will automatically correct the mistake.

Auto Text

Frequently typed text can be placed into an Auto Text entry. First type the text what we want to 
put into an Auto Text entry and then select it. Select Tools menu and Click Auto Correct and 
then activate Auto Text Tab.  Now, enter the abbreviation for the selected text and click OK. 
Afterwards, if we want to type the text that is there in the Auto Text, simply type the abbreviation 
and click OK. Then automatically the text will be typed without actually typing.

2.15. Page Setup:

Page Margins
The page margins of the document can be changed using the rulers on the page and the Page 
Setup window. The ruler method is discussed, 
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Figure 2.15a

first move the mouse over the area where the white ruler changes to gray.

When the cursor becomes a double-ended arrow, click with the mouse and drag the margin 
indicator to the desired location. Release the mouse when the margin is set. 

                                                        
                                                      Figure 2.15b

The margins can also be changed using the Page Setup dialog box:
Select File/Page Setup and choose the Margins tab in the dialog box.
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Enter margin values in the Top, Bottom, Left, and Right boxes. The Preview window will reflect 
the changes. If the document has Headers and/or Footers, the distance this text appears from 
the edge of the page can be changed. Click OK when finished.

Page Size and Orientation
Change the orientation page within the Page Setup dialog box.
Select File/Page Setup and choose the Paper Size tab.

                                                         Figure 2.15c
Select the proper paper size from the drop-down menu. 
Change the orientation from Portrait or Landscape by checking the corresponding radio button.

Page Numbers
Follow these instructions to add page numbers to a document.
Select Insert/Page numbers from the menu bar and the following dialog box will appear.
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Figure 6.15d

Select the position of the page numbers by choosing "Top of page" or "Bottom of page" from the 
Position drop-down menu. Select the alignment of the page numbers in the Alignment drop-
down menu. If you do not want the page number to show on the first page (if it is a title page, for 
example), uncheck the Show number of first page box.  Click OK when finished. 

2.16. Print Preview and Printing:
Preview your document by clicking the Print Preview button on the standard toolbar or by 
selecting File/Print Preview. When the document is ready to print, click the Print button from the 
Print Preview screen or select File|Print.

2.17.Summary:
At the end of this lesson you have learnt the important features of Ms-Word. We started 

with procedure to invoke Ms-Word. We have identified toolbars available in the word. You learnt 
the procedure of creating a new document and opening an existing document. Now you are in a 
position to create a new document and can make corrections like deleting a character, word, 
line or paragraph and replace with required text by using replace option. You can also move the 
selected part of the text to another place by the “cut” and “paste” commands. At the end of the 
lesson we discussed the procedure of saving a document and exit from word.

You have gained the knowledge of formatting a document using different formatting options like 
setting margins, changing the font size, and alignment to the text. The headers, footers, tabs, 
indents make the document in presentable format.

2.12. Technical Terms:
Font
Font refers to the combination of a typeface (eg. Times Roman, Arial, Century Schoolbook) and 
its attributes (bold, italics, size (12pts).

Bullets

Bullets are special characters or symbols that are used to set off a paragraph. Typically, each 
bulleted paragraph is an item in a list, and it consists of the bullet symbol and indenting to set 
the bullet apart from the text.

Document

A document is any data file that is created by a specific application.

Current Document

The current, or active document is the document you see on the Word screen.

Drag-and-drop

Drag-and-drop is a feature that allows you to move or copy information without using the 
Windows Clipboard. To use it, you simply drag a selected item from one location to another. It is 
best used for moving or copying small items short distances.

Footer
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A Footer is the contents of an area located within the bottom margin of a page.

Header

A header is the contents of an area located within the top margin of a page.

Justification

Justification determines how lines and characters within those lines are printed. With full 
justification, all lines start at the left margin and end at the right margin.

Margin

The margin is the amount of blank space, usually measured in inches or characters, above and 
below and to the right and left of the main body of a document.

Menu Bar

The menu bar contains the names of Word's menus and is used to navigate through their 
commands.

Paragraph

A paragraph in Word begins where you start typing, and it ends where you press [ENTER].

2.12. Model Questions:
1. Explain about different components of MS-Word window.

2. Explain Find, Replace & Go To?

3. Explain Header and Footer?

4. What is the difference between Auto Correct and Auto Text

5. Explain the text formatting features in MS-Word

2.20. References:

RON MANSFIELD, ‘Working with MS OFFICE’, Tata Mc Graw Hill – 2000 Edition

GUY HART DAVIS, ‘ The ABC’S Of Microsoft Office. ‘ BPB Publications,  New Delhi

MS OFFICE 2000 Complete, BPB Publications, New Delhi 

                         Y. SURESH BABU, M.Com., M.C.A.,
                           Lecturer, Dept.Of Computer Science,
                            JKC College,  GUNTUR.
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UNIT – II 

Microsoft Word

2.0.2 Objectives:

This lesson provides an introduction to the Views, Spell Checking, Tables, Macros and Mail 
merge. 

Structure of the Lesson:

2.1. Views
2.2. Spell Checker
2.3. Word Count
2.4. Macro
2.5. Graphics
2.6. Lines and Shapes
2.7. Word art
2.2. Tables
2.2. Borders and Shading
2.10.Footnote and Endnote
2.11.Tabs
2.12.Mail merge
2.13.Format Painter
2.14.Summary
2.15.Technical Terms 
2.16.Model Questions 
2.17.References

2.1.Views:
Any document can be viewed in different fashions. These views can be selected from the view 
menu of the menu bar.

Normal view is a default view for all new documents. However saved document will be opened 
last saved view.  For example a document is opened in normal view and saved in page layout 
view, when saved document is reopened, the document will be opened in page layout view.
  
Normal View
You can create and edit text or graphics normally.  To work with header and footers you 
invoked select item/Header and Footer.    Footer details will not be displayed on screen. 

This view will not show side-by-side column positioning, footers and headers. Automatic page 
breaks are shown as dotted lines.  Manual page breaks containing the words “ Page Break”.

Page layout View
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In this view headers & footers can be seen and edited. You can modify the Header/Footer by 
the selecting the matter itself.  It will display the left side scale also.

Outline View

This view is used to see entire contents of the document, chapter headlines and sections 
headings if your document is properly formatted.  It is useful if the document is large.

Print Preview
Print preview is another way to view a document.  Choose file  print preview or Ctrl +F2.  You 
can see one page to six pages at a time in print preview. 

Split Screen View
You can see two parts of your document at once.  This feature is useful to make copying, 
cutting and pasting quickly in both the documents simultaneously.

2.2. Spelling Checker:
To start the spelling checker, select Spelling and Grammar from the Tools menu. MS Word will 
begin to check for misspellings. If a word is found that is not in its dictionary, it pauses, displays 
the word, and if possible, suggests alternatives (see figure below). 

                                                 Figure 2.2

You have several choices at this point described in the table below. If the word is spelled 
correctly, you can Ignore it or add it to a custom dictionary by selecting the options. If the word 
is incorrect, you can use Replace it with one of its suggestions or with a spelling you type in the 
Change To: box.

If the word is spelled correctly... 
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To ignore only this occurrence of the word, click Ignore

To ignore all occurrences of the word, click Ignore All 

To add the word to a custom dictionary, click Add 

If the word is misspelled... 

First, click correct spelling in Suggestions list or type the correction in the Change To: 
box. Then... 

To change only this occurrence of the word, click Change 

To change all occurrence of the word, click Change All 

2.3. Word Count:
Word count displays the number of words, paragraphs, lines, characters, pages in the 
document. Select Tools menu from the menu bar and click on the word count.

2.4. Macro:
Macros are advanced features that can speed up editing or formatting you may perform often in 
a Word document. They record sequences of menu selections that you choose so that a series 
of actions can be completed in one step. 

Recording A Macro

To record a macro, follow these steps: 

                               Figure 2.4a

Click Tools/Macro/Record New Macro on the menu bar.
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Name the macro in the Macro name field. This name cannot contain spaces and or begin with a 
number. 

From the Store macro in drop-down box, select the document you would like the macro to be 
associated with or choose "All Documents" enabling to use the macro in any document. Enter a 
description of the macro in the Description field. This is for your reference only so you 
remember what the macro does. Click OK to begin recording. 

Select options from the drop-down menus and Word will record the options you choose from the 
dialog boxes, such as changing the margins on the Page Setup window. Select only options 
that modify the document. Word will not record toggle actions such as View/Toolbars that have 
no effect on the document itself. 

The recording toolbar will allow you to stop, pause, and resume recording.
Click the Stop button in the recording toolbar. The macro is now saved. 

                                                   Figure 2.4b

Running A Macro

To run an existing macro, follow these steps: 

                                     Figure 2.4c

Select Tools/Macro/Macros from the menu bar.

From the Macros window, highlight the Macro name in the list and click Run.
If the macro is long and you want to stop it while it is running, press BREAK (hold CTRL and 
press PAUSE).
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                                                                                Figure 2.5.

2.5.Graphics:
Microsoft Word contains a full set of graphic tools. You can:

Create graphics from scratch. 

Import graphics from other programs. 

Place graphics within text. 

Manipulate graphics on a page.

Word comes with some pre-designed graphics that are normally installed in the MS 
OFFICE\CLIP ART folder. These graphics can be resized and placed within text. 

Inserting a Graphic in your Document 

To insert a graphic in a document position the insert point where you want to place the graphic 
in the text. Select Picture from the insert menu. Click on Clip art, and double-click the graphic 
you want to insert. 

Choose Insert, Picture, Clip Art or click the Insert Clip Art button on the Drawing toolbar. 

Word opens the Clip Art Task Pane. 

Search for a specific clip image by entering what you are looking for within the Search field in 
the Task Pane. 

Alternately, click on the Clip Organizer button toward the bottom of the Task Pane to open up 
the Clip Art Organizer. 

Select a clip and when Word shows a control palette, select the first option, Insert Clip. The clip 
is inserted where your insertion point is positioned. 

You can also drag the clip art into your document. 
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Wrapping Text around a Graphic

By default text does not wrap around a graphic. To get text to wrap around a graphic, do the 
following:

Right click on the graphic to get the short cut menu. 

Choose Format Picture from the list displayed. 

Select the Layout tab. 

Choose the style of wrap that you like and click OK.

Resizing a Picture

Select the inserted picture by clicking once on it. 

Click the Cropping tool on the Picture toolbar. 

Notice that the mouse cursor has changed. 

Drag one of the corners with the pointer to reduce its size and eliminate it. 

2.6. Lines and Shapes
Use the Drawing toolbar to create lines, shapes, text boxes, AutoShapes, WordArt, or Clip Art. 

Drawing a Line or Arrow

Open a new Word document. Click the Drawing tool in the Standard toolbar or right click in any 
toolbar on your screen to display a list of available toolbars. Select the Drawing toolbar. Click a 
line or arrow on the Drawing toolbar. When the cross hair (+) appears, point to a spot in your 
document where you want the line or shape and draw a shape.

Drawing an AutoShape

Click AutoShapes on the Drawing toolbar. Select Stars and Banners from the drop down list of 
categories. Select the shape you want. Click in your document and drag the cross hair that 
appears to draw the shape. 

Adding a Text Box:

Click the Text Box icon on the Drawing toolbar. When the cross hair appears, point to a spot in 
your document where you want the text box and drag. The box appears with an insertion point 
in it. Type "Microsoft Word Graphics" within the box. 

2.7. WordArt :
To display the Word Art Gallery, choose Insert, Picture, WordArt or click the WordArt icon on 
the Drawing toolbar. Double-Click a WordArt style. Word opens the Edit WordArt dialog box. 
Type the text you want and it will replace the sample text. Choose a font, font size, and style. 
Click OK to close the WordArt Gallery and see your text. 
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                                           Figure 2.7

2.2. Tables:
Creating Tables Using the Menu

A table is a grid of rows and columns on the page, like a spreadsheet. The area where a row 
and column intersect is called a cell. The number and width of columns can vary from row to 
row. Cells are separated by gridlines, which are non-printing separators. To display the table 
gridlines, select Gridlines from the Table menu. 

Each cell can contain a paragraph, multiple paragraphs of text, or graphics. Microsoft Word 
wraps text within a cell in the same way that text is wrapped at the end of a line of normal text. 
Text within cells can be formatted, copied, cut, and pasted. You can add text, edit text, change 
its size, add borders, or add and delete columns and rows. 

To create a table, select the Insert Table command from the Table menu. The Table Dialog box 
appears: enter the number of columns and rows you want to include in the table and click on the 
OK button. A table with the number of columns and rows that you specified is inserted in your 
document and the cursor is positioned in the first cell of the table. You can move from cell to cell 
using the <Tab> key, to move forward to the next cell and the <Shift Tab> keys to move back to 
the previous cell. 

Creating a Table Using the Table Button in the Standard Toolbar 

The Table button on the Toolbar provides another way to create a table. To use the Table 
button, place the mouse on the Table button and press the mouse button. The Table button 
selection box pops down. Drag the mouse down to select the number of rows you want and to 
the right to select the number of columns. When you have selected the correct number of rows 
and columns, release the mouse button. A table with the number of cells you have specified is 
inserted in your document. 

Selecting Tables

Cells in a table can be selected using the click-and-drag method or one of the following 
techniques:
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To select a 
cell: 

Click in the lower left corner of the cell. (The mouse pointer shape 
becomes a right pointing arrow.) 

To select a 
row: 

Single Click in the selection bar to the left of the row. 

To select a 
column: 

Place the mouse on the top border of the column and click. (The mouse 
pointer becomes a black down pointing arrow.) 

To select the 
entire table: 

On a Macintosh hold down the Option button and double-click in the 
table. On a Windows machine Press the <Alt> key and the number 5 key 
on the numeric keypad . (The NumLock must be turned off.) 

To select more 
than one cell: 

Drag the mouse across the desired cell selection. 

Inserting Columns and Rows

To insert a row or column within a table, select Insert Row or Column options from the Table 
menu and position the insertion point in the row/column you want to insert. 

Changing Column Width

You can adjust the width of a column, or you can adjust the width of all the cells in a column. To 
change the column width, click on the column width button. Drag the button to the left or right 
according to your needs. To change the width of all the columns select the entire table and drag 
the column width button you wish to change. 

Click and drag the first column width button to the 1.5-inch mark. Click on the Next Column 
width button to the 3-inch mark. The mouse can also be used to change column widths. To 
select the column that you want to change, place the mouse pointer on the right border of the 
column. As you move the mouse pointer on top of the column border the pointer becomes a 
two-headed arrow (see example). When the mouse pointer is displayed as the two-headed 
arrow, press the mouse button and drag to reposition the column width. As you drag the mouse, 
an outline of the new border shows the border position. When you have resized the column to a 
satisfactory width, release the mouse button. The entire column is resized accordingly. 
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Deleting Columns and Rows 

To delete a column or row, select the column or row you want to delete then select Delete 
column or row from the Table menu. Notice that if you select a column, the command is Delete 
Columns. If you select a row, the command is Delete Rows. 

2.2. Borders and Shading:

You can add a border to any or all sides of each page in a document, to pages in a section, to 
the first page only, or to all pages except the first. You can add page borders in many line styles 
and colors, as well as a variety of graphical borders.

2.10. Footnote and Endnote:
Footnotes and Endnotes are used in printed documents to explain, comment on, or provide 

references for text in a document. You can include both Footnotes and Endnotes in the same 
document — for example, you might use Footnotes for detailed comments and Endnotes for 
citation of sources. Footnotes appear at the end of each page in a document. Endnotes typically 
appear at the end of a document. 

1. In print layout view, click where you want to insert the note reference mark.

2. On the Insert menu, click Footnote.

3. Click Footnote or Endnote.

4. Under Numbering, click the option you want. 

5. Click OK. 
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Word inserts the note number and places the insertion point next to the note number. 

6. Type the note text.

7. Scroll to your place in the document.

2.11. Tabs:
By using tab key on the keyboard we can move the cursor by a fixed distance in the 

document. By default, every tab press, the cursor moves half-inch. But we can create our own 
tab positions. For creating customized tab positions first we have to select the tab alignment 
button at the left hand side corner of the ruler line. Tabs can also be created, by using the tab 
dialog box. Select Format menu from the menu bar and click tabs option. Then we get Tabs 
dialog box. Here we select the type of the tab and distance and click OK. button. Then the tabs 
will be set accordingly. Here by using tab dialog box we can also create one more tab i.e., bar 
tab. By this we can create a vertical line in the text at the specified bar tab position.

2.12. Mail Merge:
Mail Merge is used to quickly create form letters, mailing labels, envelops and catalogs by 
merging the information from two different files.  Those two files are generally the Main 
Document and Data Source File. After creating those two files, they are merged to get the 
desired result. Generally mail merge is used to print multiple copies of a particular letter 
addressed to many members. For example Circulars, Greetings & Invitations will come under 
mail merging.

Main Document

The main document contains the subject matter of the letter to be printed.  It can contain text, 
graphics objects and fields (data), which are to be inserted in to the letter. When merging, data 
will be merged with the main document.

Data Source

Data Source file contains the information in the form of records, which is to be inserted to the 
main document.  In one record, one member’s information is stored – for example one person’s 
address. The individual information in the records is called a field. Actually the data written in 
these fields will be inserted in the main document during merge.

Merge requires 3 steps

Creating Main Document

Creating Data Source

Merging two files.

Creating Main Document

First, Open a new document to create a main document by selecting FileNew.  Then select 
ToolsMail Merge. The following dialog box will be displayed on screen:
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Click on the “Create” button to display the available formats (form letter, mailing labels, 
envelopes or catalog) of the main document. Then a dialog will be displayed prompting where to 
create the main document (whether the active window or a new document). Click on “active 
window” to create the main document in the active window.

Creating Data Source

To create a data source file click on Get Data in Data Source. The following will be displayed. 
Click on Create Data Source to specify the fields to be included in the address, like name, place 
etc.,

The existing field names will be displayed on the screen to the right.  Unwanted fields can be 
removed by clicking on the field name and by clicking on the field name and by clicking on the 
button  “remove field name”.  If any new fields are to be added, type the field name on the left 
side. After specifying the field names, to type the contents, click on ok. A dialog box will be 
displayed to specify a name for the data source. Type the name and click on “Save”. A dialog 
box is displayed asking to edit the data source or edit the master document. The following 
diagram specifies the same:
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Type the details by pressing enter after typing the first name, job title etc., for this, click 
on “Add new”. After typing all the details click on OK. Add contents to the document. Insert the 
merge fields in the window document.  Finally select toolsmail merge. Merge dialog box will 
again get displayed, click on “Merge”.

2.13. Format Painter:
The Format Painter is a button on the Standard toolbar. It makes it easy to copy all the 
formatting features of one paragraph to one or more paragraphs.

To copy the paragraph formatting using the Format Painter you will: 

1. Highlight the paragraph whose format you want to copy. 

2. Now click the Format Painter button on the Standard toolbar. 

o If you press the button once, you will be allowed to copy the format to only one 
paragraph. 

o If you double-click the button, the button will stay depressed and allow you to 
copy the format to as many paragraphs as you want. When you are finished you 
must then click the Format Button once in order to turn off the feature. 

3. Notice that your insertion point now has a Paint Brush attached to it. This indicates that 
the format of the selected paragraph may be painted or copied onto another paragraph. 

4. Place your insertion point anywhere within the paragraph that is to receive the format 
and click the left mouse button. At this point the format of this paragraph will change. 

2.14.Summary:

In this lesson we discussed the procedure of inserting a table in the document. You can insert a 
table of required number of rows and columns.  In this lesson you have learnt the concept of 
mail merge and its usefulness. The mail merge feature supports many word processors that 
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enable you to generate form letters.  The mail merge feature of Ms-Word requires mainly two 
components: the main document and the data file. The main document is the body of the letter 
that has to be sent. The data file contains the list of names and addresses in the form of rows. 
You have learnt the procedures of creating the main document and the data file, and combining 
them.

You have observed how to use spell checker, the macro capability, and working with the 
graphics like ClipArt, WordArt, Format Painter, Footnote and Endnote features.

2.15. Technical Terms:

ClipArt 

ClipArt consists of pre-designed images that can be placed within a document.

Data Form

A data form is a dialog box that allows you to view and edit individual records in a database.

Data Source

A data source contains the information from which a merged document is created. The data 
source is merged with a main document, which specifies the kind of output required.

Database

A database is a collection of organized information.

Dictionary

Word uses two kinds of dictionaries, a main dictionary and a custom dictionary. The main 
dictionary cannot be altered; we can add words to the custom dictionary.

Mail Merge

Mail Merge refers to the process of combining a data source, and a main document to produce 
a unique output.

Wizard

A wizard is a feature of Microsoft applications that lets you work through a series of dialog 
boxes to help you complete a task.

2.16. Model Questions:

1. What is a macro? Explain the procedure for creating a macro?

2. How do you perform mail merge?

3. Explain the difference between Footnote and Endnote?

4. Explain the procedure to create a table?

5. Explain different views in Ms Word ?
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6. Explain the graphic facilities in MS-Word ?

2.17.Refereneces:

RON MANSFIELD, ‘Working with MS OFFICE’, Tata Mc Graw Hill – 2000 Edition

GUY HART DAVIS, ‘ The ABC’S Of Microsoft Office. ‘ BPB Publications, New Delhi

MS OFFICE 2000 Complete, BPB Publications, New Delhi 
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UNIT- II

Microsoft PowerPoint

2.0 Objective:
This lesson introduces the basic features of Microsoft PowerPoint, Creating Presentations, View 
options, Inserting new slides and setting background color scheme to the presentation.

Structure of the Lesson:

22..11 PPoowweerrPPooiinntt bbaassiiccss

22..22 SSttaarrttiinngg aa pprreesseennttaattiioonn

22..33 PPoowweerrPPooiinntt wwiinnddooww pprrooppeerrttiieess

22..44 SSaavvee aa PPoowweerrPPooiinntt pprreesseennttaattiioonn

22..55.. CCooppyy aanndd MMoovvee ddaattaa iinn aa PPoowweerrPPooiinntt pprreesseennttaattiioonn

22..66.. VViieeww ooppttiioonnss

22..77 AAdddd aa sslliiddee

22..22 AAdddd//MMooddiiffyy tteexxtt

22..99 BBuulllleett ssttyylleess

22..1100 SSppeeaakkeerr nnootteess

22..1111 BBaacckkggrroouunndd//CCoolloorr sscchheemmee

22..1122 SSlliiddee mmaasstteerr

22..1133 HHeeaaddeerrss//FFooootteerrss

22..1144 SSuummmmaarryy

22..1144 TTeecchhnniiccaall TTeerrmmss

22..1155 MMooddeell QQuueessttiioonnss

22..1166 RReeffeerreenncceess

2.1. PowerPoint Basics:
PowerPoint is an application that lets you build, print, and deliver presentations. You 

have several options for the delivery of a presentation, but you only have to develop it once. 
You can print slides, print handouts, print notes pages, prepare for 35mm slides, or deliver an 
on-screen presentation. Only the on-screen presentation allows you to use the full range of 
PowerPoint's features.

As you develop a PowerPoint presentation, it is important to remember that you should 
not try to include every piece of information you wish to deliver. PowerPoint slides should 
contain brief, concise, descriptive phrases that will help you remember what you want to present 
and to serve as a reminder for your audience. 
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2.2. Starting A Presentation:
Start PowerPoint by either of two methods:

1. Go to the Start menu. Choose Programs and then click on Microsoft PowerPoint. 

2. Double-click the icon of any PowerPoint document. When you double-click a PowerPoint 
document, PowerPoint opens with the document already loaded. 

A PowerPoint presentation consists of slides that can contain text, graphics, charts, and other 
data types. When you start PowerPoint, you can start with a blank presentation, or you can 
begin from a template or use the AutoContent Wizard.

The AutoContent Wizard is series of step-by-step instructions designed to assist you. The 
Template button to help accesses slide templates create a consistent, professional look for your 
slide 
resentation. 

                                                 New Presentation Dialog Box

AutoContent Wizard walks you through a series of questions designed to elicit information 
about you and the type of presentation you are making. The Wizard then builds a dummy 
presentation that will guide you in developing the content of the presentation.

Design Template allows you to establish the background and color scheme from the available 
templates prior to beginning work in the new presentation. Template choices are generally 
easier to make after you have opened the new presentation because you can better see the 
characteristics of each template before making a selection.
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Blank presentation opens a new presentation with no template. Open an existing presentation 
displays a list of recently opened PowerPoint presentations from which you can choose. Or, you 
may choose More Files to move to the location of a previously saved presentation file and open 
it.

AutoLayout

After you have opened a new presentation, PowerPoint displays the New Slide dialog box 
containing several Auto Layouts. Auto Layouts provide a pre-determined layout for each specific 
type of slide. They provide consistency throughout the presentation. Each layout depicted is 
described in the lower right corner when you click the layout. This sample New Slide dialog box 
shows the Title Slide selected (denoted with the thick border).

New Slide Layout Dialog Box

2.3. PowerPoint Window Properties:
The Microsoft PowerPoint window has many of the same attributes as other windows in 

the Microsoft Office Suite. The table below lists the different features and provides a brief 
description of each one. 

Besides the usual window components, the PowerPoint window has several unique elements, 
identified in the figure below.
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Menu Bar

The words listed atop the application window, immediately underneath the Title bar. You can 
access all application commands from the Menu bar

Standard Toolbar

The Standard toolbar, located beneath the menu bar, has buttons for commonly performed 
tasks like printing, saving, inserting clip art, and other operations. You can customize the toolbar 
or even display multiple toolbars at the same time. 

Formatting toolbar
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The Formatting toolbar, located beneath the Standard toolbar bar, or possible to the side of it, 
has buttons for various formatting operations like changing text size or style, changing 
alignment, formatting bullets, and animation 

Drawing Toolbar

The Drawing toolbar on the bottom of the PowerPoint window contains drawing and text tools 
for creating graphics.

Slide Layout Task Pane

The area on the left side of the window that allow you to easily switch between the Outline and 
the Slides views.

Slide Area

The area in the middle, in which you actually work on your presentation slides

Task Pane

The area on the right side of the window that allows you to easily access various commands. 
You can display different Task Pane options by clicking on the dropdown arrow in the upper 
right-hand corner of the pane.

2.4. Save a PowerPoint Presentation:

Changes you make to a document are not saved to disk until you issue a Save 
command. Saving is quick and easy, and you should save often to minimize the loss of your 
work. PowerPoint has two save commands, Save and Save As, that work similarly. Both 
commands are on the File menu.

Save
When you save a new presentation for the first time, PowerPoint displays a dialog box similar to 
the Open dialog box. Select the disk in which to save the presentation and specify a name for 
the file. When you save an existing document that you have been editing, the newly saved 
version replaces the older version.

Save As
This command displays a dialog box where you can choose a document name and destination 
folder or disk. Use the Save As command whenever you want to save a copy of the current 
document with a different name or in a different folder or disk. The newly saved copy becomes 
the active document
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A presentation is normally saved as name.ppt file type. However, PowerPoint Show with the 
extension of name.ppt is also a useful file type so that your file is able to run regardless of 
operating system. 

2.5. Copy and Move data in a PowerPoint Presentation:

Use the Copy and Paste commands to copy selected text and graphics from one slide to 
another. If you want to move data instead, use the Cut and Paste commands. To do this:

 Select the text you want to cut or copy by highlighting it.

 Go to the Standard Toolbar to choose the Cut or Copy short cut icon.

 Move and click your mouse to the place where you want the text to go. Note the cursor 
is blinking.

 Go to the Standard Toolbar to choose the Paste short cut icon.

2.6. View Options:
Power point offers different views for entering, editing and previewing your information. They 
are:

 Slide view
 Outline view
 Slide Sorter view
 Notes Pages view
 Slide show view

Slide View
Slide view shows how our listed slides will work. We can move from one slide to another with 
pg up and pg dn keys. We can edit text and other slide elements in slide view.

Outline view
It will display all the text in the presentation. Here we can easily rearrange line item. We 
collapse items in this view so that we can see important headings or names of each slide.

Enter and Edit Text in Outline View:

PowerPoint's Outline Area lets you focus on the content of your presentation, by typing up the 
outline prior to laying the presentation out. After you type an outline, you can concentrate on 
how your presentation looks

The boundary of the Outline Area can be resized by dragging the vertical separation to the right. 
This will make it easier to enter your outline.

Entering Slide Titles and Bullets:

Typing in PowerPoint's Outline view is similar to using a word processor. Type your slide title or 
bullet point and press Return to start a new slide or bullet. To force a line break within a slide 
title or bullet, press Shift-Enter. This starts a new line for the same title or bullet.

Move Slides in the Outline Area:
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It's easy to change the order of your slides and bullets in the Outline Area. Press the mouse 
button on the item you want to move and drag it to the desired location. You can also select the 
item you want to move and click on the Move Up or Move Down buttons.

Delete Slides or Bullets:

While working in the Outline Area, you can delete a slide by clicking on the slide icon next to the 
title and pressing the Delete key. Delete bullets and sub bullets similarly.

Slide Sorter view
It will show the slides in reduced size. We drop the sliders to move the slides so that we can 
change the order of slides. We can make the slides appear and disappear using the effects.

Notes Page View
It is to create and see notes to the presenter. It shows miniature slide image and provides a text 
area for presenters notes.

To enter notes 
1.Click on the text area shown below this line. The box outline will change appearance.
2. Type and edit in the note box.

Slide show view
It will show the slides in reduced size. We drop the slides to move the slides so that we can 
change the order of slides. We can make the slides appear and disappear using the effects.

When you right click on the slide it will show some options. In that we can opt ‘Pen’ to draw the 
temporary lines. These lines will not be saved on the slides. To leave from the slide show press 
Esc.

Zoom

The Zoom adjuster lets you alter how large your slides appear on the screen relative to full-
screen presentation mode. Click on the Zoom drop-down list (in the toolbar near the top of the 
screen), or click on the View menu, and select Zoom... Select "fit", a default percentage, or type 
in your own number, according to your needs.

2.7. Add a Slide:

In the Text Outline area, you can add a slide before or after an existing slide. 

 To add before a slide position the cursor at the beginning of text of the slide in front of 
which you would like a new slide, and press the Enter key. 

 To add after a slide, position the cursor at the end of the text of the slide after which you 
would like a new slide, and press the Enter key (if you had indented levels of text on the 
previous slide, use the Promote (left arrow) button in the toolbar at the top of the screen 

to move the text back to the left to force a new slide. 

In Normal, Outline, Slide, or Slide Sorter view, select the slide after which you wish to insert a 
new slide. 
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 Then click on the Insert menu, and select New Slide. 

 When you add a new slide this way, the New Slide window appears, asking you to 
select a slide layout. 

 Select whichever layout is appropriate for the content you will place on the new slide. 
The one selected in the example on the right is "Bulleted List". If the provided layouts 
don't meet your needs, select the bottom-right layout, "Blank", which will provide you 
with a new empty slide. However, no matter which layout you choose, you will be able to 
modify it later. 

2.8. Add/Modify Text:

Here are a few ways to insert or modify text in PowerPoint:

 In Normal or Slide view, select the slide on which you wish to insert text. If there is 
already a text box on the slide you may click your mouse on it and start typing. Familiar 
word processing tools for modifying text (color, style, font, alignment, etc.) are provided. 

 In Normal or Slide view, to add a new text box to a slide, click on the Insert menu, and 
select Text Box. Put your mouse over the slide layout - the cursor will change to a 
narrow down-arrow (as shown on the left below). Click, hold, drag, and release the 
mouse to form a rectangle on the slide. Then you can type into the text box created for 
you (as shown below).

  

 To work directly in the Text Outline area, position the cursor at the point where you 
would like the new text to appear and just type it in. Use the Promote / Demote buttons 

in the toolbar at the top of the screen to create different levels of indentation. 
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2.2. Bullet Styles:
Although you can set Bullet Styles in the Master, you also can change the bullet style 

on any slide or on any bulleted point. When you change the bullet style, every subsequent bullet 
on that slide, whether promoted or demoted, will have that style until you change back to the 
default or change to a different slide.

To change the bullet style, make sure the cursor is in the line of text in which you wish to 
change the bullet, then choose FORMAT: Bullet.
NOTE: Sometimes it is difficult to remember exactly what the default bullet style was, so pay 
close attention to the selected bullet before proceeding with any changes.

Format Bullet Dialog Box
You can choose from the selections provided by PowerPoint, choosing both the size (in 
percentage of text size) and the color.

Click Character to include any symbol font installed on your system. Keep in mind, however, 
that if you choose a font that is not installed on the computer from which you are giving your 
presentation, the presentation computer will choose the "closest" font to the one you chose and 
the result may not be one you like. Both Symbol and Wingdings font are standard on most 
computers and should display as you intended.

Adding / Removing Bullets

The Bullet Tool is a toggle. Click it once to place a bullet at the beginning of the current line 
of text (the one in which the cursor is flashing). Click it again to remove the bullet. This way you 
can add bullets to text you have typed without using the Bullet AutoLayout.
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2.10. Speaker Notes:
PowerPoint has a facility for adding speaker notes to a presentation. These can be notes that 
you create for yourself — for example, to help you remember key points during a 
presentation — or you can create them as additional information for your audience. After you 
have completed a presentation, you can print the notes for each slide, along with a smaller 
version of the slide. To add notes to a slide: 

 Click on the View menu, and select Notes Page (you may want to adjust the Zoom
percentage to get a larger view). 

(Notes Page)

2.11. Background / Color Scheme:
Design templates contain color schemes, slide and title masters with custom formatting, and 
styled fonts, all designed to create a particular look. Not only can you specify a design template 
when you begin a new presentation, you can choose a design template (for the whole 
presentation, not individual slides) any time while editing a presentation. To do this, click on the 
Format menu, and select Apply Design Template. A window will open asking you to choose a 
design. Select one and click Apply. The name of the template chosen will be displayed in the 
center of the status bar at the bottom of the PowerPoint screen. If the status bar is not visible, 
click on the Tools menu, select Options, click on the View tab, and ensure that Status bar is 
checked.
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The background color of slides can be customized by clicking on the Format menu / 
Background. Click on the drop-down list to select either another color from the subset provided 
or click on More Colors and Fill Effects to see other choices. One of the Fill Effects available 
is Picture (import an external image file to use as a slide background). When you are done, 
click on Apply (if you wish to alter just the current slide) or Apply to All (to alter all slides at 
once).

The color scheme for slides can be customized by clicking on Format / Slide Color Scheme. 
Either chooses a preset scheme from the Standard tab or click the Custom tab, click on the 
desired component (e.g. Background), and click Change Color (a color selection window will 
appear). When you are done making color choices, click on Apply (if you wish to alter just the 
current slide) or Apply to All (to alter all slides at once).
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2.12. Slide Master
The Slide Master in a template is a slide that controls the formatting, text, and objects 

that appear on every slide in your presentation. For example, if you want a small picture of the 
world to appear on every slide, place that picture on the Slide Master. To display the Slide 
Master, choose Master/Slide Master from the View menu. You can then edit this slide. Changes 
you make to the Slide Master also appear on each slide in your presentation.

It is easy to edit the text of a slide in the Outline Area. However, to modify a slide's 
appearance, switch to Slide View. If you want your changes to apply to every slide in the 
presentation, choose Master/Slide Master from the View menu.

In Slide View just click on an object to select it. Then use the Format menu to apply the 
change you want. For example, to change the font or color of the slide title, select the slide title 
and choose Font from the Format menu. The Format menu also has commands for centering or 
left aligning text (Alignment), and changing colors (Colors and Lines). You can even change the 
format of slide bullets using the Bullets command on the Format menu. PowerPoint also has a 
Formatting toolbar to simplify basic formatting tasks.

Sample Slide Master
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2.13. Headers / Footers:
 On the View menu, click Header and Footer. 

 On the Slide tab, you set options,  the effect of the options selected will appear at the 
bottom of slides: 

o Date and time can be set to Update automatically (to reflect the last date the 
slides were modified) or Fixed (type a certain date such as when the 
presentation will be given). 

o Selecting the Slide number option will automatically insert a sequence number. 

o Selecting Footer (and typing text in the box below it) inserts fixed footer text. 

o Selecting Don't show on title slide will omit the footer from the title slide (but it 
will appear on the other slides). 

o Normally you click on the Apply to All button to make these changes throughout 
the presentation, but of course you can click Apply to affect just the current slide. 

 Similar options are available on the Notes and Handouts tab, plus the option of adding 
a page header to your printouts.

2.14. Summary:
At the end of this lesson you have learnt the important features of Ms-PowerPoint 

including creating a presentation, opening an existing presentation and working with different 
kinds of slide layouts. We identified different toolbars available in PowerPoint. 

You are in a position to format the text, applying background color to the presentation, working 
with master slide, applying speaker notes to slide, applying header and footer to the document.  

2.14. Technical Terms:
Slide: Brief, concise, descriptive phrases that will help you remember what you want to 

present and to serve as a reminder for your audience. 
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PowerPoint Presentation: PowerPoint presentation consists of slides that can contain text, 
graphics, charts, and other data types.

Slide Master: The Slide Master in a template is a slide that controls the formatting, text, and 
objects that appear on every slide in your presentation.

Speaker Notes: Speaker notes can be notes that you create for yourself, key points during a 
presentation, additional information for your audience. 

2.15. Model Questions:
1. What are the features of PowerPoint?

2. What is a Slide? Explain the procedure to create a Slide?

3. What is Slide Master? Write the procedure to create Slide Master?

4. Explain the procedure to create Header and Footer in PowerPoint?

5. Explain the views available in PowerPoint?

2.16. References:

RON MANSFIELD, ‘Working with MS OFFICE’, Tata Mc Graw Hill – 2000 Edition

GUY HART DAVIS, ‘The ABC’S Of Microsoft Office.‘ BPB Publications, New Delhi

MS OFFICE 2000 Complete, BPB Publications, New Delhi 
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UNIT - II

Microsoft PowerPoint

2.0 Objective:
This lesson introduces the Drawing Objects, Images and ClipArt, Audio and Video, Slide 
Transition, Rehearse Timings and Charts.

Structure of the Lesson:

22..11 WWoorrkkiinngg wwiitthh TTeexxtt

22..22.. DDrraawwiinngg OObbjjeeccttss

22..33 IImmaaggeess aanndd CClliipp AArrtt

22..44 AAuuddiioo aanndd VViiddeeoo

22..55 CCrreeaattiinngg HHyyppeerrlliinnkkss

22..66 AAnniimmaattiinngg tthhee pprreesseennttaattiioonnss

22..77 SSlliiddee MMiinniiaattuurree

22..88 SSlliiddee TTrraannssiittiioonn

22..99 SSlliiddee SShhooww AAnniimmaattiioonn

22..1100 RReehheeaarrssee TTiimmiinnggss

22..1111 SSlliiddee SSeettuupp aanndd PPrriinnttiinngg

22..1122 CChhaarrttss
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22..1133 SSuummmmaarryy

22..1144 TTeecchhnniiccaall TTeerrmmss

22..1155 MMooddeell QQuueessttiioonnss

22..1166 RReeffeerreenncceess

2.1. Working with Text:
Any time you wish to make formatting changes to text, you must highlight the text to be 
changed. Making a selection from the Text Toolbar affects the highlighted text only. In addition 
to the standard text formatting tools of font choice and size, bold, italics, and underline, you also 
can align text left, center, or right. Other special tools are described below.

Shadowed Text

The Shadow Text Tool places a slight shadow behind the text. Although the effect is not 
prominent, this is an excellent tool to use to give more definition to title text. You should NOT 
shadow all body text since this makes it very "muddy" to read.

Sample Shadowed Text

To shadow text,

1. Type the text to be shadowed.

2. Highlight the text.

3. Click the Shadow Tool. 

Increase / Decrease Paragraph Spacing

The Increase and Decrease Paragraph Spacing Tools expand and contract paragraph 
spacing, respectively. 

Format Painter

The Format Painter Tool picks up any formatting applied to existing text and applies that 
same formatting to any text it is "painted" over. The two pieces of text need not  be on the same 
slide.

To use the Format Painter,

1. Highlight the text containing the formatting you desire to "pick up".
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2. Click the Format Painter Tool.

3. Press and drag over the text as you would to highlight it. The formatting will be 
applied. 

After the formatting is applied the Format Painter will de-select.
To apply formatting to multiple selections of text without needing to click the Format Painter 
between each application, double click the Format Painter. The Painter will remain the selected 
tool until you click it to de-select, allowing you to press and drag over multiple sections of text, 
applying the same format to each.

Increase/Decrease Font Size

You can increase or decrease the font size of highlighted text by clicking on the 
Increase Font Size or Decrease Font Size Tool, respectively. Size increments and 
decrements by the standard font sizes.

Text Colors

You choose text colors with the Font Color Tool located in the Drawing Toolbar. 
Highlighted text will change to the color displayed in the band beneath the A.

To make additional color choices or to see additional non-scheme colors you have used in this 
presentation, click the drop-down arrow beside the A.

Font Color Choices

Word Wrap

Whether text is in a Placeholder or a textbox, you can narrow or widen the width of the box by 
dragging the box border. This affects where the text wraps. Make sure the cursor looks like a 
two-headed arrow to affect the Placeholder width; a four-headed arrow will move the 
placeholder.

2.2. Drawing Objects:
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To draw a line, an arrow, a square, or a circle, select the appropriate tool from 
the Drawing Toolbar. When you move the cursor over the slide, it will be a crosshair. Press and 
drag the cursor to insert the object. The larger an area you drag, the larger the object will 
become.

TIP: To draw a straight line or arrow, or a perfect square or circle, hold SHIFT as you press and 
drag.

Selecting

To alter any PowerPoint object, you first must select the object. When you click the object, you 
will see Handles around the perimeter of the object. This lets you know exactly which object you 
will be affecting.

Sample Handles

Deleting

To delete an object, click to select it, then press DELETE.

Fill Colors

When you draw solid objects (squares and circles), they fill with the automatic color. The 
underline under the Paintbucket is the current fill color.

To fill an object with the current fill color, select the object, then click the Paintbucket 
Tool.

To change the current fill color, drop down the arrow beside the Paintbucket and make a new 
selection. There are also additional options under Fill Effects, including choosing no fill color at 
all.
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                                   Alternate Choices for Fill Colors

Fill Effects

Fill effects include Gradients where you can select one or two colors of your choice, as well as 
the direction and variants of the gradient. Textures are image files similar to web page 
wallpapers; you can use PowerPoint's selections or choose an image file from your workstation. 
Patterns allow you to choose two colors and the pattern design with which you want to fill the 
object. Picture allows you to choose an image file from your workstation; the photograph will 
center itself within the selected object, hiding any parts of the image, which do not automatically 
show within the object's shape.

Gradients

Textures
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Patterns
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Photos

Line Effects

Each drawing object has an outline the color of the automatic color. The underline under 
the Line Color Tool is the current line color. To outline an object with the current line color, 
select the object, then click the Line Color Tool.

To change the line color, drop down the arrow and make a new selection. Other options with the 
Line Color Tool include color and patterns similar to the Fill Tool.

To change line style, dash style, and arrow style, click on these tools, respectively, 
after drawing the object and while it is still selected.

Object Effects

To place a shadow or 3D effect on an object, select the object, then click the tool 
selection.

AutoShapes and WordArt

If you're not particularly artistic, AutoShapes and WordArt can come to the rescue. To use 
AutoShapes,

1. From the Drawing Toolbar, click the drop-down arrow beside AutoShapes, and then 
select the shape type.



                        Fundamentals of IT                2.55                                                             
UNIT-I

2. Click the shape you want. The cursor will change to a cross-hair as you move the 
mouse across the slide.

3. Click on the slide where you want to place the shape.

4. Move the object, change its size or color, as desired. 

Autoshapes Tool

To use WordArt,

1. Click the WordArt Tool.

2. From the WordArt Gallery, click the design you want, then click OK. 

WordArt Gallery
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3. In the Edit WordArt Text box, type your text. You can also change the font face and 
type size, or add bold or italics. Then click OK. 

The art will be placed in the center of the slide and is  always smaller than you would like—
press and drag the handles to enlarge the object to the desired size.

Many of the WordArts also have one or more small yellow diamond-shaped handles. You can 
press and drag any of these to distort the shape of the object:

Samples of Word Art

To change the colors in WordArt, make sure the object is selected, then choose FORMAT: 
WordArt and make your selections.

Text Tool

To insert text on the slide other than in a Placeholder

1. Click the Text Tool.

2. Press and drag the cursor over the slide to create a Text Box.

3. Type in the box. 

NOTE: Any text you type in a placeholder will show in Outline View; text inserted via the Text 
Tool is treated as an object and will not display in the outline.

Moving

To move an object on the slide, select it, then move the cursor over the object until you see the 
four-headed arrow along with the cursor. Press and drag the object to the location you need it.

NOTE: Be sure it is a four-headed arrow rather than a two-headed arrow. Two-headed arrows 
re-size objects.
To move a text box, select it, then move the cursor over the frame until you see the four-headed 
arrow along with the cursor. Press and drag the text box to the location you need it. If you move 
the cursor within the box, it will change to an insertion point so that you can type or edit text.

Rotating

To rotate any object, including a text box,

1. Click the Rotate Tool.
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2. Click the object to be rotated.

3. You will see small green disks in place of the normal handles on the object. 

Sample Rotated Text

4. As you move the cursor over the disk, it will change to a looped circle. Position the 
loop over one of the green disks and press and drag to the desired rotation.

5. Click the Rotate Tool to deselect it. 

Grouping and Ungrouping

Often after you have created multiple objects and layered them in the sequence you need, you 
want them to "stay put". By grouping multiple objects, you can move or resize them as a single 
entity rather than manipulating their individual components.

To group multiple objects:

1. Size each individual object as necessary.

2. Layer objects as necessary.

3. Each object must be selected prior to grouping. To select multiple objects, hold SHIFT 
then click each object. Each object clicked becomes selected and the handles of each 
are displayed. Release SHIFT after you have selected each of the objects to be 
grouped.

4. From the Drawing Toolbar, choose DRAW : Group. You will see that the objects' 
individual handle-sets will be combined, leaving a single handle-set for the grouped 
object. 

Sometimes, if your object is very complex, you will find it beneficial to group your object 
components incrementally. When you finish a subset of your final object, group the components 
you have finished. Then you can continue building additional components, knowing you won't 
accidentally move or re-size the portion you have completed.

Text that you include in a grouped object will not change point size if you re-size the grouped 
object, however, word-wrapping may adjust to conform to the re-sizing.

To manipulate individual components of grouped objects, you must ungroup them. To ungroup 
an object, select it, then from the Drawing Toolbar, choose DRAW : Ungroup. After editing, you 
can choose Re-group.
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2.3. Images and Clip Art:

PowerPoint comes with a library of "clip art" that includes traditional clip art, as well as videos, 
photographs, and sounds. You can also insert graphics from other sources into a presentation.

To access PowerPoint's ClipArt Gallery, click the ClipArt Gallery Tool (located on the 
Drawing Toolbar).

To use a Gallery ClipArt image, in the Insert ClipArt dialog box, select the category pertaining to 
the type of image you are looking for, then select the image you want. A pop-up box will allow 
you to: insert the image, preview the clip, add the clip to a different category, and/or find similar 
clips.

Insert ClipArt Dialog Box

The greatest benefit of the ClipArt Gallery is that you can add multiple selections to your 
presentation without leaving the Gallery.

ClipArt images will be inserted in the center of the slide. You can move, enlarge, or reduce 
them.

To select multiple objects using the mouse,

1. Position your mouse cursor beyond the corner of the object to be re-grouped. Make 
sure you start far enough beyond the objects to catch all of the components.

2. Press and drag diagonally across the objects to select all the components. Make sure 
that you do not accidentally include an object in the selection that you do not want to 
be selected. (You may have to try this step several times, it is a bit tricky to master.)
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3. After all the components are selected, from the Drawing Toolbar, choose DRAW : 
Group (or Regroup). 

2.4. Audio and Video:
Your presentation can link to external audio and video files.

 Select the slide on which you wish to add a link to an audio or video file. 

 On the Insert menu, point to Movies and Sounds. 

 To insert a sound from a file, click Sound from File. To insert a video from a file, click 

Movie from File.

 A standard file directory window appears. 

 Locate the folder that contains the audio/video file you want, and then double-click the 
filename.
Note: In PowerPoint, by default your movie or sound will play manually. If you want it to 

play automatically you will have to set Custom Animation options for the slide. 

 For audio files, a sound icon appears on the slide. 

 For movies, an image consisting of the first frame is displayed as a placeholder. 

 To preview the audio/video in Normal view, double-click its icon. 

Note: Alternatively, you may have to use the Insert / Object command since PowerPoint is not 
able to play all audio/video formats inline. Insert / Object will open the media element in a new 
window rather than making it appear embedded on the slide, and it will be played by an external 
program.

2.5. Creating Hyperlinks:
Hyperlinks cause the selection of an object to result in a move to a new location or the 
performance of an action. You can create your own object or choose an AutoShape Action 
button.

To link an object with an action, select the object, then choose SLIDE SHOW: Action Settings.

In the Action Settings dialog box, choose either Mouse Click or Mouse Over. Then select the 
button "Hyperlink to" then select the destination or action. You can also choose to play a built-in 
PowerPoint sound during this action and/or to highlight the object as you click it.
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Hyperlink Action Dialog Box

2.6. Animating the Presentation:

To animate a single object on a PowerPoint slide

1. Select the object.

2. Choose SLIDE SHOW: Preset Animation.

3. Select the animation effect you desire for the selected object. 
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Preset Animation Dialog Box

Animated Layers or Slides

You may find it useful to bring a layered object into a presentation one layer at a time, building it 
on-screen. To animate a layered object or to animate each object on a slide

1. Choose SLIDE SHOW: Custom Animation. (You must be in Normal, Outline, or Slide 
View.)

2. In the Custom Animation dialog box, each object is identified in the Check to animate 
slide objects list.

If you don't remember what a particular object is, click the object's name in the list; 
that object appears selected in the preview window.

3. Click in the object's checkbox to animate that object. It will be added to the Animation 
order list.

4. To change the order that the animated objects appear, select the object in the 
Animation order list, then click the up or down arrow to move the object through the 
list.

5. Choose whether the object appears only on a mouse click or after a specified number 
of seconds. 

Layer Animation Dialog Box
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To choose other effects such as sound effects and how the object appears on the slide during 
the on-screen presentation, click on the Effects tab.

To animate text,

1. Click on the Effects tab.

2. In the Introduce Text section, from the drop-down box, choose whether the text is 
introduced all at once, by word, or by letter. 

To animate charts click the Chart Effects tab. You can choose to introduce the data by series, 
categories, or elements.

NOTE: Be careful of using too many effects in any single presentation because they soon 
become detraction to rather than an enhancement of the presentation.

2.7. Slide Miniature:
When you have zoomed the view of your slide so that all of the slide cannot be seen on the 
screen at one time, PowerPoint will create a black and white Slide Miniature in the corner. This 
allows you see the overall effects of the changes you are making to the slide.

Sample Slide Miniature

You may also choose to work in black and white mode by choosing VIEW: Black and White. To 
see a small color view of the current slide when you are working in black and white, choose 
VIEW: Slide Miniature.

2.8. Slide Transitions:
Transitions determine the effects applied when you move from one slide to another 

during an on-screen presentation. You must be in Slide Sorter View to access the Transition 
Toolbar.

To choose only a transition effect, click the dropdown box beside the words "No Transition" and 
select a transition. To have other transition choices available to you, click the Slide Transition 
Tool.
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Sample Transition Tool and Drop-down Box

When you click the Slide Transition Tool, the Slide Transition dialog box allows you to choose 
not only a transition effect from a drop-down box, but also offers other choices that affect your 
on-screen presentation.

Sample Transition Dialog Box

TIP: Do not use a different transition on each slide because your audience attention should 
remain focused on you and the content, not the effects. If you want to use multiple transitions, a 
good rule of thumb is to apply a unique transition to each slide in a specific module of the 
presentation.

Generally, you should leave the Effect Speed set to Fast. This brings in the next content slide 
quickly and keeps your audience's attention focused on the presentation content.

PowerPoint contains a few built-in sounds. To play a sound as the slide is transitioning, make a 
sound selection from the Sound drop-down box. Unless you have a well thought out reason for 
doing so, do not choose to have the sound loop until the next sound; it can become annoying 
very fast while you are giving a presentation, as well as making it difficult for you to speak over. 
Also, many presentation locations do not have adequate speakers attached to the computer to 
allow all of your audience to hear the sound.

 In Slide or Slide Sorter view, select the slide or slides on which you want to add a 
transition. 

 On the Slide Show menu, click Slide Transition.

 From the Effect drop-down list, click the transition 
you want. 



Acharya Nagarjuna University 2.64 Centre for Distance Education

64

 Select any other options you want (speed Slow/Medium/Fast, Advance on mouse Click 
or Automatically, Sound or No Sound) 

 To apply the transition to the selected slide, click Apply. To apply the transition to all the 
slides, click Apply to All. 

 Repeat the process for each slide you want to add a transition to. 

 To view the transitions, on the Slide Show menu, click Animation Preview.

2.9. Slide Show Animation:

You can control how and when text, graphics, and other objects appear on your 
PowerPoint slides. For example, you can make graphics or text items appear one at a time and 
add visual or sound effects. Animation can aid in focusing attention during a presentation and 
make your slide show more interesting. To set slide show animation options, display the slide 
that has the objects you want to animate, then on the Slide Show menu, click Custom 
Animation. 
Timing Tab 

 In PowerPoint, ensure that you are on the Timing tab. 

 Under Slide objects without animation, double-click the objects you want to animate.
(they should be moved up to the Animation Order box). 

 Use the up and down arrows to the right of Animation Order to change the sequence in 
which objects will appear (move objects up or down in the list). 

 Under Start Animation set the timing (when objects will appear). Select each object and 
then do one of the following: 
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o To start the animation by clicking the object, select the On mouse click option. 

o To start the animation automatically, select the Automatically option, and then 
enter the number of seconds you want to have elapse since the previous 
animation. 

Effects Tab  

 Click the Effects tab to set options for visual or sound effects. 

 Under Entry animation and sound select the options you want. 

 To preview the animation effects, click the Preview button. 

 In the example above, the object will enter the screen with a Spiral animation and the 
Chime sound will play.

Animating a text box containing bulleted text 

 On the Order & Timing tab, the text box is selected with a check mark, and the On 
mouse click option is chosen (to let the presenter control the slide show with mouse 
clicks). 
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 On the Effects tab, the options set below will make each line of text enter the screen 
with a Fly From Left animation, No sound will play, and when the next line of text 
appears the previous line will change to a lighter color (a dimming effect). To preview 
the animation effects, click the Preview button. 

The series of images below show what the screen looks like after each mouse click when the 
slide with the bulleted text (set with options as above) is displayed during a Slide Show. Notes 
that the previous text points are dimmed as each subsequent line appears.
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2.10. Rehearse Timings:

The Rehearse Timing Tool allows you to practice giving an on-screen presentation, 
regardless of any slide advance timings you may have set previously. The tool sets time not 
only for the entire presentation, but also each individual slide, as you rehearse. Each time you 
advance the slide, the time is recorded. You must be in Slide Sorter View to access the 
Rehearse Timing Tool.

Sample Recorded Rehearsal Timings

To use the Rehearse Timing Tool, click the Rehearse Timing Tool.
When you have completed rehearsing, PowerPoint displays the total time for the rehearsed 
presentation and asks if you want to record the new timings. If you click "Yes", these new 
timings will replace any slide advance timings you may have previously set for the presentation.

Sample New Timings Dialog Box

Before you print your slide presentation, make sure the slide size and orientation is correct. 
Also, decide whether you want to print in color or black and white.

Change these settings using the Page Setup and Print commands on the File menu. 

Slide Setup

The Slide Setup dialog box has controls for slide size and orientation. Choose the appropriate 
slide size and orientation before you do significant formatting in your presentation. Changing 
slide orientation from portrait to landscape or vice versa may require editing and reformatting 
slides.

Printing

To print your slide presentation, choose Print from the File menu, or click the Print button on the 
toolbar. In the Print dialog box you can choose how many copies you want to print. Use the 
Print What: drop-down list to select whether you want to print just the slides, notes, or handouts 
with multiple slides per page.
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2.12. Charts:

To insert an organization chart (depicts hierarchical relationships): 

 First display the slide on which you want the chart to appear. 

 On the Insert menu, point to Picture, and then click Organization Chart. 

 A separate Microsoft Organization Chart window appears. 

 Use the buttons at the top of the Organization Chart window to add text boxes to your 
chart (above, below, or beside existing boxes). 

 Click your mouse inside a box to edit the text inside of it. 

 As shown in the example below, you can use this type of chart for almost any type of 
information you want, not just managers, workers, and other positions within a company. 

To create a bar or pie chart (or similar chart based on numbers in a datasheet): 

 First display the slide on which you want the chart to appear. 

 On the Insert menu, click Chart - or click the Insert Chart button on the PowerPoint 

toolbar.

 A sample chart and datasheet (spreadsheet) appear on the screen as shown below. 

 To replace the sample data, click a cell on the datasheet, and then type the information 
you want. 

 To change the chart type, on the Chart menu, click 
Chart Type. In the Chart Type window, which 
appears, click on the desired Chart type and sub-
type and then click the OK button. 

 To return to PowerPoint, where you can move and 
size the chart, click outside the chart on the 
PowerPoint slide. 
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 If you wish to re-edit the chart, double-click the chart on 
the PowerPoint slide.

2.13. Summary:
At the end of this lesson you have learnt how to insert and format text, working with the pictures 
and inserting images into a slide.   The concept of Slide transition, Slide animation, Rehearse 
timings allows you to automatically move  to next slide without manual interaction.   A layman 
can also know more about the data results with the help of charts.

2.14. Technical Terms:
Hyperlink: Hyperlinks cause the selection of an object to result in a move to a new location 
or the performance of an action.

Slide Transition: Slide Transition determine the effects applied when you move from one 

slide to another during an on-screen presentation.

Slide Show Animation: Slide Show Animation can aid in focusing attention during a 

presentation and make your slide show more interesting.

Rehearse Timings: The Rehearse Timing Tool allows you to practice giving an on-screen 
presentation, regardless of any slide advance timings you may have set previously.

Slide Setup: The Slide Setup controls for slide size and orientation. 

2.15. Model Questions:
1. Explain the procedure to draw the objects in PowerPoint?

2. Define Hyperlink? Explain the procedure to create Hyperlinks in PowerPoint?

3. What is a Slide Miniature?

4. Define Rehearse Timing? Explain the procedure to set the rehearse timings to 
slides?

2.16. References:
RON MANSFIELD, ‘Working with MS OFFICE’, Tata Mc Graw Hill – 2000 Edition

GUY HART DAVIS, ‘ The ABC’S Of Microsoft Office. ‘ BPB Publications, New Delhi

MS OFFICE 2000 Complete, BPB Publications, New Delhi 
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Fundamentals of IT 3.1 UNIT-III

UNIT - III

Microsoft Access
3.0  Objective:
This lesson provides an introduction to the fundamentals of Microsoft Access. It covers starting MS-
Access, creating Data bases, Tables, Queries, Forms, Reports, and Relational Data Bases.

Structure of the Lesson:

33..11 MMiiccrroossoofftt AAcccceessss IInnttrroodduuccttiioonn
33..22 SSttaarrttiinngg MMiiccrroossoofftt AAcccceessss

33..33 CCrreeaattiinngg aanndd ooppeenniinngg DDaattaa bbaasseess

33..44 TTaabblleess

33..55 QQuueerryy

33..66 RReellaattiioonnaall DDaattaa BBaasseess

33..77 FFoorrmmss

33..88 RReeppoorrttss

33..99 SSuummmmaarryy

33..33..TTeecchhnniiccaall TTeerrmmss

33..33..MMooddeell QQuueessttiioonnss

33..33..RReeffeerreenncceess

3.1. Microsoft Access:
Microsoft Access is a powerful program to create and manage your databases. It has many 

built in features to assist you in constructing and viewing your information. Access is much more 
involved and is a more genuine database application than other programs such as Microsoft 

Works. 

Database File: This is your main file that encompasses the entire 
database and that is saved to your hard-drive or floppy disk. 

Example studentDatabase.mdb

Table: A table is a collection of data about a specific topic. There can be 
multiple tables in a database. 
Example #1) Students 
Example #2) Teachers
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Field: Fields are the different categories within a Table. Tables usually contain multiple fields. 

Example #1) Student LastName 
Example #2) Student FirstName

Data types: Data types are the properties of each field. A field only has 1 data type. 

3.2. Starting Microsoft Access:

Starting Microsoft access in two ways.  

1. Double click on the Microsoft Access icon on the desktop. 

2. Click on Start --> Programs --> Microsoft Access 

3.3. Creating New and Opening Existing Databases:

If you start MS Access a window will appear as below. 
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The above Window gives you the option to: 

 Create a New Database from scratch 

 Use the wizard to create a New Database 

 Open an existing database

 The white box gives you the most recent databases you have used. If you do not see the 
one you had created, choose the More Files option and hit OK. Otherwise choose the 
database you had previously used and click OK. 

Create a database using the Database Wizard 

1. When Microsoft Access first starts up, a dialog box is automatically displayed with options to 
create a new database or open an existing one. If this dialog box is displayed, click Access 
Database Wizards, pages, and projects and then click OK. 

If you have already opened a database or closed the dialog box that displays when 
Microsoft Access starts up, click New Database on the toolbar. 

2. On the Databases tab, double-click the icon for the kind of database you want to create. 
3. Specify a name and location for the database. 
4. Click Create to start defining your new database 

Create a database without using the Database Wizard 

1. When Microsoft Access first starts up, a dialog box is automatically displayed with options to 
create a new database or open an existing one. If this dialog box is displayed, click Blank 
Access Database, and then click OK. 

If you have already opened a database or closed the dialog box that displays when 
Microsoft Access starts up, click New Database on the toolbar, and then double-click the 
Blank Database icon on the General tab.

2. Specify a name and location for the database and click Create. (Below is the screen that 
shows up following this step).
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3.4. Tables:

A table is a collection of data about a specific topic, such as students or contacts. Using a separate 
table for each topic means that you store that data only once, which makes your database more 
efficient, and reduces data-entry errors. 

Tables organize data into columns (called fields) and rows (called records). 
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Create a Table from scratch in Design view 

1. If you haven't already done so, switch to the Database Window You can press F11 to switch 
to the Database window from any other window. 

2. Double-Click on "Create table in Design view". 
(DESIGN VIEW)
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3. Define each of the fields in your table. 

o Under the Field Name column, enter the categories of your table. 

o Under Data Type column, enter the type you want for your categories. 

 The attribute of a variable or field  determines the kind of data it can hold. For 
example, in a Microsoft Access database, the Text and Memo field data 
types allow the field to store either text or numbers, but the Number data 
type will allow the field to store numbers only. Number data type fields store 
numerical data that will be used in mathematical calculations. Use the 
Currency data type to display or calculate currency values. Other data types 
are Date/Time, Yes/No, Auto Number, and OLE object (Picture). 

o Under the Description column, enter the text that describes what your field is. (This 
field is optional). 

o For example

Primary Key 

 One or more fields (columns) whose value or values uniquely identify each record in a table. 
A primary key does not allow Null values and must always have a unique value. A primary 
key is used to relate a table to foreign keys in other tables. 

 In the above example, the Stdid # field the primary key, meaning that every student has a 
student identification number.

o To do this, simply select the Stdid # field and select the primary key button. 



Fundamentals of IT 3.7 UNIT-III

o After you do this, Save the table 

Switching Views 

 Views are two types. They are Design view and Datasheet view. You can select the views 
from view menu from menu bar.

Datasheet View Design View 

Displays the view, which allows you 
to enter raw data into your database 

table. 

Displays the view, which allows you to enter 
fields, data-types, and descriptions into your 

database table. 

Entering Data 

 Click on the Datasheet View and simply start "chugging" away by entering the data into 
each field. 


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Manipulating Data 

 Adding a new row

o Simply drop down to a new line and enter the information.

 Updating a record

o Simply select the record and field you want to update, and change its data with new 
contents 

 Deleting a record

o Simply select the entire row and hit the Delete Key on the keyboard 

3.5. Query:
Queries are questions about your database. You can design a query manually, specifying all of the 
tables and fields you wish to display on your screen, or you can use a Query Wizard to create 
simple displays in predefined formats.

QUERY WIZARD

Access  provides several query formats 

• simple - looks like the Table datasheet view

• crosstab – is similar to a spreadsheet with summary information inserted into the intersection of 
each row and column

• find duplicates – lists the records which have duplicate values in any specified  field

• find unmatched – compares two tables and identifies records, which do not have a match in a 
related table.

Using Query Wizard

From Database window:

• Click Query Tab

• Click New

• Select Query type from list (OK)

• Follow prompts:
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- select Tables / Queries (Next)

- select Fields (Next)

- create a Title

- click Finish.

In general, there are two types of query: Select and Action. A select query gathers, collates and 
presents information in usable forms. An action query makes changes in specified records of an 
existing table, or creates a new table. In this course, we will concentrate on select queries only. 

Sometimes, information is scattered in many tables. For example, customers' information is stored 
in Customers table while their ordering information is stored in Orders table. In order to retrieve 
information from more than one table, queries are used. Moreover, queries are capable of 
performing the functions of filters, namely adding selection criteria and sorting instructions. In 
addition, queries allow calculation of new fields.

In contrast to a filter, a query is reusable. When a table is closed, the selection criteria and/or 
sorting instructions will be lost. Therefore, in order to retrieve the same records again, the filter has 
to be recreated. However, a query allows the selection criteria and/or sorting instructions to be 
saved and reused. 

Create a Query

Find all the products under the category Beverages and the total costs for each of these products. 
In addition, you have to find the suppliers' information of these products. 

1. Click the Query button and then the New button in the Database window. 

2. Click New Query in the resulting dialog box to open the design window for a new query. 

3. From the Add Table dialog box, select Categories, Products and Suppliers tables. Click 
Close to close the Add Table dialog box. 
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4. Drag the Category Name and Description fields from the Categories field list to the first 
and second column in the grid. Then drag the Product Name fields from the Products field 
list to the third column. Finally, drag the * field from the Suppliers field list to the fourth 
column. 

5. In the fifth column of the grid, type Cost: [Unit Price]*[Units in Stock]*0.7. 

6. Select the Criteria row in the Category Name column and enter Beverages. 

7. Run the query by clicking the Run button (!) in the tool bar. 
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8. To print the result, choose Print command from the File menu. 

9. To save the query, choose Save command from the File menu. 

3.6. Relationships:

After you have set up multiple tables in your Microsoft Access database, you need a way of 
telling Access how to bring that information back together again. The first step in this process is to 
define relationships between your tables. After you have done that, you can create queries, forms, 
and reports to display information from several tables at once. 

A relationship works by matching data in key fields - usually a field with the same name in both 
tables. In most cases, these matching fields are the primary key from one table, which provides a 
unique identifier for each record, and a foreign key in the other table. For example, teachers can be 
associated with the students they're responsible for by creating a relationship between the 
teacher's table and the student's table using the TeacherID fields.  Having met the criteria above, 
follow these steps for creating relationships between tables. 

1. In the database window view, at the top, click on Tools ---> Relationships 

2. Select the Tables you want to link together, by clicking on them and selecting the Add 
Button 

3. Drag the primary key of the Parent table (Teacher in this case), and drop it into the same 
field in the Child table (Student in this case.)
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4. Select Enforce Referential Integrity

o When the Cascade Update Related Fields check box is set, changing a primary key 
value in the primary table automatically updates the matching value in all related 
records. 

o When the Cascade Delete Related Records check box is set, deleting a record in 
the primary table deletes any related records in the related table 

5. Click Create and Save the Relationship 
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2.7. Forms:

A form is nothing more than a graphical representation of a table. You can add, update, and delete 
records in your table by using a form.

A form is very good to use when you have numerous fields in a table. This way you can see all the 
fields in one screen, whereas if you were in the table view (datasheet) you would have to keep 
scrolling to get the field you desire. 

Create a Form using the Wizard 

It is a very good idea to create a form using the wizard, unless you are an advanced user and know 
what you are doing. Microsoft Access does a very good job of creating a form using the wizard. The 
following steps are needed to create a basic form: 

1. Switch to the Database Window. You can do this by pressing F11 on the keyboard. 

2. Click on the Forms button under Objects on the left side of screen. 

3. Double click on Create Form Using Wizard

4. On the next screen select the fields you want to view on your form. Most of the time you 
would select all of them. 

5. Click Next. 

6. Select the layout you wish. 

7. Click Next. 

8. Select the style you desire. 

9. Click Next. 

3.Give you form a name, and select Open the Form and enter information.

3.Select Finish.

3.You should see your form. To adjust the design of your form, simply hit the design button 
(same as with the tables), and adjust your form accordingly.

3.8. Reports:

A report is an effective way to present your data in a printed format. Because you have control over 
the size and appearance of everything on a report, you can display the information the way you 
want to see it. 

Create a Report using the Wizard 

As with the Form, it is a very good idea to create a report using the wizard, unless you are an 
advanced user. Microsoft Access does a very good job using the wizard to create reports. 
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1. Switch to the Database Window. You can do this by pressing F11 on the keyboard. 

2. Click on the Reports button under Objects on the left side of screen. 

3. Double click on Create Report Using Wizard.

4. On the next screen select the fields you want to view on your form. Most of the time you 
would select all of them. 

5. Click Next. 

6. Select if you would like to group your files. Keep repeating this step for as many groupings 
as you would like. 

7. Click Next. 

8. Select the layout and the paper orientation you desire. 

9. Click Next. 

3.Select the style you desire.

3.Click Next. 

3.Give you report a name, and select Preview the Report.

3.Select Finish.

14.You should see your report. To adjust the design of your report, simply hit the design button, 
and adjust your report accordingly.

3.9. Summary:
At the end of this lesson you have learnt what is a database, which contains Tables, 

Queries, Forms and Reports. Table is a collection of data to a specific content which contains some 
rows and columns. You have learnt the procedure how to create tables and Queries. Queries are 
questionnaires to a database. A form is nothing more than a graphical representation of a table. 
You can add, update, and delete records in your table by using a form. Reports are used to present 
your data in a printed format. 

3.3. Technical Terms:

Database: A database is a collection of information stored in a computer in a systematic way, 
such that a computer program can consult it to answer questions.

Table: A table is a collection of data about a specific topic, such as students or contacts.

Primary Key: Primary Key is a field or whose value or values uniquely identify each record in a 
table.

Query: Queries are questionnaires to a database.

Form: A form is nothing more than a graphical representation of a table.
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Relationship: Relationship is used to bring the information back together again.

Report: Reports are used to present your data in a printed format.

3.3.  Model Questions:

1. Explain about the creation of databases in MS-Access.
2. Explain the procedure to create a Table with an example?
3. Define a Query? Explain the procedure to create query-using relationships?
4. Explain different data types in MS-Access. 
5. What is a Primary Key?
6. What is a Form? Write the procedure to create a form in different ways?

3.3. References:
RON MANSFIELD, ‘Working with MS OFFICE’, Tata Mc Graw Hill – 2000 Edition

GUY HART DAVIS, ‘ The ABC’S Of Microsoft Office. ‘ BPB Publications, New Delhi

MS OFFICE 2000 Complete, BPB Publications, New Delhi 
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UNIT-III

  Microsoft Excel

Objectives:
This lesson introduces the basic features of Microsoft Excel, a spreadsheet 

program, entering and editing data, formatting, formulas, page setup, and printing 
spreadsheets.

Structure 
3.1      Excel Features

3.2    Starting Microsoft Excel

3.3. Formula Bar

3.3   Working with Excel 

3.4 Entering and Editing Data

3.5 Row and Column Headings

3.6 Auto Fill

3.7 Custom Fill Lists

3.8 Row or Column Size

3.10.Inserting Rows and Columns

3.3.References

3.3.Charts

3.3.Summary

3.14.Technical Terms

3.15.Model Questions

3.16.References

3.1. Features of Excel:
Answer Wizard: Like word, excel has a new feature called answer wizard.  It uses “IntelliSense” to 
determine what kind of work you need, based upon your questions.

Autocalc: When we selected a group of numbers, the sum automatically appears on the status 
area.  We can see average, count the numbers by right clicking on the status area. 

Auto Complete: Auto complete will try to figure out what you intend to type, based upon the 
entries you have already made.

Auto Correct: Excel can automatically correct the mistakes. It will not allow two consecutive initial 
caps, capitalizing names of days and so on.  You can create your own auto correct entries.
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Drag And Drop: Like other office features we can drag and drop the group of cells using mouse. 
We can drag the specified portion of from one worksheet to other.

Cell tips and Scroll Tips: When you touch the scroll bar it will display the row and column number 
that you are heading for. This is great for large worksheets.  You can use Cell tips to read notes 
you’ve made for yourself in cells.

Data Map: It is having a data map feature.   We can make maps of different regions in different 
countries.  This can be quite impressive in presentations.  This can be helping you in our business 
matters.

Easier retrieval of Documents: It has greatly streamlined file management. It can quickly find 
worksheets and you can easily delete or rename files from the open dialog box.

Number Formatting: It is easy to format the numbers with Excel’s new number-formatting feature.  
There are many types of formats here like telephone numbers, dollar amounts, and dates. 

Templates and Wizards: A variety of templates (predefined) formats available with excel for use in 
business organizations. We can have a template wizard to link database with worksheets.  If we 
made changes in the worksheet, automatically database updated.

3.2. Starting Excel:
On the PC, select Start, Programs, and Microsoft Excel from the Start list. 

Components of the Excel Window
Besides the usual window components (close box, title bar, scroll bars, etc.), an Excel window has several 
unique elements identified in the figure below:
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3.3. Formula Bar:

3.4. Formula Bar:
In addition to the other toolbars the formula bar is located under the formatting toolbar at the top of 
the Excel worksheet. Use the formula bar to enter and edit worksheet data.

The contents of the active cell always appear in the formula bar. When you click the mouse in the 
formula bar, an X and a check mark appear. You can click the check icon to confirm and complete 
editing, or the X to abandon editing.
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3.5. Working with Excel:

Opening and Closing worksheet

To open an existing Excel workbook, choose Open from the File menu or click the Open tool on 
the toolbar.  Excel will display the Open dialog box, which is similar in appearance and function to 
the Save As dialog box. It contains a File Name: box for you to type a file name.

To open a file, select the appropriate location by clicking on the down pointing arrow next to the 
Look In: selection box. Excel will display all Excel files found there. Select the file you wish to open 
and click Open to open the file.

Saving a worksheet
To save an untitled Excel workbook, from the File menu choose Save As or click the Save button 
on the toolbar.  The Save As dialog box contains a text box for you to type a specific filename, a 
"Save File as Type:" box to save your workbook in a different format that other programs can read, 
a selection box to designate the folder and drive in which to save the file, and a "Places Bar" that 
offers other locations to save your file.
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Creating a New Workbook
If you are already in Excel and you want to create a new workbook, choose New from the File 
menu or click the New tool on the toolbar.

Managing Multiple Workbooks

Excel enables you to have more than one workbook open simultaneously. Each open workbook 

appears on the Window menu. The document with the check next to it is the active document. To 

switch to another document, simply choose that document from the Window menu.  To navigate 

between worksheets within a workbook, click the worksheet tab you want to activate. Double-click a 

worksheet tab to change its name.

3.6. Entering and Editing Data:

Entering Data

You can enter text, numbers and dates in an Excel worksheet. In Excel¹s terminology, numbers 
and dates are called values and text is referred to as a label. To enter data of any type, click on 
the cell you want to contain that data, and then type the information you want in the cell. When you 
begin typing, your data also appears in the formula bar. When you have finished typing the data for 
the active cell, press the Return or Enter key.

Editing Data

The easiest way to edit the contents of a cell is to select the cell and then retype the entry. The new 
entry replaces the old contents. For example, to change the number in cell C8 to 123, select cell 
C8, type 123 and press Return. This method works well with numbers, but is more difficult when 
editing long text labels or formulas.

The formula bar gives you more flexibility while editing. When the mouse pointer moves into the 
formula bar, it changes shape to an I-beam, signifying that you can enter or edit text. Text in the 
active cell appears in the formula bar and you can edit it there. Use the mouse to select the text 
you want to change in the formula bar and then type the new text. Excel automatically replaces 
what is selected. Don't forget to press the Return key when you finish editing a cell.
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You can also edit labels and values directly in cells. Double-click on the cell you want to edit. This 
puts an insertion point in the cell. Edit the contents of that cell.

Moving the Active Cell 

Cell selection and movement around the worksheet are similar operations in Excel. To select a 

given cell or make it active, simply click on that cell. Use the mouse or the arrow keys to move 

around the worksheet. For example, if you press the right arrow key twice you move two cells to the 

right.

Name box

The Name box displays the reference of the selected cells.

3.6. Row and Column Headings:
Letters and numbers identify the rows and columns on an Excel worksheet. The intersection of a 
row and a column is called a cell. Use row and column headings to specify a cell's reference. For 
example, the cell located where column C and row 8 intersect is called C8.

Active cell

The active cell has a dark border around it to indicate your position in the worksheet. All text and 
numbers that you type are inserted into the active cell. Click the mouse on a cell to make it active.

Fill handle
The lower right corner of the active cell has a small box called a Fill Handle. Your mouse changes 
to a cross hair when you are on the Fill Handle. The Fill Handle helps you copy data and create 
series of information. For example, if you type Monday in the active cell and then drag the Fill 
Handle over four cells, Excel automatically inserts Tuesday, Wednesday, Thursday, Friday and 
Saturday.

Worksheet tabs
An Excel workbook consists of 3 worksheets by default. Use the worksheet tabs at the bottom of 
the screen to navigate between worksheets within a workbook.

Go To Command
A quick way to move a large distance on a worksheet is with the Go To command on the Edit 
menu. When you select the Go To command, a dialog box prompts you to identify the cell. Enter 
the cell reference and click OK or press Return.
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Clearing Cell Contents
To clear the contents of a cell choose Clear from the Edit menu. Then, select what you want to 
clear from the cell: All, Formats, Contents, or Notes. Most frequently you will want to clear the 
Contents of a cell. Pressing the Delete key also clears the contents of cells.

Undoing Mistakes

If you make a terrible mistake and you accidentally delete important data. Use the Undo command 
on the Edit menu or the Undo tool to correct the mistake.

Copying and Moving Data

Copy selected data from one cell to another with the Copy and Paste commands, or with the Drag 

and Drop procedure. If you want to move data use the Cut and Paste commands, or the Drag and 

Drop procedure.

Drag and Drop 

This procedure does not involve the Clipboard and works best when moving data a short distance. 
To move cells, position the mouse on the cell borders. Wait until the mouse pointer changes to a 
left-pointing arrow then press and drag the data to the new location.

3.7. Auto Fill:
A series of numbers, month’s names or week names can be filled automatically in Excel. 

For doing this simply type the first word in a cell then place the mouse pointer on the fill handle and 
then drag it either horizontally or vertically so that Excel fills the data automatically.

3.8. Custom Fill Lists:
Excel providing a facility to create our own fill lists we can create our college courses, names, a 
series of your colleague’s name.  These are the steps to create custom lists.

 Select Tools/Options.
 Click on custom lists.
 Click on New list on custom area.
 Type your list of entries in list entries area. 
 Select add button.
 Your new list will be created.
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3.9. Row or Column Size:
The height of a row or the width of a column can be changed to any desired value.

Row height

Select the row, which you want to increase the height, select Row from format menu. Specify the 
value. Then automatically the height of the Row increases. 

                                      Or
Select the row, then place the mouse pointer on the bottom boarders of the row then the mouse 
pointer changes. Press left mouse button and drag the mouse downwards until the desired row 
height reaches.

Column Height

Select the Column, which you want to increase the width. Select Column from format menu.
Specify the value. Then automatically the width of the column increases.

                                                Or
Select the column, then place the mouse pointer on the top boarders of the column then the mouse 
pointer changes. Press left mouse button and drag the mouse downwards until the desired column 
width reaches.

3.10. Inserting Rows and Columns:
Select Insert menu form menu bar and select row option. Then automatically the row will be 

inserted. Similarly select Insert menu from menu bar and select column option. Then automatically 
a column will be inserted.

3.11. References:

About cell and range references
A reference identifies a cell or a range of cells on a worksheet and tells Microsoft Excel where to 
look for the values or data you want to use in a formula. With references, you can use data 
contained in different parts of a worksheet in one formula or use the value from one cell in several 
formulas. You can also refer to cells on other sheets in the same workbook.

Relative reference

Relative cell references are references to cells relative to the position of the formula. When you 
create a formula, references to cells or ranges are usually based on their position relative to the cell 
that contains the formula. In the following example
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cell c2 contains the formula =A2*b2; Microsoft Excel finds the value one cell above and one cell to 
the left of c2. This is known as a relative reference. When you copy a formula that uses relative 
references, Excel automatically adjusts the references in the pasted formula to refer to different 
cells relative to the position of the formula. The formula in cell c2 =a2*b2, the formula has been 
copied to cell C3. Excel has adjusted the formula in cell C3 to =A3*b3, which refers to the cell i.e., 
one cell above and to the left of cell C3.

Absolute reference

Absolute references, which are cell references that always refer to cells in a specific location. If a 
dollar sign precedes the letter and/or number, such as $A$1, the column and/or row reference is 
absolute. Relative references automatically adjust when you copy them, but absolute references do 
not.                                   For example:
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The total amount is calculated by the formula rat*qty + vat. The fixed vat price has to be applied to 
all the transactions. Here we are applying absolute reference for the cell f2. i.e., $F$2.

Named reference

You can assign names to cells or ranges of cells. When you do that, you can use the names in your 
formulas. For example, if you had a column named QTY and a column named Price, you could 
create a formula like  = QTY * Price.

3.3. Charts:

Excel has features for preparing charts for the selected data in a worksheet. A chart can be drawn 
in the same worksheet in which data is available or can be drawn as a separate chart sheet. Chart 
sheets have again tabs in the tab area, which operates as worksheets tabs. All charts in Excel are 
available in chart wizard so that a chart can be prepared very easily by using this special chart 
wizard.
The Best Chart Types 

There are a lot of different chart types out there, and it can be confusing to work out just which 
chart type you need for a particular set of data. Some of the most common types of chart and their 
uses are explained below. The definitions of the charts remain the same no matter what operating 
system you use, or what spreadsheet program. 

Pie Chart Type 

Pie charts should only be used if you want to show proportions. This chart type emphasizes the 
relationship between the whole and each part of that whole. A good example of this would be to 
display data on what spreadsheet program is preferred by 100 of the top spreadsheet experts. 

Column/Bar Chart Type 

The bar chart is undoubtedly the king of all chart types. Its simplicity makes it so useful for a range 
of data types. It is the best chart type to use if you need to compare values. 

Scatter Chart Type 

Scatter charts (also known as XY-Scatter charts) can be used when you need to display two 
related sets of data on a chart, particularly if you want to make predictions based on the data. 

Line Chart Type 

Line charts should generally only be used where there is a period of time involved. These charts 
are perfect for displaying trends. For example, if you want to chart the increase in use of open 



Acharya Nagarjuna University

source spreadsheets during a 5
chart type. 

The first step to making our chart is to select the range of data to be charted. 

The Chart Wizard can be started by using the 
(left) or from the Chart... button on the 
chart wizard, filled in while running the chart wizard, or added to the chart later. The Chart Wizard 
runs through a series of steps that help you set up your chart.

Step 1 - Select a Chart Type

The Standard Types tab of Step 1 of the Chart Wizard shows a list of chart types on the left side, 
and several chart sub-types on the right. The Custom Types tab has a number of built
types of charts, including several combination charts
to the User-Defined list.
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source spreadsheets during a 5-year period, the line chart would be an excellent choice for your 

The first step to making our chart is to select the range of data to be charted. 

can be started by using the Chart Wizard button on the Standard command bar 
ton on the Insert menu. The data can be selected prior to running the 

chart wizard, filled in while running the chart wizard, or added to the chart later. The Chart Wizard 
runs through a series of steps that help you set up your chart.

The Standard Types tab of Step 1 of the Chart Wizard shows a list of chart types on the left side, 
types on the right. The Custom Types tab has a number of built

types of charts, including several combination charts. You can add your favorite custom chart types 

Centre for Distance Education

ld be an excellent choice for your 

The first step to making our chart is to select the range of data to be charted. 

button on the Standard command bar 
. The data can be selected prior to running the 

chart wizard, filled in while running the chart wizard, or added to the chart later. The Chart Wizard 

The Standard Types tab of Step 1 of the Chart Wizard shows a list of chart types on the left side, 
types on the right. The Custom Types tab has a number of built-in custom 

. You can add your favorite custom chart types 
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Step 2 - Source Data
The Data Range tab gives you a preview of the chart style you selected in Step 1, indicating where 
the chart's source data range is, and allowing you to plot by row or by column. The first dialog box 
below shows a column chart, plotted by rows. The second shows an area 
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tab gives you a preview of the chart style you selected in Step 1, indicating where 
the chart's source data range is, and allowing you to plot by row or by column. The first dialog box 
below shows a column chart, plotted by rows. The second shows an area chart plotted by columns.

UNIT-III

tab gives you a preview of the chart style you selected in Step 1, indicating where 
the chart's source data range is, and allowing you to plot by row or by column. The first dialog box 

chart plotted by columns.
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If you click in the Data range box, or click on the Range selection button 
to the size of just the data range box, obscuring less of the worksheet, so you are able to adjust this 
range with your mouse.

When the Source Data dialog box is activated, a “marching ants” border, shown in unanimated 
form below, highlights the source data range.
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If you click in the Data range box, or click on the Range selection button 
to the size of just the data range box, obscuring less of the worksheet, so you are able to adjust this 

When the Source Data dialog box is activated, a “marching ants” border, shown in unanimated 
form below, highlights the source data range.
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, the dialog box shrinks 
to the size of just the data range box, obscuring less of the worksheet, so you are able to adjust this 

When the Source Data dialog box is activated, a “marching ants” border, shown in unanimated 
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Clicking on the Series tab gives you the option to add or remove some of the data series in the 
selected source data range. You can change the Name, Values (Y axis), and Category labels (X 
axis) of each series, by editing the contents of the respective box

selection button , then dragging with the mouse.
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Clicking on the Series tab gives you the option to add or remove some of the data series in the 
selected source data range. You can change the Name, Values (Y axis), and Category labels (X 
axis) of each series, by editing the contents of the respective box, or by clicking on the Range 

, then dragging with the mouse.
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Clicking on the Series tab gives you the option to add or remove some of the data series in the 
selected source data range. You can change the Name, Values (Y axis), and Category labels (X 

, or by clicking on the Range 
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Step 3 - Chart Options

This step allows you to provide a title for the chart and for the chart axes, to select which and what 
kind of axes to put in your chart, and wh
and data labels.

Step 4 - Chart Location

Here you tell Excel where to place the chart. You can put the chart onto its own sheet with a name 
that you enter in the box (where it says "Chart1") or
one of the existing worksheets (or chart sheets), which you select from the drop down list.

3.30 Centre

This step allows you to provide a title for the chart and for the chart axes, to select which and what 
kind of axes to put in your chart, and whether to show other options, such as gridlines, a legend, 

Here you tell Excel where to place the chart. You can put the chart onto its own sheet with a name 
that you enter in the box (where it says "Chart1") or you can embed the chart as a chart object in 
one of the existing worksheets (or chart sheets), which you select from the drop down list.

Centre for Distance Education

This step allows you to provide a title for the chart and for the chart axes, to select which and what 
ether to show other options, such as gridlines, a legend, 

Here you tell Excel where to place the chart. You can put the chart onto its own sheet with a name 
you can embed the chart as a chart object in 

one of the existing worksheets (or chart sheets), which you select from the drop down list.
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3.3. Summary:
In this lesson you learnt the basic features of Spread Sheet. Excel is used for performing 
accounting problems. In this chapter we introduced the concept of inserting, modifying and deleting 
rows/columns. We have learnt the procedure of changing the size of rows/columns and changing 
the data in a cell. Excel is having different types of referenc
references. The data can be represented in many ways; using the different types of charts we can 
represent the data in effective manner.

3.14. Technical Terms:
Active Cell: The active cell has a dark border around it t

Relative Reference: Relative cell references are references to cells relative to the position of the 
formula.

Absolute Reference: Absolute references, which are cell references that always refer to cells in a 
specific location.

Formula Bar: Use the formula bar to enter and edit worksheet data.

3.15. Model Questions:

1. Explain the features o MS
2. Explain different references in MS
3. Explain the Chart feature in MS
4. What is Auto Fill ? Explain Custom Fill List feature MS
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In this lesson you learnt the basic features of Spread Sheet. Excel is used for performing 
accounting problems. In this chapter we introduced the concept of inserting, modifying and deleting 
rows/columns. We have learnt the procedure of changing the size of rows/columns and changing 
the data in a cell. Excel is having different types of references like Relative, Absolute and Named 
references. The data can be represented in many ways; using the different types of charts we can 
represent the data in effective manner.

: The active cell has a dark border around it to indicate your position in the worksheet.

: Relative cell references are references to cells relative to the position of the 

: Absolute references, which are cell references that always refer to cells in a 

: Use the formula bar to enter and edit worksheet data.

15. Model Questions:

Explain the features o MS-Excel
Explain different references in MS-Excel
Explain the Chart feature in MS-Excel.
What is Auto Fill ? Explain Custom Fill List feature MS-Excel.  

UNIT-III

In this lesson you learnt the basic features of Spread Sheet. Excel is used for performing 
accounting problems. In this chapter we introduced the concept of inserting, modifying and deleting 
rows/columns. We have learnt the procedure of changing the size of rows/columns and changing 

es like Relative, Absolute and Named 
references. The data can be represented in many ways; using the different types of charts we can 

o indicate your position in the worksheet.

: Relative cell references are references to cells relative to the position of the 

: Absolute references, which are cell references that always refer to cells in a 
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Lesson –12

  Microsoft Excel

3.0 Objectives:
This lesson introduces the basic features of Microsoft Excel, Pictures and Auto shapes, 

Worksheet Formatting, Worksheet Printing, Worksheet as Database and Macro in Excel.

Structure 
3.1. Pictures and Auto shapes

3.2. Worksheet Formatting

3.3. Functions

3.4. Worksheet as Data base

3.5       Worksheet Printing

3.6       Macro

3.7      Summary

3.8     Technical Terms

3.9.    Model Questions

3.10.   References

3.1. Pictures and Auto shapes:

Pictures
Excel has a feature of inserting pre-defined pictures or clipart into the worksheets. All these 
features are available under Insert Menu of the menu bar.

Inserting Clipart
Select the worksheet area in which you want to insert clipart. Select insert menu from the menu 
bar, click picture, and clipart. Now we see lot of pictures in a dialog box. Select Clipart tab, 
category, select an image and click insert. Then automatically the selected image will be displayed 
in the worksheet and then figure will have small squares around the surface. These are called 
handles and are used to increase or decrease the size of the image.

Inserting picture form file
We can also insert pictures form a file. For this select insert menu from the menu bar and click 
picture from file. Then we see a dialog box in that select the required folder in which the file is 
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available and the name of the file and click on the Insert button. Then the pictures from the file will 
be inserted into the worksheet.
Inserting Auto shapes
An auto shape can be inserted into a worksheet. For this select Insert menu from the menu bar and 
click picture and in it Auto shape. Then different shapes will appear in the dialog box. From that 
select the required auto shape. Now place the mouse pointer in the sheet where you want to draw 
the auto shape. The mouse pointer looks like a + sign. Then press the left mouse button and drag 
the mouse diagonally or towards right so that the selected auto shape will appear in the worksheet. 
After reaching the required auto shape then release the left mouse button. The size of the auto 
shape can be increased or decreased and also you can rotate the auto shape by an angle using 
the auto shape tool bar.

3.2. Worksheet Formatting:

Alignment of cells
Generally in Excel by default all the text will be aligned left and numbers to the right. But we can 
align text or number in the desired fashion. Select Format menu from the menu bar, Cells, then 
activate the Alignment Tab. There are two types of cell alignments they are Horizontal and Vertical 
alignments.

In the case of Horizontal alignment we have default option left (contents are aligned left), right 
(contents are aligned right), center (contents are aligned center), fill (contents are duplicated so that 
they fill the cells), justify (aligned left and right) options available.

In the case of vertical alignment we have Top (contents are aligned top), center (contents are 
aligned center), bottom (contents are aligned bottom), justify (contents are aligned top and bottom) 
options are available.

Excel allows Text Wrap option. When we type text, if the text overflows then adjacent cells will be 
used. But in the text wrap option there will not be any overflow instead the cell width will be 
increased to accommodate the text. 

Number Formatting
Entering and formatting numbers
Numbers are referred as constant values or values.  In addition to the numbers 0 to 9, you can enter 
the following symbols. That are
                             +  - (   ) ,  .  $  % 

It treats commas and other dolor signs correctly, and it accepts numbers entered in scientific notation 
(2.5E+2)

Different Number Formats
   General

Number
Currency
Accounting
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Date
Time
Percentage
Fraction
Scientific
Text
Special  
Custom

When we enter any number it will take the number in general format.  We can change the type of cell 
after entering the numbers in a cell.  

For example If you activate a cell in the General format, then type a number with a dolor sign  ($), the 
cell’s format will change from general to currency format.

When a number is too big to be properly displayed in its cell, excel after displays a series of pound 
signs (######) instead of the number.  Some times excel switch to scientific notation to accommodate 
a large number.

Entering Dates and Times

You can enter dates and times by typing item in most commonly accepted American formats.

11/7/97

11-Nov-97

Nov 7, 1997
The excel stores dates and times as serial numbers using January 1, 1900 at the stating date that in 
one (1).  The serial number 2 stand January 2, 1990. You can change the date format to number, and 
number to date.  If we enter 8/93, the system automatically displays accepts as Aug-93.

If we enter numbers starting with ‘ (single quote), the entered data will be treated as text.

Fonts for Cells
To change the, font size, font style, Bold, Italic and Underline, select the cells in which we want to 
change the font. Select Format menu from the menu bar, Cells, then activate the Font Tab. Now 
apply font style, size, bold, italic etc., and click OK. Now the selected cells will be formatted 
accordingly.

Auto Format
Excel has some pre-defined formatting schemes, and those can be utilized directly instead of 
formatting worksheet.
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Select the cells, which are to be auto formatted and then select Format from the menu bar and click 
Auto Format. Then we get auto format dialog box on the screen. Here click the required format 
style, and click O.K. Then the selected cells will be formatted according to the selected pre-defined 
auto format.

3.3. Functions:
The various MS-Excel functions are classified as:

1. Statistical function:

Function Purpose
SUM() It computes the sum of a particular defined range or range 

names. Ex: sum(a1:a4)
Average() It computes the average of a particular defined range or range 

numbers. Ex:- Average(a1:a4)
Count() It counts the number of non blank cells in a particular defined 

range or range names. Ex:- count(a1:a4)
Max() It will display the maximum value from a particular defined 

range or range names. Ex:- max(a1:a4)
Min() It will display the minimum value from a particular defined 

range or range names. Ex:- min(a1:a4)

2. Mathematical function:

Function Purpose
ABS() It will calculate the absolute value of a number. Ex:- abs(-9) will 

display as 9.
Int() It will round off the number down to its nearest integer. Ex:-

int(19.34) will display as 19
Mod() It will calculate the remainder after integer division.                    

Ex:-mod(5,2) will display 1
Round() It will round off the number down to a specified number of 

decimal places. Ex:- round(a1,2) will display 19.34 if cell a1 
contains 19.345678

Sqrt() It will calculate the square root of a positive number.        Ex:-
sqrt(9) will display 3.
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3. Trigonometric functions:

These functions are used for trigonometric calculations on a list of values. Some commonly 
functions like SIN, COS, TAN, ACOS, ATAN, ACOSH, ATANH and DEGREES etc.

Syntax:- function (cell address/value)

4. Financial functions:

These functions are used to compute loans, depreciation, cash flow etc., Some commonly 
used financial functions are RATE, FV, PMT etc.,
Rate(): It calculates the rate of interest per period. The syntax is RATE(nper, pmt, pv, fv, 
type, guess). Here nper is the total payment period,  pmt is payment made per  period, pv is 
present value of the total amount, fv is the future value, type is the number 0 or 1 depending 
upon whether the payment is to be made at the end of the period or at the beginning 
respectively. Guess is the guess value for the rate of interest.
For example, amount of loan = Rs.50,000 to be paid in 24 monthly installments of 3,000 
each. Here nper = 24, pmt=-3,000, pv=50,000 fv=0.The default guess is 10%. Now 
RATE(24,-3000,50000,0,0,10) will display 1% as rate of interest.
PMT(): The  purpose of PMT() function is to compute the equal periodic payments required 
to pay off a loan. The general syntax of PMT() function is PMT(rate, nper, pv, fv, type)
Here fv and type are optional. Suppose if you want to take a loan of Rs.2,00,000/-. The 
annual interest rate is 14% and has to be paid in 15 years in equal monthly installments. 
Here rate is 14%/12, nper is 180 (15 * 12) and pv is 2,00,000. Here fv is zero by putting all 
these in the formula

Pmt(14/12,180,200000).

3.4. Worksheets as Data Bases:

Excel is a spreadsheet application but can also be a used as a database. There are two limits for 
using Excel as a database. The first one is that only one person at a time can enter data into the 
database. 

The second limit is a matter of quantity of data. Each sheet in an Excel workbook comprises 65,000 
rows and 256 columns. An Excel workbook can comprise up to 256 sheets. We are talking about 
4,292,608,000 cells.

Excel needs to recognize your set of data as a database or you will not have access to any of the 
database functionalities from the "Data" menu item (Sort, Filter, Form, Subtotal).

The DATABASE is a set of columns and rows in your spreadsheets without empty rows and empty 
columns. Many cells can be empty but never an entire row or an entire column. 

The database must have a single title row. Use "Text Wrap" in Format/Cells/Alignment to write 
more than one line of text in one cell.

The DATABASE must be surrounded by empty rows and columns (row "1" and column "A" of the 
worksheet are considered preceded by an empty row or column). 
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So anybody can develop a database in Excel. You don't need to develop complex forms to enter 
data, you don't need to develop queries you just use SUMPRODUCT, INDEX/MATCH and 
SUBTOTAL formulas to develop reports by yourself when you need them and that have the layout 
that you need.

Excel is the most user friendly analyzing and reporting application so they don't need to train a few 
analysts on other reporting applications creating a bottleneck at the report development level. 
Adopting Excel also allows all the analyst and decision makers to develop significant analysis and 
reports improving the bottom line of the whole corporation.

Using Data Forms

A data form is used to allow easy manipulation of information in an Excel data list. While a list is 
small--for instance, when it fits on one screen--it is easier to enter or change information directly. 
When you start getting a larger number of records, then you may find using a data form to be 
easier. A data form is a dialog box that displays one complete record from your list at a time. Excel 
considers a record to be a single row in your data list, so a data form basically extracts the 
information from a row, uses the field labels from the first row of the list, and displays the 
information so you can understand it easier. To utilize a data form, follow these two simple steps:

Creating Data Forms in Excel

When you have to input a data into a worksheet, using an Excel generated data form may make 
the job easier.  Your worksheet should contain column titles as in the example below:  

Click in the first cell in the row directly below your titles, then select Data, Form.  If you receive the 
message below, click OK.
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Your data form is created and ready for data entry.

Type your data, tabbing between fields and press Enter or click New after each record to add it to 
the worksheet.  

When you are done entering records, click Close. 

Sorting Data:

1. Select the columns that you want to sort.
2. Click Data>Sort.
3. In the sort window choose the column or columns you want to sort by.
4. If you have a heading row make sure the Heading row option is selected.
5. Click OK.
6. The data will now be sorted.
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Filter Data:

1. Click Data>Filter>AutoFilter.

2. The first row of the spreadsheet becomes the filtering row. 

3. To filter for specific data, click on the down arrow next to the head of the column you want 
to filter by. 

4. Then select the criteria you want to filter for.

5. You may filter by multiple columns at once by repeating steps 3-4 for each column you want 
to filter by.

3.5. Worksheet Printing:
Page Breaks
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To set page breaks within the worksheet, select the row you want to appear just below the page 
break by clicking the row's label. Then choose Insert|Page Break from the menu bar. You may 
need to click the double down arrow at the bottom of the menu list to view this option.

Page Setup

Select File|Page Setup from the menu bar to format the page, set margins, and add headers and 
footers.

Page

Select the Orientation under the Page tab in the Page Setup window to make the page Landscape 
or Portrait. The size of the worksheet on the page can also be formatting under Scaling. To force a 
worksheet to print only one page wide so all the columns appear on the same page, select Fit to 1 
page(s) wide.

 Margins

Change the top, bottom, left, and right margins under the Margins tab. Enter values in the 
header and footer fields to indicate how far from the edge of the page this text should appear. 
Check the boxes for centering horizontally or vertically on the page.
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 Header/Footer

Add preset headers and footers to the page by clicking the drop-down menus under the 
Header/Footer tab.
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To modify a preset header or footer, or to make your own, click the Custom Header and 
Custom Footer buttons. A new window will open allowing you to enter text in the left, center, or 
right on the page.

Format Text - Click this button after highlighting the text to change the font, size, and style.
Page Number - Insert the page number of each page.
Total Number of Pages - Use this feature along with the page number to create strings such as 
"page 1 of 15".
Date - Add the current date.
Time - Add the current time.
File Name - Add the name of the workbook file.
Tab Name - Add the name of the worksheet's tab.

 Sheet

Check Gridlines if you want the gridlines dividing the cells to be printed on the page. If the 
worksheet is several pages long and only the first page includes titles for the columns, select 
Rows to repeat at top to choose a title row that will be printed at the top of each page.
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Print Preview

Select File|Print Preview from the menu bar to view how the worksheet will print. Click the Next
and Previous buttons at the top of the window to display the pages and click the Zoom button to 
view the pages closer. Make page layout modifications needed by clicking the Page Setup button. 
Click Close to return to the worksheet or Print to continue printing.

Print

To print the worksheet, select File|Print from the menu bar.

 Print Range - Select either all pages or a range of pages to print. 
 Print What - Select selection of cells highlighted on the worksheet, the active worksheet, or 

all the worksheets in the entire workbook. 
 Copies - Choose the number of copies that should be printed. Check the Collate box if the 

pages should remain in order. 

Click OK to print.

3.6. Macro:
Macros can speed up any common editing sequence you may execute in an Excel spreadsheet. In 
Macro two options are there. They are Recording a Macro and Running a Macro.

Recording A Macro
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In this example we will make a simple macro that will set all the margins on the page to one inch.

 Click Tools|Macro|Record New Macro from the menu bar.

 Name the macro in the Macro name field. The name cannot contain spaces and must not 
begin with a number. 

 If you would like to assign a shortcut key to the macro for easy use, enter the letter under 
Shortcut key. Enter a lower case letter to make a CTRL+number shortcut and enter an 
upper case letter to assign a CTRL+SHIFT+number shortcut key. If you select a shortcut 
key that Excel already uses, your macro will overwrite that function. 

 Select an option from the Store macro in drop-down menu. 
 Enter a description of the macro in the Description field. This is for your reference only so 

you remember what the macro does. 
 Click OK when you are ready to start recording. 
 Select options from the drop down menus and Excel will record the options you choose 

from the dialog boxes, such as changing the margins on the Page Setup window. Select 
File|Page Setup and change all the margins to 1". Press OK. Replace this step with 
whatever commands you want your macro to execute. Select only options that modify the 
worksheet. Toggle actions such as View|Toolbars that have no effect on the worksheet will 
not be recorded.

 Click the Stop button the recording toolbar. The macro is now saved. 

Running A Macro

 To run a macro you have created, select Tools|Macro|Macros from the menu bar. 
 From the Macros window, highlight the Macro name in the list and click Run.
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 If the macro is long and you want to stop it while it is running, press BREAK (hold CTRL
and press PAUSE). 

3.7. Summary:
In this lesson we have learnt how to insert graphics in Excel. You have learnt the usage of 

functions. Functions are differentiated into different types. We can use the functions with respect to 
our application. It is  the best way to see the output in print preview fashion before we are going for 
final print. Worksheet can also be used as a Database. You have learnt the concept of using Data 
Forms. By using the Data Form we can enter the data and treat it as a record. We can sort the data 
and can filter the data with respect to our criteria.

3.8. Technical Terms:
Data Form: A data form is used to allow easy manipulation of information in an Excel data list.

Page Orientation: Page Orientation is used to set the page Landscape or Portrait.

3.9. Model Questions:
1. Explain the usage of functions of Excel? 

2. Explain the procedure to use the Data Forms in Excel?

3. Explain the concept of formatting data in excel?

4. How you  can use the worksheet as a Database? Explain.
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3.10. References:
RON MANSFIELD, ‘Working with MS OFFICE’, Tata Mc Graw Hill – 2000 Edition

GUY HART DAVIS, ‘ The ABC’S Of Microsoft Office. ‘ BPB Publications, New Delhi

MS OFFICE 2000 Complete, BPB Publications, New Delhi 
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Objectives:

Structure of the Lesson:

The main objectives of this lesson are: 

 To familiarize the students with the history and development 
of C language. 

 To clarify certain basic concepts in C language. 
 To know the different elements of C like character set, 

keywords etc.,
 To classify different C program entities like identifiers, 

constants, statements and expressions.
 To know different types of data types available in C language.
 To understand the working and usage of input/output 

statements in C language.

13.1.  Introduction
13.2.  History and Development of C 
13.3. Features of C
13.4. Types of C compilers
13.5. Structure of a C program 
13.6. C character set 
13.7. Escape sequences
13.8. C reserved words
13.9. Identifiers 
13.10.Data types 
13.11.Constant 
13.12.Variables 
13.13.Expression
13.14.Statements
13.15.Symbolic constants 
13.16.Operators
13.17.scanf()
13.18.printf()
13.19.Summary 
13.20.Technical terms 
13.21.Model questions
13.22.References

Lesson 13 – Introduction to ‘C’
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13.2.History and Development of C Language:

13.1.Introduction:

The step-by-step process of solving a given problem is called an 
algorithm. Using the algorithm select a programming language of your 
choice, based on the type of problem. Convert the algorithm into a 
program following the syntax of that language. One of such 
programming languages is our C.

C is an offspring of the Basic Combined Programming Language (BCPL) 
and B developed in 1960 at Cambridge University. The language B was 
modified by Dennis Ritchie and implemented at Bell Laboratories in 
1972. This modification was named as C.

'C' was then used to implement the UNIX operating system. C is a 
general-purpose language, which has been closely associated with the 
UNIX operating system.

CPL(Combined Programming language

BCPL(Basic Combined Programming Language)

B

ALGOL Simula 65

C
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13.4.Types of C compilers:

13. 3.Features of C language:

        
C is a beautiful language and provides many built-in functions that 
help in problem solving. We list out certain common features of C that 
have been quite useful.

 C is a powerful, flexible language that provides fast program 
execution and imposes few constraints on the programmer.

 C's power and fast program execution come from it's ability to 
access low level commands, similar to assembly language, but 
with high level syntax. 

 Another strong point of C is it's use of modularity. Sections of 
code can be stored in libraries for re-use in future programs. 
This concept of modularity also helps with C's portability and 
execution speed. 

 C is a block-structured language with fundamental flow-control 
construction. 

 C includes certain low-level features that are normally available 
in assembly or machine languages.

 Programs written in C compile into small object programs that 
execute efficiently.

 C is a largely machine independent language and programs 
written in C can be easily ported from one computer to another.

 C compilers are widely available in most personal computers 
minicomputers and mainframes. 

TThhee ffoolllloowwiinngg aarree tthhee ssoommee ooff tthhee ccoommppiilleerrss ffoorr CC llaanngguuaaggee::

 TTuurrbboo CC
 QQuuiicckk CC
 MMiiccrroossoofftt CC
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13.5.Structure of a C program:
  
Every C program consists of one or more functions, one of which must 
be called main.  The program will always begin by   executing the main 
function.  Additional function definitions may   precede or follow 
main(). Hence we say that C is a function dependent language.

        Structure of a C program:

Documentation section
Include libraries - Linkage section - Preprocessor Directives
Declare global variables
Declare constants
Define macros
Function Prototype Declaration Section
main()
{
Local variable declarations
------//
Main body of the program
------//
}
function-1()
{
------
}
function-2()
{
------
}

…….

Function-n()
{
-------
-------
}
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13.6.C Character Set:

13.7.Escape Sequences:

Here 
1. Comments are non-executable statements meant for remarks 

regarding program. Comment lines begin with a /* and end with 
a */.

2. 'C' is very case sensitive. All 'C' statements should be in lower 
case except user-defined expressions. 

3. Every statement in 'C' must be terminated by a semicolon 
except the conditional statements like if, if-else, switch, for, 
while and compile directive statements like #include, #define.

4. Every statement must be included in { and } of main().
5. Every program must include at least one function called main()

  
       

Character set means the characters and symbols that can be used in a 
C program. They are grouped to form the commands, expressions and 
other tokens for C language.  Character set is the combination of 
characters, digits, special characters and blank spaces. C language 
uses

Alphabets: upper case letters A to Z
Lower case letters a to z

Digits: 0 to 9
Special Characters: {,}, #, : ,;,&,? Etc.,

A special kind of a character that allows the user to customize the 
output of a program is referred as escape sequence.

             \b back space
     \n new line
     \t horizontal tab
     \a bell
     \\ backslash
     %% percentage
     \v vertical tab
     \0 NULL character
     \f form feed
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13.8.Keywords: 

Ex: Program to print "Hello Ramu" on the screen.

#include <stdio.h>
#include<conio.h>
main()
{

printf("\n\n\n\n\n\n\t\t\t Hello Ramu");
printf(“\n\a This is JKC College”);
printf(“\n\t  Dept.Of Computer Science);
printf(“\n Guntur.”);
getch();

}

            

      
                        
There are certain reserved words, called keywords that have standard, 
predefined meanings in C.  These keywords are to be used for their 
intended purpose only in a C program. There are 32 words defined as 
keywords in C. They are always written in lower case. A complete list 
follows: 

     auto        double      int         struct
     Break      else         long        switch
     case        enum     register    typedef
     char       extern     return      union
     Const       float       short       unsigned
     continue   for        signed      void
     default    goto       sizeof       volatile
     do               if         static       while 

In addition to this list of keywords, your compiler may define a few 
more. If it does, they will be listed in the documentation that comes 
along with your compiler.
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13.9.Identifiers:  

13.10.Data Types: 

       

Identifiers are names given to various program elements, such as 
variables, functions and arrays.  Identifiers consist of letters and 
digits, in any order, except that the first character must be a letter.  
Both uppercase and lowercase are permitted. Upper   and lowercase 
letters are not interchangeable, i.e., uppercase  letter  is  not 
equivalent to  the  corresponding  lowercase letter and vice versa. The 
under score character (_) can also be included.  An underscore is often 
used in the middle of an identifier.
     
Valid Identifiers  Invalid Identifiers
A, B,  Stno, tax_rate  etc., 4th    "x"    

    
C supports several different types of data, each of which may be 
represented differently within the computer's memory. A data type is a 
C token that tells about the type of data being assigned to an 
identifier.
C supports a rich set of data types. The category follows:

 Primary data types or Primitive data types
 Secondary data types

While using the above data types, one should intimate the compiler by 
providing corresponding format specifier or control string.

Primary data types:
Short int 
int 
long int
float
double
long double

Secondary data types:
Arrays
Functions
Pointers
Structures
Unions
Enumeration
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The % format specifiers: 

The % specifies that you can use in ANSI C are: 
   
Format Data Type
%d (%i) Int
%e (%E) float or double
%f float or double
%o      Octal 
%p       Pointer
%s        String 
%u      Unsigned data represen-tation
%x (%X)   Hexa-decimal data repre-

sentation
%c Character (single)
%ld Long int
%lf Long double

The data size of each data type follows:

Data type Data size in bytes Range

Short int 1(8 Bits) -128 to 127
Unsigned short Int 1(8 bits) 0 to 255
Int 2(16 bits) -32768 to 32767
Unsigned int 2(16 bits) 0 to 65535
Long int 4(32 bits) -2,147,483,648 to 

2,147,483,647

Double 8(48 bits) 1.7E-308 to 1.7E+308
Long double 10(80 bits) 3.4E-4932to 

1.1E+4932
Char 1( 8 bits) -128 to 127
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13.11. Constants:

13.12.Variable: 

A constant is an identifier whose value can never be changed during 
the program execution. C has four basic types of constants. They are 
                     1.Integer constant
                     2.Floating-point constants
                    3.Character constant
                    4.String constant
  Integer constant:
                      0   1  743    5280
        
   Floating constants:-
                0.   1.   0.2   825.602    2E-8   0.06E-3
      
            3*105  can be represented as follows:       
            300000.      3E5      3E+5     3.0E+5    .3E+6    30E4
                
            5.026*10-17 can be represented as follows:    

            5.026E-17
           .5026E-16

   Character constants:-
                                      'A', 'X', '3', '$'
String Constants:
A string consists of any number of consecutive characters enclosed in    
double quotations.
Ex:    "green", "jkc college"

A variable is an identifier that is used to represent some specified type 
of information. Or a variable is an identifier whose value may or may 
not be changed during the program execution.       
                  int a, b, c;
                  char d;  a=3; b=4; d = 'a';
All variables must be declared before they can appear in           
executable statements.
       
                  int a, b, c; float root1, root2;
                 char flag;     
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13.14.Statements:

13.13.Expression:

An expression represents a single data item, such as a number or a 
character.  It may also consist of a combination of entities 
interconnected by one or more operators.
        
  Ex:                c=a+b
                       x=y;
                       x<=y
                       x==y
                       ++i;

         

A statement causes the computer to carry out some action. There are 
three different classes of statements in C.
        

 Expression Statement
 Compound Statement
 Control Statement

        
An expression statement consists of an expression followed by a 
semicolon.
                       a=3;
                       c=a+b;
                       a++;
                       printf("jkc college");
        
A compound statement consists of several individual statements 
enclosed within a pair of braces {}.
                        {
                       pi=3.1415;
                       area=pi*radius*radius;
                       }
        
Control statements are used to create special program features, such 
as logical tests, loops and branches.
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13.15. Symbolic constants: 

Ex: Program to add two numbers 10 and 20.

#include <stdio.h>
#include <conio.h>
main()
{

int a, b, sum;
clrscr();
a = 10;
b = 20;
sum = a + b;
printf("\n\t Sum of %d and %d  is  %d", a, b, sum);

}

        

A symbolic constant is a name that substitutes for a sequence of 
characters.  The characters may represent a numeric constant, a 
character constant or a string constant.
        
    # define name text
        
Where name represents a symbolic name, typically written in upper-
case  letters,  and  text represents the  sequence  of  characters       
associated  with the symbolic name.  Note that text does not end  
with a semicolon.
        
            # define TAXRATE 0.25
            # define PI      3.1415
            # define TRUE    1
            # define FALSE 0 
                   
Notice that the symbolic names are written in uppercase,  to  
distinguish them from ordinary C identifiers.
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13.16. Operators: 

Unary Operator:

An operator performs an operation over one or more operands. C 
supports a rich set of operators. The following are the some of the 
examples.

        
           

An unary operator performs operation on one operand. The unary 
operators are:  ++, - -

Ex:
               ++a  or a++ is equivalent to a=a+1
     --a  or a—is equivalent to a=a-1.
Here ++a - Pre-incrementation

a++ - Post-incrementation
- -a - Pre-decrementation
a- - - Post-decrementation

 In Pre-incrementation the value is incremented first, then 
assigned.

 In Post-incrementation, the value is assigned first, then 
incremented.

 In Pre-decrementation, the value is decremented first, then 
assigned.

 In Post-decrementation, the value is assigned first, then 
decremented.

      
For example:

    int i = 5;   
   printf ("%d\n",i);      5

            printf ("%d\n",i++);    5
            printf ("%d\n",i);       6
            printf ("%d\n",++i);   7
            printf ("%d\n",i);       7
            printf ("%d\n",i--);    7
            printf ("%d\n",i);      6
            printf ("%d\n",--i);    5

            printf ("%d\n",i);      5
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Binary Operators:  

A binary operator is an operator that performs operations on two 
operands or values. There are many binary operators in C. Some of 
them are:  +, -,*, /, %, +=,-=,*=,/= etc.,

Arithmetic operators are the regular operators that can be used to 
perform basic arithmetic operations like addition subtraction, 
multiplication and division in a program in order to solve a problem.

Operators Purpose
+ Addition
- Subtraction
* Multiplication
/ Division
% Reminder

        
  Suppose a and b are integer variables such as a=10 b=3
                      Expression          Value
                       a+b             13
                       a-b              7
                       a*b             30
                       a/b              3
                       a%b              1
v1 v2 are floating points variables whose values are 12.5 and 2.0
                      Expression           Value
                       v1+v2           14.5
                       v1-v2           10.5
                       v1*v2           25.0
                       v1/v2           6.25
The value of an expression can be converted to a different  data type if 
desired.  To do so the expression must be preceded by the name of 
the desired data type, enclosed in parentheses.

             (Data type)   expression
       int a=10;

int b=3;
a/b becomes 3
(float)a/(float)b becomes 3.33
int 10+15.5  becomes 25
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Relational Operators: 

Logical Operators:

Assignment Operators:

                     Operators          Meaning
                      <              less than   
                      <=            less than or equal to
                      >              greater than
                      >=            greater than or equal to
                      ==            equal to
                      !=             not equal to

        
        
                    Operator          Meaning
                    &&               and
                     ||                or

    !       not
        

       

In C there are different assignment operators available. They are: =, 
+=, -=, *=, /=, %=.        

Syntax:         identifier = expression;

Example:  a=3;
                  x=y;
                  sum=a+b;

a += 4; // a = a+4;
a -= 4; // a = a- 4;
a *= 4; // a = a4;
a /= 4; // a = a/4;
a %= 4; // a = a%4;
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13.17.Scanf function: 

In order to provide input to any program one has to use a standard 
input statement in C. Another way  to input data into the computer is 
through a standard input device using C library function scanf().  This 
function can be used to enter any combination of numerical values, 
single characters and strings.
  
            scanf(control-string, arg1,arg2,.... argn);
Where control string refers to a string containing certain required 
formatting information and arg1, arg2...argn are arguments that 
represent the individual input data items.
        
                  %c   single character
                  %d   decimal integer
                  %e   floating point value
                  %f   floating point value
                  %s   string
                  %x   hexa decimal
                  %o   octal

Each variable name must be preceded by an ampersand  (&).   The            
arguments are actually pointers that indicate where the data items are 
stored in the computers memory.

Example:      int a;
            float b;

            char c;
            scanf("%d%f%c",&a,&b,&c);
            char name[20];
            scanf("%s", name);

     



Acharya Nagarjuna University 16 Centre for Distance Education

16

13.18.printf Function:

A standard output statement with which the user is able to display or 
view the result or output of a program is nothing but a printf() 
statement. printf() is a C library function. This function can be used to 
output any combination of numerical values, single characters, and 
strings.
                    printf( control-string,arg1,arg2,...);

Where control string refers to a string that contains formatting 
information, and arg1, arg2 are arguments that represent individual 
output data items.
                  %c   single character
                  %d   decimal integer
                  %e   floating point value
                  %f   floating point value
                  %s   string
                  %x   Hexa decimal
                  %o   Octal
However, both printf() and scanf() are the standard input  and output 
statements, they can be referred as formatted I/O statements or 
standard I/O.

Ex:Program to accept integer, float and character 
values and display them back.

main()
{

int a;
float f;
char ch;
clrscr();
printf("\n Enter an integer :  ");
scanf("%d", &i);
printf("\n Enter a floating number :  ");
scanf("%f", &fl);
printf("\n Enter a character :  ");
scanf("%c", &ch);
printf("\n Integer value : %d", i);
printf("\n Floating value : %f", f );
printf("\n Character value : %c", ch);

}
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Program to add, subtract, multiply and divide two 
numbers 

#include <stdio.h>
#include <conio.h>
main()
{

int num1, num2, sum, diff, prod;
float division;
printf(“Enter any two numbes”);
scanf(“%d%d”,&num1,&num2);
sum = num1 + num2;
diff   = num1 - num2;
prod = num1 * num2;
division = num1 / num2;
printf(“\n Sum is %d“,sum);
printf(“\n Difference is %d. “,diff );
printf(“\n\n\t Product is %d. “,prod);
printf(“\n\n\t Division is %d. “,division);

}

Program to find area and perimeter of a rectangle 
given its length as 5 units and breadth as 10 units.

#include <stdio.h>
#include <conio.h>

main()
{

int length, breadth;
int area, perimeter;
area = length *  breadth;
perimeter = 2 * (length + breadth);
clrscr();
printf("\n\n\t Length of Rectangle   :%d ",length);
printf("\n\n\t Breadth of Rectangle  :%d 
",breadth);
printf("\n\n\t Area of Rectangle     :%d ",area);
printf("\n\n\t Perimeter of Rectangle :%d 
",perimeter);

}
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13.19. Summary:

13.20. Technical Terms: 

In this lesion you learned history and development of C language and 
basics required to write a C program: character set, keywords, data 
types, operators and input/output functions.  You learnt that there are 
three basic data types in C: integer, float and character. You have 
learnt how to declare a variable, how to define a constant and how to 
use the arithmetic statements.   

Input/output statements you have learnt in this lesson are scanf() and 
pritnf().You  have also learnt how to use these functions for input and 
output of different types of variable like integer, float, character, string 
etc.

Algorithm: A step- by- step procedure for solving a problem or 
accomplishing a task.
Structured programming: Is a design approach where complex 
systems are broken down into smaller, more manageable pieces.
ANSI[American National Standards Institute]:This organization 
produces many standards, among them the standard for the C 
programming language.
Escape Sequences: A special sequence of characters used for 
describing nonprinting characters, such as `\n' for new line.
Keyword: A keyword is a word that has special meaning. Keywords 
are reserved for specific purpose   and not to be used as variable 
names. 
Built-in Function: The language provides built-in functions that 
perform various numerical and string computations. 
Variable: A name used to represent data that can be changed while 
the program or procedure is running.
Constant: A specific quantity that does not or cannot change or vary; 
the opposite of a variable.
Token: it is a smallest individual program element of a C program. 
Preprocessor: It is a program, which processes the source code 
before it passes through the compiler. 
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13.21.Model questions:

13.22. References:

1. What is C? Explain the history of C language?
2. Explain the features of C language?
3. Write about the structure of a C language program?
4. Explain various data types in C?
5. Explain different types of operators available in C?
6. Write about printf() and scanf() statements?

Byron C. Gottfried  “Programming with C”

Kelly & Pohl  “ A book on C “

Yeshavanth kanethkar  “Let us C” 

Ravi Chandran “Programming in C”

Yeshavanth kanethkar “Working with C”

Blaguruswamy “ANSI C” 

AUTHOR:
                                  G.RAMANJAIAH.,M.Sc(Computers)

Lecturer, 
Dept.Of Computer Science,
JKC College,
GUNTUR.
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Objectives:

Structure of the Lesson:

The main objectives of this lesson are:

 To use control structures to write effective programs
 To understand various types of control structures

To develop C programs using decision making constructs Objectives:

 To develop C programs using iterative constructs
 To understand break, continue, goto and label statements

14.1. Introduction 
14.2. What are Control structures?
14.3. Conditional branching 

14.3.1. Simple if statement
14.3.2. if else statement
14.3.3. nested if statement
14.3.4. switch statement 

14.4. Looping structures 
14.4.1. while statement
14.4.2. do while statement 
14.4.3. for statement

14.5. break and continue
14.6. goto and exit statements
14.7. Summary 
14.8. Technical terms 
14.9. Model questions 
14.10 References

Lesson 14 - Control Structures



Acharya Nagarjuna University 2 Centre for Distance Education

2

14.1.Introduction:

14.2.Control structures:  

14.3.Conditional Branching (or) Decision Making:

Every C program is a sequence of instructions, which are executed, in 
a sequential fashion. There are many situations in which these 
sequential executions need to be altered with a few instructions being 
executed only when a condition is satisfied. Sometimes it may be 
necessary to execute a group of instructions for a fixed number of 
times or until some condition is satisfied. In such situations 
programmer may require to include control statements in programs. 
These control statements allow the programmer to alter the sequential 
order of execution.

In high-level programming languages, flow of program execution may 
be changed using certain control statements called control structures. 
A control structure is a control flow statement that allows you to 
alter the sequential flow. 

Control flow statements fall into three categories:
1. Conditional branching (or) Decision Making or Non-iterative
2. Looping or iterative or repetitive
3. Unconditional branching.

Conditional branching is the most basic control feature of any 
programming language.  It enables a program to make decisions, to 
decide whether or not to execute a statement or a block of statements 
based on the value of an expression.  The expression may result in 
either true or false value. Since the value of the expression may vary 
from one execution to another, this feature allows a program to react 
dynamically to different data.  
C supports various types of conditional branching statements. The 
following categories illustrate several conditional control structures.

 Simple if
 if ..else
 else if ladder
 Nested if
 Switch
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14.3.1.Decision Making with Simple if statement:

The simple if statement is wonderful decision making statement and 
is used to control the flow of execution of a single or multiple 
instructions. 

The general form of “simple if” follows:
If (condition/expression)
  Statement;

In this statement   the given condition is 
tested first and responds accordingly. If the 
result of expression is true then the given 
statement is executed. If the result is false 
the statement cannot be executed.

When multiple statements are to be executed using if control structure 
then it may be referred as compound if.

Syntax:
If (expression)
{

statement-block;
} 
statement-x;

The statement-block may be a single statement or a group of 
statements. If the expression is true statement-block will be executed, 
other wise the statement-block will be skipped and the execution will 
jump to the statement-x.

Ex:Program to find biggest of two numbers.
main()
{

int a, b;
printf("\n\t Enter A value : ");
scanf("%d", &a);
printf("\n\t Enter B value : ");
scanf("%d", &b);
if (a>b)

printf("\n %d is Greater than %d", a, b);
if (b>a)

printf("\n %d is Greater than %d", b, a);
}

True

Entry

Expres
sion

Statement
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14.3.3.Decision making with else.. if ladder:  

14.3.2.Decision making with if – else statement:

In if-else control statement there 
exists an extension of the simple if 
statement.  It allows the user to 
perform another block of statements 
in case the condition result is false. 

syntax :
if (expression)

statement-x;
else

statement-y ;
Here the expression is evaluated; if 
the result of the expression is a true 
then statement-x is executed 
otherwise statement-y will be executed.

Ex:
Program to check whether given number is even or odd
main()
{

int n;

printf("\n Enter a number..:");
scanf("%d",&n);
if (n%2==0)

  printf("\n Given  number is even"):
else

printf("\n Given  number is odd"):
getch();

}

In else..If ladder number of conditions are checked depending on the 
falsity of the previous condition. Literally, too many conditions are 
evaluated in if..else ladder.

True

Entry

Expres
sion

statement x statement y

False

Flow graph
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Syntax: If <condition1>

{
------

}
else if <condition2>
{

------ True block 1
}
else 
{

------ False block
}

In this, condition1 is checked and if it is true then its corresponding 
condition is executed. If the condition is false then next condition is 
verified. If all the given conditions are false then false block is 
executed. Only one of all the available blocks gets executed. After the 
execution of any one of the blocks, control is transferred to next 
statement after the construct.

Ex:

program to find biggest of three numbers

main()
{

int a,b,c;
clrscr();
printf(“enter three numbers:”);
scanf(“%d%d%d”,&a,&b,&c);
if(a>b)

if(a>c)
printf(“%d is big”,a);

else
printf(“%d is big”,c);

else if(b>c)
printf(“%d is big”,b);

else
printf(“%d is big “,c);

}

Program to award grade to a student 
main()
{

int comp,mat,stat,tot;
float avg;
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14.3.4.Decision making with Nested if: 

char gra;
printf("\n\t Enter Computers marks   :  ");
scanf("%d", &comp);
printf("\n\t Enter Maths marks   :  ");
scanf("%d", &mat);
printf("\n\t Enter Mathematics   marks   :  ");
scanf("%d", &stat);
tot = comp+maths+stat;
avg = tot / 6.0;
if(comp>=35 && maths >= 35 && stat>=35)
{

if (avg >= 80)
gra = 'A';

else if (avg >= 70)
gra = 'B';

else if (avg >= 60)
gra = 'C';

else if (avg >= 50)
gra = 'D';

else
gra = 'E';

}
else

gra = 'F';
printf("\n|            JKC COLLEGE, GUNTUR |");
printf("\n------------------------------------------------“);
printf("\n\n\tComputers :%d”,Comp);
printf("\n\n\tMaths: %d”,maths);
printf(“\n\n\t Statistics: %d”,stat);
printf("\n--------------------------------------------");
printf("\n\n\tTotal   Marks :%d”,tot);
printf(“\n\n\tAverage :  %8.2f",avg);
printf("\n----------------------------“);
printf("\n\n\t\t\t Grade awarded     :  %c",gra);
printf("\n\n---------------------------------“);

}

A nested if control structure consists of multiple if statements in one 
another. Here each if statement consists of subsequent branching 
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14.3.5.Switch Statement:

statement.  Literally a nested if consists of one if statement in another 
if statement. It is used when multiple conditions are to be evaluated. 
Syntax:

if(expression)
{

if(expression)
{

if(expression)
{

---
---

Here evaluations of expressions or conditions are based on the first 
condition. If the first condition itself is false, then there is no way of 
evaluating other conditions. At any level of expression the program 
control may be altered. 

Ex:
Program Biggest of 3 numbers using nested if

main()
{

int a,b,c,big;
printf("\n Enter the value of a  :   ");
scanf("%d",&a);
printf("\n Enter the value of b  :   ");
scanf("%d",&b);
printf("\n Enter the value of c  :   ");
scanf("%d",&c);
if (a>b)

if (a>c)
big = a;

else
big = c;

else
if (b>c)

big = b;
else

big = c;
printf("\nBiggest of three numbers is:%d",big);

}

C provides a special kind of conditional control structure that acts as 
an alternative to if..else ladder. When there are more conditions or 
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paths in a program, if-else branching can become more difficult. In 
such situations switch may act better. The switch statement allows 
the user to specify an unlimited number of execution paths based on 
the value of a single expression. Each execution path is referred as a 
case. 
However, all the cases should be unique.  
Each case must be terminated by a ‘break’ statement. The ‘default’ 
case is not mandatory.  
In a switch statement, there are four different keywords to be used:

 switch
 case
 break
 default

Though the switch control structure enables the user to improve clarity 
of the program, it causes more errors. So, it requires more attention 
while implementation. 

Syntax:              
            switch(expression)
                       {
                       case  value1: 

statement;
                                     break;

                       case  value2: 
statement;

                                     break;
                       :
                       :
                       :
                       default : 

statement;
                       }

Among all the cases, only one case can be executed successfully 
because each case is terminated by a ‘break’ statement.

Ex:
Program to accept two integer values and perform 
arithmetic operation by getting the user input.(1) 
Addition,2) Subtraction ,3) Multiplication,4) Division. 
5) Exit ).
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14.4.Looping structures:

main()
{

int a, b, c, ch;
clrscr();
printf("\n\t\t\t Enter two numbers : ");
scanf("%d %d", &a, &b);
printf(“Enter your choice:”)l
printf(“1)Addition\n2)Subtraction”);
printf(“\n3)Multiplication”);
printf(“\n4) Division. \n5) Exit”).
scanf(“%d”&ch);
switch (ch)
{
case 1:

c = a + b;
break;

case 2:
c = a - b;
break;

case 3:
c = a * b;
break;

case 4:
c = a / b;
break;

default :
printf("\n Invalid option  ");
exit(0);

}
printf("\n\t\t\t Result   :%d",c);

}

Some times, in a program, a statement or a block of statements need 
to be executed repeated number of times.  In such situations decision 
control structures may not be useful, as they do not transfer the 
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14.4.1.While statement:

control back.  Hence the user may require another form of control 
structures, which perform a group of instructions for a fixed number of 
times. Such control structures are named as looping control structures. 
C language provides three different iterative or looping structures. 

 while loop
 do…while loop
 for loop

The while control structure executes a single or multiple statements 
for repeated number of times based on a given condition. It executes 
the statements as long as the given condition or expression results in 
a true value. It terminates execution as and when the condition is 
false. 
Syntax: initialization statement;

while(condition)
{

…
Condition reachable statement;

}
Flow graph:

Here the condition is 
tested every time, it 
executes the block of 
statements.  The 
keyword while verifies 
the trueness and falsity 
of the expression and 
responds accordingly. If 
the condition is false 
for the first time the 
minimum number of 
iterations is 0 in 
while control structure. It requires three statements in order 
to perform repetitive tasks. 

They are
 Initialization statement
 Conditional statement
 Condition reachable statement

Body of loop

True

False

Next Statement

Condition
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14.4.2.Do - While statement:

If any of the above statements is ignored then the while may 
not perform well. 

Ex:

Program to print the numbers from 1 to 10 
main()        
{
  int i;
  i=1;
  while (i<=10)
    {
      printf("%d\n", i);
      i++;
    }
}

Program to print even numbers from 2 to 100
main()
{

int a=2;
while (a<=100)
{

printf("\n %d",a);
a = a + 2;

}
}

Program to print odd numbers from 1 to 100
main()
{

int a=1;
while (a<=100)
{

if (a%2 != 0)
printf("\n %d",a);

a++;
}

}

C provides another form of while control structure i.e., do-
while control structure. In do-while control structure the 
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14.4.3.For Loop:

statements in the block get executes first, later on the 
condition is evaluated. Hence the user can assume that the 
minimum number of iterations for do while control structure 
as 1, even if the expression or condition results in false for 
the first time.

Syntax:
Initialization statement;

do
{
-------------
Condition reachable statement;

} while(condition);
      
Flow graph:

Here the statements in 
the loop will be 
executed until the 
given condition 
becomes false. The 
while statement should 
be terminated by a 
semicolon (;) in do 
while. 

Ex: print the 
numbers from 1 to 10 

main()        
{

int i;
i=1;
do
{
      printf("%d\n", i++);
} while (i<=10);

}

C provides a more flexible form of looping control structure 
that improves clarity of the code. It is nothing but for 
control structure. Usually the for control statement is used 

Next 
statment

Body of 
loop

Conditi
on

Tru
e

Fals
e
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14.5.Break and continue Statement:

to perform fixed number of iterations. The major difference 
between for and other looping structures is the number of 
iterations. In case of while and do-while the number of 
iterations are indefinite. The user may not predict the 
number of iterations. On the other hand for specifies the 
number of iterations in the statement itself. 

Syntax:

for(initialization; test condition; increment/decrement part) 
{

Body of the loop;
}

The initialization may contain single or multiple assignment 
statements.  A control variable is involved in this part of 
statements. 

The test condition verifies the validity of the control variable 
for each iteration.

Increment or decrement part increments or decrements the 
value of the control variable in order to reach the test 
condition.  

Ex:
program to print the numbers from 1 to 10 

main()        
{
  int i;
  for (i=1 ; i<=10; i++)
    printf("%d\n", i);
}

Break:
This statement takes control out of the switch statement or 
loop structure. In other words, a break statement takes the 
control out of the current block in execution. The control is 
transferred to the statement that follows the block. 
Syntax:            break;
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14.7.Summary: 

14.6. goto and label statements:

Continue Statement
To skip a part of the body of the loop in execution on certain 
condition and for the loop to be continued for the next 
iteration continue statement is used.
Syntax:            continue;

C supports an unconditional branching statement called ‘goto’. This 
‘goto’ is meant for transferring control from one part of the program to 
another part a label is present. A label is a user-defined word to where 
the control is supposed to be transferred. The given label must reside 
in the same function and can appear before only one statement in the 
same function. Although it may not be preferable to use the goto 
statement in a highly structured language like C, there may be 
occasions where the use of goto is desirable. 
Syntax:

goto label: label:
---------------- statement;
---------------- -----------------
label: -----------------
statement; goto label:

the following example demonstrates the goto statement: 
void main()
    {
         int x = 1;
         abc:

printf(“ %d”,x);
x++;

     if(x <= 5 )
                  goto abc;
    }

This lesson has focused the major elements of programming - control 
structures in C language. You have learnt about the conditional, 
looping and unconditional statements. You have also seen conditional 
statements: if, if-else, nested If and switch. Also focus on three 
categories of loops, available in C language: while, do – while and for 
loop. Usage of break, continue, goto and exit statements, which are 
very useful in loops have been covered.
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14.9.Model Questions: 

14.10.References: 

14.8.Technical Terms:

Looping: Repeating a block of statements based on condition or a 
counter. 
Compound Statement: A series of statements, enclosed in curly 
braces. Compound statements may be nested. 
Expression: an expression is a statement in which either arithmetic 
or assignment operations are performed. 
Control statement: A statement, which controls the logical flow of a 
program. Ex: if, goto, switch. 
while: It is an entry- controlled loop in which the body of the loop is 
executed only when the condition is true. 
do—while: it is a loop construct, which is used to test a condition 
after the body of the loop is executed once. 
for loop: It is an entry-controlled loop, which provides a more concise 
loop control. 

1. Describe the control structures of C language and explain each of 
them with an example.

2. Discuss various control flow statements available in C language?
3. Explain the various loop constructs in available in C language?
4. How can the do-while loop vary from the while-loop?
5. Explain break and continue statements with example?
6. Explain goto and label statements with an example?

Byron C. Gottfried  “Programming with C”
Kelly & Pohl  “ A book on C “
Yeshavanth kanethkar  “Let us C” 
Ravi Chandran “Programming in C”
Yeshavanth kanethkar “Working with C”
Blaguruswamy “ANSI C” 

AUTHOR:
                                  G.RAMANJAIAH.,M.Sc(Computers)

Lecturer, 
Dept.Of Computer Science,
JKC College,
GUNTUR.



Fundamentals of IT 1 Functions and Storage Classes

Objectives:

Structure of the Lesson:

The main objectives of this lesson are:

 To understand what a function is
 To know the advantages of functions
 To understand different types of functions
 To understand the function declaration, variable 

declaration and function calling in a program 
 To understand the concept of recursion
 To understand the concept of storage classes

15.1.Introduction 
15.2. Functions
15.3. Advantages of functions
15.4. Types of functions
15.5. Types of function calls
15.6. Recursion
15.7. Storage classes 

15.7.1. Auto 
15.7.2. Static 
15.7.3. Extern 
15.7.4. Register

15.8. Summary 
15.9. Technical terms
15.10. Model questions
15.11. References

Lesson 15 - Functions and Storage classes
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15.1. Introduction:

15.2.Functions:

A large program may be split into several sub programs in order to 
reduce complexity.  Bigger applications are not manageable as they 
contain large code. Modular programming is the concept of splitting a
problem or program into several manageable pieces called sub 
modules or sub programs.  C provides such modular programming in a 
extensive manner. 

A function is a self-contained block of statements to perform a sub 
task in a program. It can be referred as a module or procedure or a 
subtask. A function itself is not a program; rather it extends the ability 
of a program. 

As C is a function dependent language, it supports a rich set of 
functions in a sophisticated way. Every C program starts with at least 
one function called main(). There are two different categories in 
functions, system defined and user defined functions. 

System defined functions: 

A system-defined function is a subprogram, which is prewritten by the 
compiler. There is a library in C for system defined functions. For 
example, printf(), scanf(), clrscr(), getchar() etc., 

User Defined Functions:

Some times, the user may require a function, which performs a 
specific task of his own. In such cases, C permits user-defined 
functions.

Every function has its own significance and provides a separate scope 
for variables. A function requires three different types of statements to 
be specified by the user. They are 

 Function prototype declaration 
 Function Definition
 Function calling
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15.3. Advantages of Functions:

As C supports top down approach in executing the programs, explicit 
declaration of the functions must be required in a program. 

Every function requires definition without which the system is able to 
perform nothing. Literally the user has nothing to do without defining 
any function.

Unless the user makes an explicit call to the function, the function 
declaration & definition have no significance and they perform nothing.

Hence the above three statements are essential for implementing 
functions.

1. Program debugging is made easy if a C program contains 
functions.

2. Functions allow a larger task to be subdivided into several 
smaller tasks, so that they can be managed easily.

3. The length of the source program can be reduced to a maximum 
extent using functions.

4. The same function can be used for many programs once it is 
written.

5. Functions may increase program execution speed.
6. Functions improve optimum utilization of memory.
7. Functions are more reliable. 

Structure of a Function:  

return type function - name (data type arg1, data type arg2…..)
{

local variable declarations ;
// body of function
…………………….
return(expression);

}
return type is nothing but specifying the type of the value being 
returned by the function to its parent function or caller function.
Every function requires a name (function name) so that it can be 
referred or identified by the user. Function names are unique in a 
program. While specifying names, make sure that the name doesn’t 
posses any space in between the characters.
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15.4.Types of Functions:

A function may accept any number of values as input from the caller 
function in order to perform the task assigned to it. Each value is 
referred as an argument or parameter. Usually parameters are 
specified in the brackets ‘(‘, ‘)’.

The keyword return is not mandatory. It is the last statement of a 
function. If at all, a function wants to send a value back to the caller, 
return statement may be kept in use.

In C, functions are divided into the following categories:

 System Defined Functions
 User Defined Functions

Both system defined and user defined functions may fall in the 
following category:

 Functions with no arguments and no return type.
 Functions with arguments and no return type.
 Functions with arguments and return type.
 Functions with no arguments and return type.

Functions with no arguments and no return type:
In this category of function, the caller function does not send any 
argument to the function and the called function does not return any 
value.

Functions with arguments and no return type:
In this category of function, the caller function sends one or more 
values to called function but in return the called function does not 
return any value.

Functions with arguments and return type:
In this category of function, the caller and called functions send values 
to one another.

Functions with no arguments and return type:
This category of function doesn’t accept any value from the caller 
function but returns one value back to the caller.
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15.5.Types of Function calls:

  There are two types of function calls.

1. Call by value
2. Call by reference.

Call by value:      
In call by value, the actual parameters are sent to the called 
functions from the caller. 

Call by reference:
In call by reference, instead of copy, the address of the actual 
parameter is sent to the called function from caller. Therefore, the 
called function can alter the value of the actual parameters. In this 
case, pointers are used. 

Ex:  Write a function to clear the screen.

main()
{

void screenclear();
screenclear();
getch();

}
void screenclear()
{

int i,j;
for(i=1;i<=24;i++)
{

for(j=1;j<=80;j++)
{

gotoxy(j,i);
printf(" ");

}
}
gotoxy(1,1);

}
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15.6.Recursion:

Write a program to find factorial of a given number.

main()
{

void fact();
clrscr();
fact();
getch();

}
void fact()
{

int x;
long int f=1;
printf("\n Enter a number to find factorial : ");
scanf("%d",&x);
while(x>0)
{

f = f * x;
x--;

}
printf("\n Factorial of given number is : %ld",f);

}

When a called function in turn calls another function, then a process of 
chaining occurs. Recursion is special case of this process. In other 
words, Recursion is a process by which a function calls itself 
repeatedly, until some specified condition is true. The number of 
recursive calls is limited to the size of the stack. A function is called 
‘recursive’ if a statement within the body of a function calls the same 
function. Sometimes called ‘circular definition’. 
Ex:   void ramu()

  {
static  count = 1;
printf (“%d”, count);
count++;
ramu();

  }
main ()
{

ramu ();
}
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What will the program do? First it prints the value of count, which is 1 
then it increments count; then it calls itself.  The second time, count 
equals 2. This repeats the function infinite times. The output will be
1 2 3 4 5.
At some point, the computer will run out of stack memory, and the 
program will abort with a runtime error.  This illustrates an important 
point about recursive programming.  You must include a stop point or 
the program will run forever (or until it runs out of memory).  So, we 
can modify the above function so that calls itself only three times.

void ramu ( )
  {

static count = 1;
if ( count > 3)

return;
else{

printf(“%d\n”, count);
count++;
ramu ( );
}

   }
  main ( )
  { ramu ( );
  }

Each time the function is called, new storage is allocated for the 
parameters for the auto and register variables so that their values in 
previous, unfinished calls are not overwritten. Parameters are directly 
accessible to the instance of the function in which they are created. 
Previous parameters are not directly accessible to ensuing instances of 
the function. 

Note that the program would not end if count were automatic rather 
than fixed because it would dynamically create a new variable called 
count and reinitialize it to 1 with each call. For each new call, the 
compiler creates a whole new set of automatic variables. Even though 
they have the same name, they refer to different memory areas. That 
variables declared with static storage do not require new storage with 
each recursive call. Their storage exists for the lifetime of the program. 
Each reference to such a variable accesses the same storage area.
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15.7.Storage classes:

15.7.1.Auto variables:

Every variable and functions in C is associated with a data type. 
We have already seen that all variables have an attribute, its type.  In 
addition to the data type, C associated a storage class with variables 
and functions. Storage class is pertaining to the storage of the 
variable. 

A storage class is associated with its object certain properties such as 
scope and lifetime in a program. By scope of an object we understand 
that the portions of the program in which the object can be used. The 
lifetime of an object is the period of time during which it is allocated 
storage space in memory. 

The scope and lifetime of objects are determined by storage class 
specifications. There are four types of storage classes.

 Auto
 Register storage class
 Static 
 Extern

Auto is the default storage class to be used within a program or file. 
For ex:

int x; (or) auto int x;
Here, The 'auto' keyword declares the storage specifier for the variable 
x is automatic. 
The scope of automatic variable is limited to the block in which it 
appears. They are created when the function is called and destroyed 
when the function is exited. Their memory locations get deallocated 
when the function is existed. They are recreated when function is 
called again. 
Automatic variables are not initialized to any value when they are 
created. They usually start with garbage values. Automatic variables 
have two pleasing aspects. First, memory space used economically. 
Second their local scope protects us from affecting them inadvertently 
in other function. So, variable in other function need not necessarily be 
given different names.
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15.7.2.Static variables:

Ex: Auto variables
void main()
{

auto a=1;
{

auto a=2;
{

auto a=3;
printf(“%d \t”,a);

}
printf(“%d\t”,a);

}
printf(“%d\t”,a);

}
Output: 3 2 1

       

The static variables are defined within a function. They have the same 
scope of the rules of the automatic variables, but in the case of static 
variables the contents of the variables will be retained thought the 
program. Static is a keyword used to define the storage class as static.  
In the absence of any initialization, static variables are initialized to 
zero.

Like automatic variables, static variables are also local to the function. 
When they are declared. 
Ex:

int myblock()
{

static float  a;
static int b[]={1,2,3,4,5};
-----------

}
The variable a and the array b have been declared static. They will 
start with an internal value and their value is retained when  the 
function is exited. 
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15.7.4. Register variables:

15.7.3.External variables:

The variables that are declared before the function main() are globally 
existing for all the functions inside the program. These variables are 
called global variables. The extern declaration of the variables makes 
the variables to be available even for the external functions that are 
called from the program. 
The extern storage class does not create a variable. It only informs the 
compiler of its existence and so the extern declaration cannot include 
any initialization. 

Extern int I;
Here, I is a global variable which may be defined in another file, thus 
supporting multi-file communication.
External variables are declared outside the block in which it is used. It 
can be declared either before the block or after the block. If it is 
declared after the block, we have to declare the variable as extern 
before using it. If the variable is declared before the block it is not 
necessary to declare it as extern.     

Ex:# include<stdio.h>
int a,b;
float x;
void main()
{

-----
-----

}
Here a, b and x are defined outside of all functions, including main. 
Therefore they are external. However, the word extern should not 
precede them. They are recognized as external by virtue of their 
position in the program.

The keyword register is used to specify the storage class of the 
variables. All the computers have a few memory locations on the 
microprocessor. These memory locations are known as registers. 
Storage and retrieval of data from a register can be done by a 
program much faster than from a location in the main memory of the 
computer.
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15.8. Summary: 

15.9. Technical Terms:

The register specification is quite useful when a particular value is 
frequently required, for example, index variables. Otherwise it is 
stored in the RAM with the default storage class.
Ex: Register int a;

The scope and life of a register variable is similar to that of the 
automatic variables. There are some restrictions on register variables. 
Since a machine register is usually single word, many compilers only 
allow those variables that fit into the word to be placed in registers.

In this lesson you have learnt what is a function, how to use a 
functions, how the functions interact with one another, how to send 
them information using arguments, and how to use them to return 
values. 

In this lesson  we have discussed the concepts of storage class and 
scope for variables in a C program. The language provides four storage 
classes: automatic, register, external, and static. 

Function: In computer science, a subroutine (function, procedure, or 
subprogram) is a sequence of code, which performs a specific task.
Local variable: A variable that exists only inside a particular function, 
not affecting anything outside the function.
Global variable: A variable that can be accessed by all parts of a 
program.
Register: Memory device that is the part of computer memory that 
has a specific address and that is used to hold information of a specific 
kind.
Secondary storage: Secondary storage is a category of computer 
storage. It is used to store data that is not in active use. It is usually 
slower and has higher capacity than primary storage, and is almost 
always non-volatile.
Recursion:When a function calls itself, either directly or indirectly. If 
this isn't clear, refer to the entry for "recursion." 
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15.10. Model Questions: 

15.11. References: 

1. What is a function? Explain advantages of functions in a 
program?

2. Write short notes on different types of functions?
3. Explain recursion with an example?
4. Write about storage classes?

Byron C. Gottfried  “Programming with C”

Kelly & Pohl  “ A book on C “

Yeshavanth kanethkar  “Let us C” 

Ravi Chandran “Programming in C”

Yeshavanth kanethkar “Working with C”

Blaguruswamy “ANSI C” 

AUTHOR:
                                G.RAMANJAIAH.,M.Sc(Computers)

Lecturer, 
Dept.Of Computer Science,
JKC College,
GUNTUR.
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Objectives:

Structure of the Lesson:

The main objectives of this lesson are:

 To understand what an array is.
 To understand different types of arrays.
 To know the declaration and initialization process.
 To understand the concept of strings.
 To understand the declaration and initialization of strings.
 To familiarize with string manipulating functions.

16.1. Arrays 
16.2. Single dimensional arrays 
16.3. Two dimensional arrays 
16.4. Multi dimensional arrays 
16.5. Strings
16.6. String handling functions
16.7. Summary 
16.8. Technical terms
16.9. Model questions
16.10.References 

Lesson 16 - Arrays and strings
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16.1.Arrays:

16.2.Single dimensional arrays:

An array is a group of related data items that shares a common name 
(or) an array is a collection of identically (similarly) typed variables 
stored contiguously in memory.

Each variable in an array is called an element and can be accessed by 
giving the array name plus an index expression called a subscript.  A 
subscript value of 0 identifies the initial element; a value of 1 identifies 
the next element, and so forth.

The most basic purpose of arrays is to store large amounts of related 
data that share the same data type. Suppose you want to store  100 
names of your relatives and friends.  This requires 100 memory 
locations.  Obviously, it would be extremely tiresome to declare 100 
variables, each with a unique name. Arrays provide a solution to this 
problem.

Apart from the broad spectrum of data types C supports 
arrays. This data type is useful when a group of elements 
are to be represented by a common name.

An array is a group of elements that share a common name, 
that are differentiated from one another by their positions 
within the array. An array is a collection of homogeneous 
data. 

Declaring arrays: -

An array must be declared, since it is basically a variable. 

Syntax: type variable-name [size];

Every element in the array is manipulated using its index. 
The starting index of element is 0 and  ends with n-1. A list 
of data items can be given one variable name using one 
subscript and such a variable is called one-dimensional 
array.
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 Declaring an Array

You can declare an array by placing a pair of brackets after the 
array name.  To specify the size of an array, enter the number of 
elements within the brackets.
Syntax

Type variable_name[size]

int  a[10];

Represents ten integers, this complete set is called an array.  
Here, int specifies the type of the variable, just as it does with 
ordinary variables and the word a specifies the name of the variable.  
The number 10 tells how many elements of the type int will be in our 
array.  This number is often called the “dimension” of the array.  The 
bracket  [ ]  tells the compiler that we are dealing with an array.  

 Initializing 

We can initialize the elements in array in the same way as the ordinary 
variables when they are declared. The general from is

Type array_name [size] = {list of values}
For example:

int a[3] = { 1, 2, 3 };

In this form the size may be omitted.  In such cases, the compiler 
allocates enough space for all initialized elements.

For example:
Char name[] = { ‘S’, ’S’, ’I’, ’T’};

Thus the above statement declares the name array of four characters, 
initialized with the string, “SSIT”.

 Accessing Elements

You can access the elements inside the array by using array name and 
index of the element to be accessed.   All the array elements are 
numbered, starting with 0. Thus a[2] is not the second element of the 
array but the third.   In our program we are using the variable i as a 
subscript to refer to various elements of the array.  This variable can 
take different values and hence can refer to the different elements in 
the array in turn.  This ability to use variable as subscripts is what 
makes arrays so useful.
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You can access the first element by using a[0], second element a[1], 
and so on.
I.e., a[0] = 11   

a[1] = 21
a[2] = 31

Ex: Program to accept 5 elements into an array and display them 
back.

main()
{

int a[5], i ;
for( i=0; i<5;i++)
{

printf ("\n Enter the value of  a[%d]   :   " , i );
scanf("%d",&a[i]) ;

}
pr intf ("\n");
for( i=0; i<5;i++)
{

printf ("\ t%d",a[ i ]) ;
}

}

Program to find sum of elements of an array with n elements.
main()
{

int a[50], i ,  n, sum = 0;
do
{

clrscr();
pr intf ("\n Enter number of  elements     :    ") ;
scanf("%d",&n);

} while (n>50 || n<=0);
for( i=0; i<n;i++)
{

printf ("\n Enter the value of  a[%d]   :   " , i+1);
scanf("%d",&a[i]) ;
sum += a[i ] ;

}
clrscr();
for( i=0; i<n;i++)
{

printf ("\ t%d",a[ i ]) ;
}
pr intf ("\n\n Sum of elements     :     %d",sum);
getch();

}
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16.3. Two-dimensional arrays:

Program to find biggest of elements of an array.
main()
{

int a[50], i ,n,big;
do
{

clrscr();
pr intf ("\n Enter number of  elements     :    ") ;
scanf("%d",&n);

} while (n>50 || n<=0);
for( i=0; i<n;i++)
{

printf ("\n Enter the value of  a[%d]   :   " , i );
scanf("%d",&a[i]) ;

}
big = a[0];
for( i=1; i<n;i++)
{

i f  (big<a[i ])big=a[ i ] ;
}
for( i=0; i<n;i++)
{

printf ("\ t%d",a[ i ]) ;
}
pr intf ("\n\n Biggest of  elements         :     %d",big);
getch();

}

So far we have discussed the array variables that can store a list of 
values.  There will be situations where a table of values will have to be 
stored.

C allows us to define such tables of items by using two-dimensional 
arrays.  This type of arrays can be declared as

Type array_name[row-size][column-size];

For example
int a[3][3];

This two dimensional array consists of three rows and e three columns.
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 ACCESSING THE ELEMENTS

The first row first element can be accessed by a[0][0], the first 
row second element can be accessed by a[0][1], similarly the third 
row second by a[2][1] and soon.

Multidimensional arrays are stored in row-major order, which 
means that the last subscript varies fastest.

 INITIALIZATION

Like single dimensional arrays the initialization can be done in 
multidimensional arrays. When initializing a multidimensional array, 
you may enclose each row in braces. If there are too few initializes, 
the extra elements in the row are initialized to zero. Consider the 
following example:

Int m_arr [5] [3] = {{1,2,3}, 
         {4},
         {5, 6, 7}};

This declares an array with five rows and three columns, but only the 
first three rows are initialized, and only the first element of the second 
row is initialized.  

1 2 3
4 0 0
5 6 7
0 0 0
0 0 0

if we do not include the inner brackets, as in 
int m_arr[5] [3] = {1, 2, 3,

     4,
     5, 6, 7};

the result is
1 2 3
4 5 6 
7 0 0
0 0 0
0 0 0
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16.4. Multi- dimensional arrays:

Ex  Program to accept an m * n matrix and display it.
main()
{

int a[10][10], i , j ,m,n;
printf ("\n\n\n\t\ tEnter total number of  rows      :   ") ;
scanf("%d",&m);
printf ("\n\n\t\ tEnter total number of  colomns   :   ") ;
scanf("%d",&n);
for (i=0;i<m;i++)
{

for( j=0; j<n;j++)
{

printf ("\n Enter the element a[%d][%d]  :  " , i+1,j+1);
scanf("%d",&a[i] [ j ] );

}
}
printf ("\n\n Given Matr ix is.. .. \n");
for( i=0; i<m;i++)
{

for( j=0; j<n;j++)
{

printf ("\ t  %d",a[ i] [ j ] );
}
pr intf ("\n");

}
}

C allows arrays of three or more dimensions.  The exact limit is 
determined by the compiler.
A subscript expression can also have multiple subscripts, as follows: 
Type array_name[expression1][expression2]….[expression n];
Subscript expressions associate from left to right. The leftmost 
subscript expression, expression1,[expression2], is evaluated first. 
The address that results from adding expression1 and expression2
forms a pointer expression; then expression3 is added to this pointer 
expression to form a new pointer expression, and so on until the last 
subscript expression has been added. The indirection operator (*) is 
applied after the last subscripted expression is evaluated, unless the 
final pointer value addresses an array type (see examples below). 

Expressions with multiple subscripts refer to elements of 
“multidimensional arrays”. A multidimensional array is an array whose 
elements are arrays. For example, the first element of a three-
dimensional array is an array with two dimensions. 
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16.5. Strings:

A string is a group of characters, usually letters of the alphabet. In 
order to format your printout which has meaningful names and titles, 
you need the ability to output text data. Actually you have already 
been using strings, the second program in this tutorial, way back in 
Chapter 2, output a message that was handled internally as a string. A 
complete definition of a string is a series of char type data terminated 
by a null character. 

When C is going to use a string of data in some way, either to compare 
it with another string, output it, copy it to another string, or whatever, 
the functions are set up to do what they are called to do until a null, 
which is a zero, is detected. Such a string is often called an ASCII-Z 
string. We will use a few ASCII-Z strings in this chapter. 

One of the most common uses of arrays is to store strings of 
characters.  A string is an array of characters terminated by a null 
character. 

A null character is a character with a numeric value of zero. It is 
represented in c by the escape sequence ‘\0‘.  A string constant, 
some times called a string literal, is any series of characters enclosed 
in double quotes.  It has a data type of array of char, and each 
character in the string takes up one byte.  In addition, the compiler 
automatically appends a null character to designate the end of the 
string.

Declaring and initializing strings
To store a string in memory, you need to declare an array of type 
char, you may initialize an array of chars, with a string constant.  For 
example
   char str[] = “some text”;
The array is one element longer than the number of characters in the 
string to accommodate the trailing null character.  str[], therefore, is 
ten characters in length.  If you specify an array size, you must 
allocate enough characters to hold the string.  In the following 
example, for instance, the first four elements are initialized with the 
characters ‘y’, ‘e’, ‘s’, and null ‘\0’. The remaining six elements receive 
the default initial value of zero.

    char str[10] = “yes”;

For example:           char code[ ] = "abc";
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Initializes code as a four-element array of characters. The fourth 
element is the null character, which terminates all string literals.

The declaration

char s[] = "abc", t[4] = "abc"; is identical to 
char s[]  = {'a', 'b', 'c', '\0'},      t[4] = {'a', 'b', 'c' };

If the string is shorter than the specified array size, the remaining 
elements of the array are initialized to 0. 

 Reading and Writing Strings

You can read and write strings with the printf () and scanf () functions 
by using the %s format specifier.  For scanf (), the data argument 
should be a pointer to an array of characters that is long enough to 
store the input string.  The input string is terminated by any space 
character.  After reading in the input characters, scanf () automatically 
appends a null character to make it a proper string.  On the printf () 
side, the data argument should be a pointer to a null-terminated array 
of characters.  Printf () outputs successive characters until it reaches a 
null character.  

Ex:  Program to accept a string and count no.of characters.

main()
{

char s[20];
int i,charcount=0;
clrscr();
printf("\n Enter any string : ");
gets(s);
for(i=0;s[i]!='\0';i++)
{

charcount++;
}
printf("\n No. of characters in the given string : %d",charcount);
getch();

}
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A program to check whether a given string is palindrome or 
not.

main()
{

char a[20],b[20];
int i,l=0,flag=0;
printf("\n enter any string  :  ");
gets(a);
l = strlen(a);
for(i=0;i<l;i++)
{

b[i]=a[l-(i+1)];
}
for(i=0;i<l;i++)
{

if(b[i]!=a[i])
flag=1;

}
if(flag==1)

printf("\n %s is not a palindrome.",a);
else

printf("\n %s is a palindrome.",a);
}

Write a program to count number of vowels in a given string.

main()
{

char s[20];
int i,l=0;
printf("\n enter any strying:");
gets(s);
for(i=0;s[i]!='\0';i++)
{

if(s[i]=='a' || s[i]=='e' || s[i]=='i' || s[i]=='o' || s[i]=='u' 
|| s[i]=='A' || s[i]=='E' || s[i]=='I' || s[i]=='O' || 
s[i]=='U' )

       l++;
}
printf("\n No. of vowels in a given string are : %d",l);
getch();

}
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16.6. String handling functions:

A string in C is simply an array of characters. The following are the 
basic string handling functions. All the string-handling functions are 
prototyped in: #include <string.h> 

stpcpy Copy one string into another. 

strcmp       Compare string1 and string2 to determine 
Alphabetic order. 

strcpy Copy string2 to stringl. 

strerror     Get error message corresponding to specified 
error  number. 

strlen       Determine the length of a string. 

strncat    Append n characters from string2 to stringl. 

strncmp   Compare first n characters of two strings. 

strncpy   Copy first n characters of string2 to stringl . 

strlen() Function :

This function  counts the number of characters present in a string. 

Ex:
main()
{

char s[20];
int i,charcount=0;
clrscr();
printf("\n Enter any string : ");
gets(s);
charcount = strlen(s);
printf("\n No. of characters in the given string : %d",charcount);
getch();

}
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strcpy() Function :

This function copies the contents of one sting into another. The base 
address of the source and target strings should be supplied to this 
function. 

Ex:
main()
{

char a[20],b[20];
int i;
clrscr();
printf("\n Enter any string  : ");
gets(a);
strcpy(b,a);
printf("\n Copied string is  : ");
puts(b);
getch();

}

strrev() Function :

This function reverses the string.

Ex:
main()
{

char a[20],b[20];
int i,stringlength=0;
clrscr();
printf("\n Enter any string : ");
gets(a);
strrev(a);
printf("\n Reversed string is : ");
puts(a);

}



Fundamentals of IT 13 Arrays and strings

strcat() Function :

This function concatenates the source string into target string. It is 
necessary to place ‘\0’ into the target string, to make its end.

Ex:
main()
{

char a[20],b[20],c[40];
int i,j;
clrscr();
printf("\n Enter 1st string:");
gets(a);
printf("\n Enter 2nd string :");
gets(b);
strcpy(c,a);
strcat(c,b);
printf("\n concatenated string is   ");
puts(c);

}
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16.7. Summary: 

16.8. Technical Terms:

In this Chapter, we have introduced one form of compound data type: 
the array. An array is a block of a number of data items all of the 
same type allocated in contiguous memory cells.

We have seen that, in C, an array may be declared using the syntax: -

specifier identifier>[<size>];

specifying the type of the data items, and the number of elements to 
be allocated in the array.

This lesson  has discussed a very common data type in C programs: 
the string. We have briefly introduced the concept of an abstract data 
type as consisting of a data declaration and a set of operations on data 
items of that type. We have defined a user-defined type, STRING, for 
string data and used it throughout the chapter. 

We have described the functions for string manipulation, strlen() and 
strcpy() as well as string operation, strcmp() and strcat(), have been 
described. Other functions described include atoi(), strncmp(), and 
strncpy(). Throughout the chapter we have shown numerous examples 
of programs for string processing. 

Array: Arrays are a data structure that is used to store a group of 
objects of the same type sequentially in memory. All the elements of 
an array must be the same data type.
Character Array. A set of elements of type char. (Can be used to 
store a string).
Pointer: pointer is a variable, which contains the address of another 
variable.
String: a string is a sequence of characters terminated by a null 
character. 
Concatenation:This term is used to describe the combining of strings
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16.9.Model Questions: 

16.10.References: 

1. What is an array? Explain different types of arrays?
2. Write a program to read and display a two dimensional array?
3. Explain string-handling functions in C?
4. Write a program to check whether a given string is 

palindrome or not.

Byron C. Gottfried  “Programming with C”

Kelly & Pohl  “ A book on C “

Yeshavanth kanethkar  “Let us C” 

Ravi Chandran “Programming in C”

Yeshavanth kanethkar “Working with C”

Blaguruswamy “ANSI C” 

AUTHOR:
                                        G.RAMANJAIAH.,M.Sc(Computers)

Lecturer, 
Dept.Of Computer Science,
JKC College,
GUNTUR.
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Objectives:

Structure of the Lesson:

The main objectives of this lesson are:

 To understand what a pointer is. 
 To know the abilities of pointers in C language.
 To understand pointer variable declaration and its usage in 

a program. 
 To know the pointer usage in functions and arrays.

17.1. Introduction 
17.2. Pointer 
17.3. Abilities of pointers 
17.3. Summary 
17.4. Pointers in functions 
17.5. Function pointers
17.6. Different kinds of pointers
17.7. Summary
17.8. Technical terms 
17.9. Model questions
17.10. References.

Lesson 17 - Pointers
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17.1.Introduction:

17.2.Pointer:

‘Pointers’ is a wonderful concept provided by C in order to access data 
in a better way. They provide a convenient environment where in data 
may be managed by its address locations. Every data that the user 
stores in memory has certain address location. Address is nothing but 
a unique ID number associated with every data items placed in 
memory.  In some other way, a pointer provides a convenient way of 
accessing a data item without referring its name or identifier directly.

One of the most powerful features of C, and one that makes it quite 
close to assembly language, is its ability to refer to the address of 
program variables. A “pointer declaration” names a pointer variable 
and specifies the type of the object to which the variable points. A 
variable declared as a pointer holds a memory address.

As a definition, a pointer is a variable that holds the address of another 
variable. Suppose there is an integer variable, to hold its address it 
requires an integer pointer. For any floating point value, it requires a 
float type pointer. So is the case even with other data types. 

Pointers enable the users to effectively represent complex data 
structures. A pointer provides an indirect means of accessing the value 
of a particular data item.  In order to create a pointer, use two 
different operators like indirection operator (*), address of operator 
(&).

Syntax: int z=5;
int  *p;
p = & z; // address of a.
printf(“%d”,*p);

Here ‘p’ means address of ‘z’ and ‘*p’ means value at address p.
Literally, p  address of z;

*p  value at address(p)
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17.3. Abilities of Pointers:

1. To have indirect access to the data.
2. To improve capability of applications.
3. To increase the speed of program execution.
4. To develop hardware level applications.
5. To perform dynamic memory allocation & de-allocation.
6. To return more than one value from a subprogram.
7. A pointer to a pointer may be generated.

Ex:
int a, *p1;
flaot b, *p2;
char c, *p3;
a= 100;  b = 23.45; c  = ‘z’;
p1 = & a; 
p2 = &b;
p3 = &c;
printf(“%d %u  %u %d %d\n”, a, p1, &a, *(&a), *p1);
printf(“%d %u  %u %d %d\n”, b, p2, &b, *(&b), *p2);
printf(“%d %u  %u %d %d\n”, c, p3, &c, *(&c), *p3);

Output of above program:

100 250 250 100 100
23.5 350 350  23.5  23.5 
z 450  450  z  z

The above program prints the address of a, b and c. Here ‘%u’ is the 
format specifier, ‘&’ it is meant for displaying unsigned integer values. 
Every address location is an unsigned integer value. Hence you may 
use %u or %p for pointers.
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Lets see how pointers actually work: When you run the above program 
variables a, b and c are kept in memory as follows:

Here, a, b, c are the different variables and p1, p2, p3 are the 
pointers. So the pointers hold always the addresses. Moreover, a 
pointer may have its own address again i.e., a pointer also gets stored 
somewhere in memory.
 100, 23.5, ‘Z’ are the data items.
 250, 350, and 450 are assumed to be the address of a, b, c in 
memory respectively.
1000, 1050 and 1100 are the addresses of pointers p1, p2 & p3.

In general pointers may perform arithmetic operations like addition 
and subtraction. Even relational operators may be applied on pointers. 
However, multiplication and division cannot be performed. Short-hand 
operators like ++, -- can also be used.

p++;  //valid
p--;  // valid
p-2; // valid
p+3; //valid
a = *p+2; // valid
p * 2;  // invalid
p1/p2 ; // invalid
p/3;       // invalid

  a

       100

  b

       23.5

  c

        ‘Z’

      250 350     450

       250        350       450

      p1 p2 p3

        1000 1050   1100
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Here pointer instrumentations have special meanings. Suppose p is a 
pointer and it holds address of a variable k; then p+1 means the value 
of p is incremented by the length of the data type that it points to, 
such length is called scale factor.

In case of the following data types; length is:

Data type Length
Int 2
Char 1
Float 4
Long int 4
Double 8

For example, p has the address 2300 for a variable of double type. 
P+2 means 2300+(2 * 8) = 2317; p become 2317.

Pointer to Arrays:

A pointer may be applied to arrays. Generally the compiler itself 
allocates a base address to an array. Moreover, the compiler, in case 
of arrays, performs implicit addressing. Suppose, we declare an array 
z as follows:

statc int  z[] = {11,22,33,44,55};

Assume that the above is stored in memory as follows:

Consider p is a pointer to array z:
p = &z[0];  or p = z; i.e., p = 100.

11 22 33 44 55

0 1 2 4 5 index values

100 102 104 106 108     addresses

values
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This implies the address or base address of array z into p.

Hence you can assume the following representation:

The following program illustrates the pointers to arrays:

#include <stdio.h>
void main()
{
  static int a[] = {11,22,33,44,55};
  int *p,i;

  p = a; // assigning address of base address of a

   for(i = 0;i<5;i++)
  {
    printf(“%d\t”,++(*p));
    p++;
  }

        }

output:
12 23 34 45 56

Here, ++(*p) means the value at address p is incremented by 1. 
Hence values 11, 22, 33, 44 and will become 12, 23, 34, 45, 56 
respectively.

In some other way, the array elements are represented as follows:

a[0] a[1]     a[2] a[3] a[4]

*(a+0) *(a+1) *(a+2) *(a+3) *(a+4) 

11 22 33 44 55

p+0 p+1 p+2 p+3 p+4
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In case of two dimensional arrays, suppose, int a[2][2] = 
{11,22,33,44};

a[0][0]   *(*(a+0)+0)
a[0][1]   *(*(a+0)+1)
a[1][0]   *(*(a+1)+0)
a[1][1]   *(*(a+1)+1)

Ex: #include<stdio.h>
void main()
{
int I,j;
int z[3][3] = {{1,2,3},{4,5,6},{7,8,9}};
for(I=0;I<2;I++)
{ 
   for(j=0;j<3;j++)
    printf ( “%4d”,*(*(a+i)+j) );
   printf(“\n”);
  }
}

Output: 1 2 3
4 5 6
7 8 9

In case of strings or character arrays:

Like one-dimensional array, strings can be manipulated using pointers. 
A string is always terminated by a NULL character, it becomes easy to 
manage.

Ex: #include<stdio.h>
void main()
{
  char *str = “JKC college”;
  char *p;

  while(*p!=NULL)
  {
    printf(“%c”,*p);
    p++;
  }
}

Output: JKC college.
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17.4. Pointers in Functions:

As ‘pointers’ is a general concept, it may be used in functions. In case 
of passing arguments, pointers may be used. In fact, functions: caller 
and called functions use, pointer in quite a different way.

Functions that call by value may not be useful in certain cases where 
the reflections of called functions should be done on caller. The 
following example illustrates the usage of pointers.

#include<stdio.h>
void swap(int, int); // prototype declaration

void main()
{
  int a, b;
  a = 5;
  b = 9;

  printf(“\n Before swapping….\n”);
  printf(“%5d%5d”,a,b);

  swap(a,b); // called function & is a call by value

  printf(“\n After swapping….\n”);
  printf(“%5d%5d”,a,b);
}

void swap(int x, int y)
{
  int temp;

  temp = x;
  x  = y;
  y = temp;
  return;
}

o/p:    
Before swapping….
5 9
After swapping….
5 9
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Here, a, b in main() are the actual parameters and x, y in swap() are 
the formal or dummy parameters. Though x, y hold values of a, b, the 
changes made to x, y may not reflect a, b because only the copy of a, 
b is placed in x, y.  Updations are restricted to the called function only.

If at all, every trivial change is to be reflected in the caller function, 
then user has to consider ‘pointers’ concept. The following example 
illustrates the same.

#include<stdio.h>
void swap(int &, int &);

void main()
{

  int a,b;
  a = 5;
  b = 9;

  printf(“\n Before swapping….\n”);
  printf(“%5d%5d”,a,b);

  swap (&a, &b); // called function & is a call by value

  printf(“\n After swapping….\n”);
  printf(“%5d%5d”,a,b);
}

void swap(int *x , int *y)
{
  int temp;

  temp = *x;
  *x   = *y;
  *y    = temp;
   return;
}
o/p:

Before swapping….
5 9
After swapping….
9 5
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17.5. Function Pointer :

Like integer pointer, float pointers  and other pointer types,  may have 
function pointers. A function pointer is a pointer that holds the address 
of a function in memory. It improves program execution speed.

Syntax:
Data type (function_ptr)();

Example:
double (*p)();

The following example illustrates function pointer:

#include<stdio.h>

void test(); // proto type declaration.
void main()
{
  void (*p)();

  p = test; //assigning address of function to p.

  (*p)();  // calling test() using function pointer.
}

void test()
{
  printf(“ c “);
  printf(“c++”);
  printf(“vc++”);
}
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17.6. Different kinds of Pointers:

There is a special kind of category in pointers. 

 Near Pointers
 Far Pointers
 Huge Pointers

Based on the memory organization, data may be accessed in different 
ways. Different microprocessors follow different data models. Based on 
the data models, the above category of pointers will do the work.

Near Pointer:
It takes 2 bytes so it holds the addresses (offset) from 0 to 65535. 

Far Pointer:
It takes 4 bytes of memory, it will hold both the segment address 
(higher order two bytes) and offset (lower order two bytes). 

In order to access CGA video memory, we normally use, far pointers.

Huge Pointer:            
In this we have another type is called “Huge Pointer ’’ which is just 
like far pointer except that “ the address stored in huge pointer will be 
normalized”.

TSR programming or low level programming is performed using Near, 
far and huge pointers.
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17.7. Summary: 

17.8. Technical Terms:

In this lesson we have introduced a new data type, a pointer. We 
have seen how we can declare variables of this type using the * and 
indicating the type of object this variable can point to, for example: 

int   * iptr;
float * fptr;
char  * cptr;

Declare three pointer variables, iptr which can point to an integer cell, 
fptr which can point to a cell holding a floating point variable, and cptr
which can point to a character cell. 

We have also shown how pointer variables may be used to indirectly
access the value in a cell using the dereference operator, *: y = 
*iptr;

As we have seen,, pointers are very useful in developing complex 
programs. The concept of pointers may be confusing at first, however, 
a useful tool for understanding the behavior of a program using 
pointers is to draw the memory picture showing which to cells each 
pointer is pointing. 

Call by reference - passing a pointer to an argument to a function. 
The function can then change the argument value. See call by value. 
Call by value - passing a copy of an argument to a function. The 
function cannot then change the argument value. C and C++ use call 
by alue argument passing. But also see pointer and reference, also call 
by reference.
Pointer to data member - a pointer that points at a data member of 
a class. 
Pointer to function - an address of a function or a member function.
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